Route Manager 2000™

User Guide

Advantage Route Systems, Inc.

We Deliver – so you can!

Version 11
Windows XP/Vista/7
# Contents

## Chapter 1 – Overview
- Introduction .................................................................................................................. 1
- Manuals ......................................................................................................................... 2
- Service and Support ........................................................................................................ 2

## Chapter 2 – Management Guide
- Overview ....................................................................................................................... 3
- Hardware Requirements ............................................................................................... 3
- Setting up the System .................................................................................................... 4
- Day-to-day Operations .................................................................................................. 4
  - Using Service Agreements ......................................................................................... 4
  - Obtaining Priority Service ....................................................................................... 4
  - Servicing Handheld Equipment ................................................................................ 4
  - Managing Routes ....................................................................................................... 5
- Maintaining Spare Units ............................................................................................... 5

## Chapter 3 – Setting Up Your System
- Overview ....................................................................................................................... 7
- Assembling Your Materials ......................................................................................... 7
- Preparing Desktop Equipment ..................................................................................... 7
  - Hardware .................................................................................................................... 7
  - Printer ......................................................................................................................... 7
  - USB port .................................................................................................................... 8
- Handhelds ..................................................................................................................... 8
  - Diagnostics ................................................................................................................ 8
  - Marking Equipment .................................................................................................. 8
  - Marking PC Cards ....................................................................................................... 8
  - Ordering Paper Supplies ............................................................................................ 8
  - Stylus ........................................................................................................................ 9
  - TouchSafe™ .............................................................................................................. 9
- Installing the RM2000 Software .................................................................................. 10
- Starting the Program ................................................................................................... 15

## Chapter 4 – Using Your Desktop Software
- Overview ....................................................................................................................... 17
- Getting Started ............................................................................................................. 17
Chapter 5 – Company Information

Overview ........................................................................................................................................ 29
Setting Up Company Data .......................................................................................................... 30
  Setup Tab ................................................................................................................................ 30
  Accounting Tab ....................................................................................................................... 33
  Banking Tab ............................................................................................................................ 35
  Taxes Tab ................................................................................................................................ 36
  Desktop Tab ............................................................................................................................ 37
  Defaults Tab ............................................................................................................................ 40
  Statement Tab ......................................................................................................................... 41
  Handheld Tab .......................................................................................................................... 43
  Equipment Tab ......................................................................................................................... 44
  Logging Tab ............................................................................................................................. 47
  Docking Tab (Optional) ........................................................................................................... 48
  Calendars Tab .......................................................................................................................... 49
  GPS Tab .................................................................................................................................. 55
  Optimizations Tab .................................................................................................................... 56
Local Settings .....................................................................................................................................
  Desktop Tab ............................................................................................................................ 57
  Communications Tab ............................................................................................................. 59
  Directories Tab ....................................................................................................................... 61
  Printers Tab ............................................................................................................................ 62
  Message Entry ........................................................................................................................ 64
  Load from Host (Docking Only) .............................................................................................. 65
  Output to Host (Docking Only) .............................................................................................. 66
Import ..............................................................................................................................................
  Customers ............................................................................................................................... 67
  Equipment ............................................................................................................................... 68
  Import Routing ....................................................................................................................... 71
  Driving Directions (Roadnet) ................................................................................................. 71
Export ............................................................................................................................................
  Export Databases ................................................................................................................... 72
  Export Routing ....................................................................................................................... 73
Maintaining Data Files ................................................................................................................
  Rebuild Data Files .................................................................................................................. 73
  Pack ....................................................................................................................................... 74
  Backup/Restore ..................................................................................................................... 75
  Printer Setup .......................................................................................................................... 76
Chapter 6 – Setting Up List Information

Overview .................................................................................................................. 79
Inputting Customer Data .................................................................................................. 80
Customer Setup Codes ........................................................................................................ 112
  Credit Class .................................................................................................................. 113
  Dunning Messages ........................................................................................................... 115
  Dunning Letters ............................................................................................................ 116
  Finance Charge Codes ................................................................................................. 117
  Administrative Charge Codes ....................................................................................... 119
  Statement Codes .......................................................................................................... 120
  Start/Stop Reasons ....................................................................................................... 124
  Suspend Service Codes ............................................................................................... 125
  Contact Reasons ........................................................................................................ 126
  Customer Type Codes ................................................................................................. 127
  ZIP Codes .................................................................................................................. 130
  Telephone Reasons ..................................................................................................... 131
Organizing What You Sell .............................................................................................. 132
  Product Charge Codes ................................................................................................. 132
  Product Class Codes .................................................................................................... 139
  Product Price Lists ....................................................................................................... 141
  Package Plan (Optional Module) .................................................................................. 142
  Gratis Reasons ........................................................................................................... 142
Accounting Setup ............................................................................................................ 143
  Sales Tax Rates .......................................................................................................... 143
  General Ledger Setup ................................................................................................. 145
  Credit Card Groups Setup ......................................................................................... 146
Organizing and Tracking Equipment ............................................................................ 147
  Equipment .................................................................................................................. 147
    Equipment Master List ............................................................................................... 147
    Equipment Type ........................................................................................................ 155
    Equipment Style ....................................................................................................... 156
    Service Codes ........................................................................................................ 157
Configuring Handheld Options ....................................................................................... 158
  Handheld Options ...................................................................................................... 158
  Driver Setup .............................................................................................................. 173
  Route Types .............................................................................................................. 176
  Site Inspection Reasons ............................................................................................. 177
  Group Area Codes ...................................................................................................... 178
  Container Contents ................................................................................................. 179
Employee Setup .............................................................................................................. 180
  Employees ................................................................................................................. 180
  Security Level Codes .................................................................................................. 183
  Commission Class Codes ......................................................................................... 184
<table>
<thead>
<tr>
<th>List Reports</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer List</td>
<td>320</td>
</tr>
<tr>
<td>Customer Setup Codes List</td>
<td>321</td>
</tr>
<tr>
<td>Credit Class List</td>
<td>321</td>
</tr>
<tr>
<td>Finance Charge Codes List</td>
<td>321</td>
</tr>
<tr>
<td>Administrative Charge Codes List</td>
<td>322</td>
</tr>
<tr>
<td>Statement Codes List</td>
<td>322</td>
</tr>
<tr>
<td>Start/Stop Reasons List</td>
<td>322</td>
</tr>
<tr>
<td>Suspend Service Codes List</td>
<td>323</td>
</tr>
<tr>
<td>Contact Reasons List</td>
<td>324</td>
</tr>
<tr>
<td>Customer Type Codes List</td>
<td>325</td>
</tr>
<tr>
<td>ZIP Codes List</td>
<td>326</td>
</tr>
<tr>
<td>Telephone Reasons List</td>
<td>327</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Product Codes</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Charge Codes List</td>
<td>328</td>
</tr>
<tr>
<td>Product Class List</td>
<td>329</td>
</tr>
<tr>
<td>Product Price List</td>
<td>329</td>
</tr>
<tr>
<td>Gratis Reasons List</td>
<td>330</td>
</tr>
<tr>
<td>Sales Tax Rates Report</td>
<td>331</td>
</tr>
<tr>
<td>General Ledger Account Usage</td>
<td>331</td>
</tr>
<tr>
<td>Group Area Codes List</td>
<td>331</td>
</tr>
<tr>
<td>Truck List</td>
<td>332</td>
</tr>
<tr>
<td>Employee Report</td>
<td>332</td>
</tr>
<tr>
<td>Security Levels List</td>
<td>333</td>
</tr>
<tr>
<td>Commission Class List</td>
<td>333</td>
</tr>
<tr>
<td>Company Report</td>
<td>334</td>
</tr>
<tr>
<td>Graphs</td>
<td>334</td>
</tr>
<tr>
<td>Custom Reports Menu</td>
<td>335</td>
</tr>
</tbody>
</table>

Chapter 9 – Route Options 337
Chapter 10 – Tools

Overview ................................................................................................................................ 337
Daily Handheld Processing .................................................................................................................. 338
  Morning Cards ................................................................................................................................. 338
  Afternoon ..................................................................................................................................... 339
  Load Data Card ............................................................................................................................... 340
  Pre-Route Reports .......................................................................................................................... 341
  Print Route Tickets .......................................................................................................................... 343
  Print Load Sheet .............................................................................................................................. 345
  Route Pre-Sale ................................................................................................................................. 346
  Post Route Invoice Input .................................................................................................................. 349
  Card Override ................................................................................................................................ 351
  Prepare Data Card ............................................................................................................................ 351
Utilities ................................................................................................................................... 352
  Change Route Date .......................................................................................................................... 353
  Delete Route .................................................................................................................................. 354
  Route Resequence .......................................................................................................................... 355
  Modify Route ................................................................................................................................ 356
  Global Route Changes .................................................................................................................... 358
  Load Sheet Entry ............................................................................................................................. 359
  Modify Telephone Order Sequence ................................................................................................. 361
  Route Dispatch Manager (RDM) ....................................................................................................... 362

Chapter 10 – Tools

Overview ................................................................................................................................ 364
Update Software via Web Site ............................................................................................................. 365
Electronic Commerce 2000 Web Update (Optional Module) ................................................................. 365
Electronic Filing 2000 (Optional Module) ............................................................................................ 365
Automated Attendant ........................................................................................................................... 365
  Check for New Messages .................................................................................................................. 365
Global Changes ................................................................................................................................. 366
  Change Customer Account Numbers .............................................................................................. 367
  Change Customer Names .................................................................................................................. 368
  Change Equipment ID’s ..................................................................................................................... 369
  Modify Rent Prices ........................................................................................................................... 370
  Add/Remove Default Products ......................................................................................................... 371
  Modify Prices on Default Products .................................................................................................. 372
  Change Default Products ................................................................................................................ 373
  Add/Remove Recurring Charges ........................................................................................................ 374
  Close Open Telephone Requests .................................................................................................... 375
  MangoGeo Address Correction ........................................................................................................ 376
Administration ................................................................................................................................ 377
  Users Currently Logged In ............................................................................................................... 377
  Data Integrity Check .......................................................................................................................... 378
  Consolidate History Data .................................................................................................................. 379
  Clean Open Invoice System .............................................................................................................. 379
Helpful Windows Functions .................................................................................................................. 380
  Calculator ....................................................................................................................................... 380
  Calendar ......................................................................................................................................... 380
Chapter 1 – Overview

Introduction

Route Manager 2000 integrates state-of-the-art handheld technology with sophisticated accounts receivable software. This program provides a cost-effective solution for field data collection in a variety of route accounting applications.

This user manual contains the necessary information to help you set up the system quickly and operate it efficiently. The complete volume of training materials consists of three user manuals and supplemental documents found on our Web site www.ARS247.com or on your installation CD:

- Desktop User Guide
- Handheld Guide
- Getting Started Guide

These three manuals along with other aids will help you quickly get going and use the system effectively.

- Supplemental Guide
- Online Documentation at www.ARS247.com
Manuals

This document has been divided into several main chapters:

- Management Guide
- Setting Up Your System
- Using Your Desktop Software
- Company Information
- Setting Up List Information
- Daily Processing and Transactions
- Reports
- Handheld Options
- Tools
- Help
- Training and Support

At the end of this user manual, you will find a glossary, appendix, and an index.

Use this manual to quickly master crucial skills and effectively use your RM2000 software.

Service and Support

At ARS, it is our priority to provide you with the highest quality of service and support available. We provide 24-hour-a-day, 7-day-a-week telephone support. How to contact us:

- Toll free, 24-7 Telephone Support 866-549-8837
  (Outside the United States at 1-209-632-6358)
- Visit the support Web site at http://www.ARS247.com
- Email Support@ARS247.com
- Fax 775-263-8426

Support requests sent via Email or fax will be responded to during the hours of 6 AM to 5 PM US Pacific Time. For more information on ARS Support Policies, please refer to our Web site.

If you are in the program and need help with the screen you are viewing, simply press the F1 key. This will activate the RM2000 context sensitive help. It will generally display the same information as found in the corresponding section of the User Guide.
Chapter 2 – Management Guide

Overview

This chapter provides an overview of the manager’s role in the implementation and maintenance of the RM2000 system and its components. This includes system setup, day-to-day operations, and periodic maintenance.

Hardware Requirements

The following table outlines the minimum recommended processor speed and memory for RM2000 as of the publication of this manual. Be sure to check with ARS for the latest recommended hardware specifications.

<table>
<thead>
<tr>
<th>Operating Systems</th>
<th>Processor Speed</th>
<th>Physical Memory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows XP/Vista</td>
<td>2 GHz minimum</td>
<td>512 MB minimum (1 GB recommended)</td>
</tr>
</tbody>
</table>

Here is a list of additional hardware requirements to run RM2000 on a single user system:

- VGA monitor with video card - must support 800 X 600 mode.
- 10 GB hard disk space available.
- 32x CD-ROM
- Internet connection (Cable or DSL).
- Keyboard and mouse.
- Inkjet printer — a laser printer is essential if you have more than 500 customers. For over 2,000 customers, you should have a printer that prints more than eight pages per minute.
- File backup and extended storage capabilities — CD, DVD Re-Writable Drive, tape backup, etc.
- Available USB port to connect card reader.

NOTE: If you do not have all of the necessary hardware, contact your reseller or Advantage Route Systems immediately.
Setting up the System

The manager’s most important job is setting up the system for all personnel to use; this process is described in Chapter 3. In addition, the manager must coordinate the following activities:

- Getting all hardware together and installed
- Setting up the software
- Training office personnel
- Training drivers
- Ordering supplies

Chapter 3 will describe the activities that will help the manager as he or she sets out to install the system.

Day-to-day Operations

Using Service Agreements

During your setup process, ARS provides a specified amount of phone or onsite training. After this period, we recommend you choose an affordable support plan that best matches your requirements. For complete details of our service and programs, visit our tech support Web site at www.ARS247.com.

Obtaining Priority Service

We highly recommend that you have internet access. This will allow us to operate your system remotely for diagnostic or training purposes, and allows you to update your RM2000 software at any time.

Servicing Handheld Equipment

Keeping your equipment in good condition is important for obtaining maximum life from each unit. For further information on this topic, refer to the recommendations in the Handheld User Guide. In the event of equipment failure, contact your reseller or Advantage Route Systems.

Typically, route drivers take better care of their equipment if they are assigned to a single unit. Put their route number or name on their handheld, printer, holster, memory card, etc.
Managing Routes

Each day you will need to transfer route information to each handheld unit. This should be done prior to the drivers arriving each morning. With this in mind, it is best to prepare route data the night before their scheduled routes.

NOTE: Loading handheld data the evening before the routes are scheduled will prevent delays due to unforeseen circumstances such as computer failures or electrical failures.

Maintaining Spare Units

Unless you are a very small operation, we recommend you have at least one spare unit for every six to eight handhelds. This will help you prepare for unforeseen problems, new employees, temporary routes, etc.
Chapter 3 – Setting Up Your System

Overview

This chapter covers both hardware setup and software installation. Before beginning these processes, review the packing slip to ensure that your order is complete. If all ordered hardware has not been received, contact your reseller or Advantage Route Systems immediately.

Assembling Your Materials

Before installing your software, you need to have the following:

- PC compatible desktop running Windows XP or higher
- Ink Jet or Laser Printer
- Route Manager 2000™ Software
- Manuals

Preparing Desktop Equipment

Hardware

Examine all hardware to ensure that it meets the minimum requirements. Assemble the components to ensure that the computers and peripheral equipment are working properly.

Printer

The RM2000 software requires an ink jet (or better) printer. The system is not designed for dot matrix printers. A laser printer is essential if you have more than 500 customers. Consider buying a laser printer with a speed of at least 12-ppm if you have over three routes.
USB port
A USB port must be available to use a storage card reader for your handheld. This will allow RM2000 to transfer data using a storage card.

Handhelds
Prior to sending drivers on their first route, observe the procedures and information found below.

Diagnostics
Turn on the handheld computer to make sure it is working properly. The documentation provided by the hardware manufacturer can help you establish power settings for optimized battery usage throughout the route day as well as some other helpful settings. See the hardware section of the Handheld User Guide for complete procedures.

Marking Equipment
We strongly encourage you to etch your company name and phone number on all of your equipment (Marker pens and sticky labels can wear off). You may also want to put a driver identification tag on the printer unit. This way each driver can be assigned one handheld and one printer.

Marking PC Cards
Each memory card should be marked with either the driver’s name or route number. This allows each driver to know which unit is assigned to which route. Due to the close tolerance of the card in the computer, do not apply any sticky labels to the cards — use permanent marker pens only. It will be necessary to re-label the card every three or four months as the writing wears off as the card is removed from the computer frequently.

NOTE: See the hardware section of your Handheld User Manual for handheld setup and operation instructions.

Ordering Paper Supplies
We recommend ordering at least six months of paper supplies at a time. Figure that each roll of paper will generate about 85 receipts. Orders for plain white paper are usually filled within a week.

WARNING! Do not use thermal adding machine paper for these units. The handheld printer uses a special low dust, high sensitivity paper designed for the close tolerance of the print head. Using lower quality papers will damage the unit and void the warranty.
Stylus

A stylus is included with each handheld. However, since it can be easily lost, you may want to order the ARS stylus, which comes with a pocket clip. It is also much cheaper than the ones that come with the unit.

NOTE: Only use your finger or a touch-screen stylus with a Teflon® tip on the handheld touch panel. Pens or other objects will scratch the surface.

TouchSafe™

Under normal usage, the touch screen of your handheld will be scratched, and pick up a few nicks. Noticeable scratches will first appear in areas where you always touch the screen, such as the EXIT button or the signature capture area. To keep this from happening, ARS recommends using our TouchSafe™ product that absorbs the abuse and can be replaced every couple of weeks.
Installing the RM2000 Software

Before you begin the installation, make sure that you have the latest distribution CD, or installation file available. You will also need the serial number found in your new customer introductory letter.

NOTE: If you cannot find your serial number, please contact Advantage Route Systems so that we may provide you with one.

To install the software, insert the RM2000 CD into your CD-Rom drive. If you are installing RM2000 from a downloaded file, simply double-click on it. An installation screen will appear on your screen (CD installation only). Select the Install RM2000 option to begin the installation.

NOTE: If your installation CD does not start automatically, go to Start > Run, and type in (X):\AutoRun.hta, where (X) is the drive letter of your CD-ROM drive.
This will bring up a screen similar to the following graphic, select ‘Next’ to continue:

![Route Manager 2000](image)

**NOTE:** From this point on, select ‘Next’ to continue with the installation, or ‘Back’ to view previous pages.

Carefully read the *User License Agreement*. If you agree to the terms as displayed, select ‘Yes.’

![User License Agreement](image)

**NOTE:** If you do not agree to the terms of the license agreement, select ‘No,’ and contact ARS or your reseller for assistance.
Select the installation option you prefer from the following choices, there are four options available to you:

- **Install**: Use this option to install the standard RM2000 program.
- **Install Demo**: If you would like to evaluate RM2000 using sample data, select this option. This option installs a set of demo data.
- **Update**: Choose this option if you are already an RM2000 user, and would like to upgrade your software to a more recent version.
- **Network Client**: In a multi-user environment, this option should be used when setting up a workstation.

Select an option, and choose ‘Next’ to continue. In this example, Install has been selected.

**WARNING!** If you are updating from a previous version of RM2000, you should only select Update or Network Client. Selecting any other option will cause a loss of data!
Select, or enter, the desired installation directory and click ‘Next’ — RM2000 will be installed in C:\RM2000 by default.

The setup program will now proceed to install the program. This process may take several minutes, depending on the speed of your machine.
Once the installation is complete, choose ‘Finish’.

NOTE: If you would like to install the RM2000 demo program separately, simply run the installation again, and select the Install Demo option.

Continue to the next section to learn how to login and register your new RM2000 program.
Starting the Program

To begin using RM2000, select Start > Programs > Route Manager 2000, or double-click on the RM2000 shortcut placed on your desktop.

The first time you launch RM2000, you will need to enter the serial number and CI Code provided from ARS. The Registration screen is shown below:

NOTE: If you are using RM2000 as a demo system, select ‘OK,’ and the program will continue with limited options.
The following login screen will appear. This screen displays who is logged onto the system, as well as the maximum number of users that can be logged onto the system at one time (Allowed), and the number of handheld licenses available (Handhelds Allowed).

![Login Screen]

Select the ‘Administrator’ username and click ‘OK’ — no passwords have been set at this time.

**NOTE:** Once your data has been entered, you will want to restrict unauthorized access by establishing passwords in RM2000.
Chapter 4 – Using Your Desktop Software

Overview

After discussing how to get started, this chapter will focus on the eight main menus in which RM2000 has been divided. Each menu and sub-menu item is covered in the order displayed on the screen.

| File | Lists | Transactions | Reports | Route | Tools | Window | Help |

Getting Started

After starting the program and logging in, the Main Menu screen will appear. This screen displays both the RM2000 logo, and the eight main menus.
Main Menu Screen

You can use the mouse or keyboard to select menu items within RM2000. To use the mouse, place the cursor on top of the menu item and left click on the menu once. To select a menu item using the keyboard, press ALT and the underlined letter in the menu you wish to go to (i.e., ALT + F will take you to the File menu).

Using either the mouse or the keyboard, select a menu item. A list of choices will drop down relating to that topic. The File menu is shown below.

<table>
<thead>
<tr>
<th>File</th>
<th>Lists</th>
<th>Transctions</th>
<th>Report</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Branch Setup</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Local Settings</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Messaging</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manage Data Sets</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Import...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Export...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rebuild Data Files</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exit and Logout</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print Setup...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CUI+P</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Logout</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Notice that horizontal lines separate some items. This allows similar subjects to be grouped together according to topic.

Some menu choices have small arrows to the right of the words. When you highlight these words with your mouse, additional choices will appear to the right of the arrow. These lists are called sub-menus.
Navigational Tools

Navigational toolbars are found on the right side and bottom of most of the screens throughout RM2000. This section defines each available toolbar option.

NOTE: If you are unsure what a particular key on a toolbar does, place your cursor over it for two seconds. This will briefly trigger a description next to each key.

Button Descriptions

Find (CTRL+F/F10): Allows a search for a specific record based on entered criteria.

First, enter the information you are looking for in the Find field, such as a customer’s name. From the In field, use the drop-down list to select the field that you would like to search by, and click ‘OK’ to search for the desired data.

NOTE: If ‘Auto-Sense Find Criteria’ is checked in Company Setup under the Desktop tab, the computer will automatically search all of the field names in each record.
A typical list of available field names is shown below:

- Account number
- Customer Name
- Business License
- ZIP Code
- Address Line 1
- Address Line 2
- Street Name
- City
- State
- Social Security Number
- Phone Number
- Fax Number
- Email Address
- Contact Name
- Contact Phone
- Extra

The listed *Find* key fields will vary based on the current RM2000 screen that you are viewing.

**Browse (CTRL+B, or F8):** This will bring up a grid containing the database information associated with the current screen. To search through the data on the grid, you can select CTRL+F to initiate a search box.

**NOTE:** Data cannot be changed from the browse grid.

**Modify (CTRL+E, or F9):** This button allows you to edit the displayed record. A record must be in modify mode before any changes can be made to the data displayed on the screen.

**Add (CTRL+A, or F7):** This button allows you to create a new record.

**More (CTRL+M, or F12):** This button allows you to save the current record and immediately create a new one — this is helpful when you are entering many new records.

**Save (CTRL+S, or F11):** This button saves the current record.

**Delete (CTRL+D, or F5):** This button deletes the current record. The border of the screen turns red when the item is marked for deletion.

**WARNING!** When deleting a customer’s account on the *Info* tab of Customer Information, the record cannot be un-deleted.

**Undelete:** This button will un-delete any items marked for deletion (indicated by a red border).

**NOTE:** To permanently remove records marked for deletion, select *File > Pack* in RM2000.
Print (CTRL+P, or F2): The print button sends information associated with the data on the screen to the printer.

Equipment Exchange: This button allows a piece of equipment to be easily replaced with another piece of equipment and retain the same settings (i.e., rent billing cycle and amount).

Verify Address: This button allows you to verify addresses using the Advanced Mapping Module.

Cancel (F3): This button cancels any unsaved modifications to the current record.

Exit (CTRL+Q, or F4): This button exits the current screen.

Printing Controls
The following buttons appear on the report toolbar.

Print (CTRL+P, or F2): This button sends the selected report to the default printer.

Cancel (CTRL+Z, or F3): This button cancels the current report and returns to the main menu.

Preview: This button displays the report on the screen before printing.

Printer Setup: This button allows a different printer to be selected.

Export Report: This button will export the selected report’s data to a file such as Excel or Notepad, depending on your selection.

Fax Report (Additional Setup Required): This button will send the report to the fax printer.

Alignment: This button prints an alignment pattern to assist in the placement of the dot-matrix forms in your printer.

Create Statement File: This button only appears when generating bulk statements in RM2000. This option is used for transmitting files to third party companies that print and mail statements for you.
Other Controls

When reviewing a report, a control bar will appear:

First Page: Click to view the first page of the report.
Previous Page: Click to view the previous page of the report.
Go to Page: Click to enter any page number of the report to view.
Next Page: Click to view the next page of the report.
Last Page: Click to view the last page of the report.
Zoom: Select Zoom to reduce or magnify the report screen.
Close Preview: Click to close the report preview.
Print Report: Click to print all or some of the pages of the report shown on the screen.

Customer Information Options

When choosing the Print icon on the toolbar from within Customer Information, the following options will be available:

Customer Information: Prints customer billing information, including balances and default settings.
Customer Contact Messages: Prints all information logged under the Contacts tab on the current account.
Route Information: Prints delivery related information, including Default Products, Delivery Schedule, and installed equipment.
Service Agreement: Prints a custom form used for customer service agreements.

Here is an example of the standard Service Agreement included in RM2000:

By default, the Service Agreement terms read:
To replace this text with your own company policies, terms, etc., create a text (.txt) file and place it in the root folder of RM2000 using the file name ‘agreement.txt’ (below):

When a Service Agreement is printed, it will display the contents of the ‘agreement.txt’ file (example below).

NOTE: To revert to the default agreement terms in RM2000, simply remove the ‘agreement.txt’ file from the RM2000 root folder.
User Login Screen

The following screen will allow you to log into the RM2000 program. The user activity window displays any users currently logged into the system, along with the duration of their current session.

Security

Each user on the system may only be logged onto one machine at a time. If a user attempts to log in while already logged in from another location, the following message will appear:
To manage users logged into the system, go to Tools > Administration > Users Currently Logged In. If you need to manually ‘boot’ a user from the system, you can simply highlight their name and click the delete button (wastebasket).

The *Clear Locks* button is used in cases when you receive messages such as ‘Files in use by’. Most of the time you can resolve issues with locked files by clicking this option.

**NOTE:** If you cannot log into the system because your name appears in the list already, you can manually kick yourself out as long as you have administrative rights. To do this, pull up the login screen and select your username from the drop-down list. Instead of using your normal password, enter: ARS-RM2000 (must be in caps). This will prompt you for your regular password and take you directly to the *Users Currently Logged In* screen. You can now safely log yourself out of the system.

Furthermore, once a user is logged in, their access is controlled by one of the three levels indicated in the table below:

<table>
<thead>
<tr>
<th>Level</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>No access permitted to the indicated option. It will be invisible on the menu.</td>
</tr>
<tr>
<td>Read</td>
<td>User will be able to view information, but the control buttons for adding, modifying, and deleting will be disabled.</td>
</tr>
<tr>
<td>Write</td>
<td>Enables full access to the options shown on the screen.</td>
</tr>
</tbody>
</table>

When security is being established, every menu option can be controlled with the access options shown above. This will reduce the chances of information being changed by unauthorized users.

**NOTE:** Each of these options is controlled by an assigned *Security Level Code* in the program, discussed further in *Chapter 6*. 
Using Multiple Windows

This version of RM2000 allows you to open multiple windows concurrently. For instance, you can be in multiple customer records and the new customer wizard simultaneously. To manage all of the open windows, use the Window menu.

Some areas of the program, such as reports or rebuilding files, do not allow multiple windows to be open.
Notes
Chapter 5 – Company Information

Overview

The *File* menu is used to establish default company settings and import or export information.

<table>
<thead>
<tr>
<th>Menu Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Company Setup</td>
</tr>
<tr>
<td>Local Settings</td>
</tr>
<tr>
<td>Message Entry</td>
</tr>
<tr>
<td>Import...</td>
</tr>
<tr>
<td>Export...</td>
</tr>
<tr>
<td>Rebuild Data Files</td>
</tr>
<tr>
<td>Pack</td>
</tr>
<tr>
<td>Backup/Restore</td>
</tr>
<tr>
<td>Printer Setup</td>
</tr>
<tr>
<td>Logout</td>
</tr>
<tr>
<td>Exit</td>
</tr>
</tbody>
</table>

These menu items are identified and explained within this chapter.
Setting Up Company Data

Use the Company Setup option to enter default company information and settings.

<table>
<thead>
<tr>
<th>Company Setup</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equipment</td>
</tr>
<tr>
<td>Setup</td>
</tr>
</tbody>
</table>

Setup Tab

The Setup tab is used to input general company information and invoice numbers.

Company Name / Address:

Name: Enter the name of your company.

Address: Enter your company’s address information.

Phone: Enter your company’s phone number.

Fax: Enter your company’s fax number.

Email: Enter your company’s mail address, up to 35 characters.

Advanced TS Client (Optional)

Server IP: Name of the server on which Advanced TSClient is installed.

FTP User: Name of the designated FTP username.

FTP Password: Designated password for FTP username.
**Other Fields:**

*Month Close Date:* This field displays the date of the last month close. This date automatically updates each time the close period function is performed under *Transactions > Close Period.*

**NOTE:** Leave the *Month Close Date* field blank when first setting up the system. It will be updated after you close the period for the first time.

*System Start Date:* Enter the date that you started using the RM2000 desktop software.

**NOTE:** Double-clicking on any date field in RM2000 will display a date selection calendar.

**Acct Number Format:**

It is imperative to choose the type of account numbers that will be used prior to entering customers in RM2000.

*Numeric:* Select this option to use six digit numbers as account numbers (e.g., 002345, 000409, 104511).

*Alphanumeric:* Select this option to use a combination of letters and numbers as account numbers (e.g., W6L4LF, T32H89, B44ROW).

**NOTE:** ARS recommends using the numeric format, which allows quick input and can be used with more features in RM2000 (e.g., *Past Due Authorization Codes*).

*Next Acct No:* This field displays the account number that will be assigned to the next new customer. This field is automatically incremented.

**Invoices:**

*Start Invoice No:* Enter a starting six-digit invoice number that will be designated as the lowest number that will be used.

*Current Invoice No:* Displays the current invoice number that will be used.

*Invoice Rollover:* Enter an ending six-digit invoice number that will be designated as the highest number that will be used. After reaching this number, the invoice number pool will revert to the *Start Invoice No.*
**Warehouse Location (Map Start Point):**

This address will be used as the route starting point when using the optional *Advanced Mapping Module*.

**Name:** Enter the name of your warehouse location or company.

**Address:** Enter your warehouse or company’s address.

**Lat/Long:** Enter the warehouse or company’s GPS coordinates.

**MangoGeo User Name (Optional Module):** Displays your MangoGeo username.

**MangoGeo Password:** Contains your masked MangoGeo password.

**Change Password:** Select this option to update your MangoGeo password.

---

**NOTE:** The MangoGeo program is used for address verification and correction services. Contact Advantage Route Systems or visit [www.Mango-Geo.com](http://www.Mango-Geo.com) for further information.
Accounting Tab

The Accounting tab is used to enter system accounting information.

NOTE: The Default Accounts listed below must be established prior to using RM2000.

Default Accounts:

Cash: All payments received from customers — typically, this is a Cash account type.

Accounts Receivable: All sales to customers — typically, this is an Accounts Receivable account type.

Payment Discount: All discounts to customers — typically, this is an Expense account type.

Finance Charge: Select the Product Charge Code that will be assigned to all finance charge invoices in RM2000.

Refunds: Select the Product Charge Code that will be assigned to all refunds generated in RM2000.
**Rounding:**

**NOTE:** This feature is used strictly by our international clients.

**Round to:** In some countries, the smallest unit of currency is larger than .01, so it is impossible to have an invoice for 13.01 when the smallest coin is .05 cents. By entering .05 in this field, all transactions will be rounded to the nearest .05.

**Prod Charge Code:** Enter the Product Charge Code that will be used to accumulate the rounding values indicated in the previous field.

**Program:**

**Business Bookkeeping Program:** Specify your external accounting program that may be used for importing G/L account summaries:
- SBT - Vision Point 2000
- Quick Books Pro
- Peachtree
- Peachtree 2000
- Business Works
- Great Plains
- Other

**NOTE:** We routinely update this list, so your software may have more choices than those shown above.

**G/L Account Number Prefix:** Enter a G/L account prefix that will be attached to all of your accounts during export of the G/L Summary Report (if required).

**Check Type:** Use the drop-down list to choose one of the following check type formats when processing Refund Checks:
- Check-Stub-Stub – Use with laser printers.
- Check-Stub – Use with dot-matrix printers.
- Stub-Check-Stub – Use with laser printers.
- Stub-Check – Use with Dot-Matrix printers.

**Fiscal Year End:** As a reminder of certain year-end procedures, enter the month your tax year ends. The default is 12 (for December), but you may enter any number from 1 to 12.
Master/Sub-Account Merge:

Product Charge Code: Select the Product Charge Code that will be used to transfer account balances when merging an account using Master Account Billing.

Banking Tab

The Banking tab is used to store your company’s bank information.

NOTE: The Bank and Authorize.net fields are used by the optional Electronic Funds Module. For further information, contact your reseller or Advantage Route Systems.

Bank Information:

Transmitter ID: Enter the transmitter identification code assigned by your bank.

Public Key: Enter the public key assigned by your bank.

Merchant ID: Enter the merchant identification code assigned by your bank.

Default Returned Check Accts:

Returned Check: Select the Product Charge Code that will be used to reverse the returned payment amount on each account when processing returned checks in RM2000.

Returned Check Fee: Select the Product Charge Code that will be used to apply a returned check fee to each account when processing returned checks in RM2000.

Currency: Displays the primary form of currency used by your company. This option is defaulted for you.
Authorization.net Information:

Login ID: Identification number to be used to access the account.

Transaction Key: Select the proper key for the type transaction to be made.

Wells Fargo Secure Source Merchant Account: The account number assigned by Wells Fargo.

Taxes Tab

The Taxes tab stores information regarding tax labels.

NOTE: This option allows you to assign user-friendly titles to the four product tax categories found on the Pricing tab of the Product Charge Codes screen, as well as the Sales Tax Codes screen. These labels are used to identify taxable and non-taxable items in RM2000.

Product Tax Category Labels:

Categories A - D: Assign a tax label to each tax category.

Misc Tax Information:

Federal Tax ID: Enter your federal fax ID, for reference.

State Tax ID: Enter your state tax ID, for reference.
Desktop Tab

The *Desktop* tab is used to define various RM2000 desktop related options.

**Mini Descriptions on Invoice Drilldown:** Check this box to view a mini description of each product sold on the invoice within the *Description* field under *Customer Information > Pricing > Invoice Lookup*.

**NOTE:** If this is not checked, the original description of the item will be used.

**Add Pending Transactions to Invoice Drilldown:** Check this box to add pending (un-posted) transactions to the invoice drill-down area of the *Customer Information* screen.

**NOTE:** Pending transactions will be listed with a ‘P’ placed beside them.

**Age Open Items by Day:** Select this option to age all open invoices on each customer’s account by their date, not by the month in which they were created.

**Popup Customer Note:** Check this box to display any notes added to the *Customer Information > Info* tab automatically.

**Force Address to Upper Case:** Check this box to force all address fields in the program to use upper case.
Customer Route:

**Hide Site Statistics:** Select this option to hide the Site Stats option used for water source depths on the Customer Information > Route tab.

**Hide Water Analysis:** Select this option to hide the Water Analysis data used for testing iron, nitrates, etc., in the water on the Customer Information > Route tab.

**Hide Par:** Select this option to hide the Par option available on the Customer Information > Route tab.

International:

**Free Format Phone Numbers:** This option disables the auto-hyphenation of phone numbers in the system.

Handheld Transfer:

**Select Process Date for Modem Transfer:** This option allows you to specify the date of which to process routes when doing remote transfer. This is only used with the Advanced Communications Module.

System:

**Show Module Bar:** Check this box to enable the module bar whenever running RM2000 (recommended). The module bar enables a quick entry bar that includes customer fast find, telephone request access, and customer label buttons.

**Auto-Sense Find Criteria:** Select this box to automatically search through all fields within the Find box ‘In’ field when searching for information.

**Force reason on Telephone Request:** Checking this option forces a reason to be selected on the Telephone Request screen before it can be saved.

**Location to backup data before Month Close:** This option is used for creating an automated backup during the Close Period process. Enter the directory that the monthly backup should be created and stored within — refer to the Supplemental Guide for further information, under Backup Routines.

**AF2000 Directory (Optional Module):** Enter the location of your AF2000 program.

Recurring Charges:

The Recurring Charges option allows you to charge your customers recurring fees on their account. The charges are established by assigning a recurring charge fee to the Recurring Charges section of each account under Customer Information > Products.

The following information establishes default settings when charging recurring fees.

**Waive on Hold Service:** Check this box to waive any recurring charges on the handheld when a customer is on ‘Hold Service’ status.
**Handheld Billed:** Check this box to bill recurring charges on the handheld.

**NOTE:** If this option is not selected, customers will be billed on the desktop once per month.

**Monthly:** Check this option to bill the customers a recurring charge on the handheld once per month.

**Every Delivery:** Select this option to bill customers recurring charges with each handheld delivery.

**NOTE:** When billing recurring charges on the desktop, customers can only be charged once per month.

**Invoices:**

**Add Default Products to Manual Invoices:** Check this box to automatically add a customer’s Default Products to manual invoices entered on the desktop computer.

**Auto Apply Handheld ROA Payments to Oldest Items:** Checking this box will automatically apply any payment received on the handheld to the customer’s oldest open invoices — this is only valid on Open Invoice accounts.

**NOTE:** If you would like the option to apply handheld invoice payments to specific invoices manually, do not choose this option.

**Show Tax Breakdown on Invoices:** Check this box to separate tax totals by Authority on invoices. Typically, this function is used in Canada to display GST and PST totals.

**Allow Sequence Numbers on Special Delivery:** Check this option to use the customers default sequence number, instead of placing the customer at the top of the route list.
Defaults Tab

The `Defaults` tab contains data used in several areas of the program.

**Include As Contact Notes:**

- **Handheld Notes:** Stores notes created on the handheld by route drivers.
- **Equipment Movement:** Stores equipment transfers, pickups, drop-offs, etc.
- **Handheld One Time Messages:** Stores One Time Messages sent to the handheld from the Telephone Request screen or the customer’s account.

**Company Defaults:**

- **Contact Follow-up Days:** The default number of days allowed before the system reminds you about a customer ‘follow-up’ from a previous Contact Message.
- **Base ZIP Code Length:** The minimum number of characters for ZIP codes in your country (i.e., 5 in the United States, and 3 in Canada).
- **Quantity Unit Label:** This eight-character label is used on reports to indicate unit conversions for products — the default label in RM2000 is gallons but can be changed as required.
- **Product Label Description:** This label is used as the primary product container description for products being sold (i.e., bottles or units).
- **Delivery Label:** This is normally a one or two word description that replaces the word ‘Delivery’ when applicable (i.e., Delivery can be changed to Drop-Off). This change will reflect both the desktop and handheld.
- **Miles Label:** This label will replace the word ‘Miles’ when applicable throughout the program (i.e., Miles can be changed to Kilometers).
ZIP Code: This label will replace ‘ZIP Code’ when applicable throughout the system (i.e., ZIP Code can be changed to Postal Code).

Payment type “Check” Label: This label will replace ‘Check’ when applicable throughout the system (i.e., Check can be changed to Cheque).

Pounds Label: This label will replace the word ‘Pounds’ when applicable throughout the system (i.e., Pounds can be changed to Liters).

8.5 X 11 Invoice Address Adjustment:
Address 1 Offset: Enter a positive or negative number to adjust the placement of the first address line for your invoice envelope window.
Address 2 Offset: Enter a positive or negative number to adjust the placement of the second address line for your invoice envelope window.

Statement Tab
The Statement tab allows you to set up information that is used when processing statements in RM2000.

Statement Options:
Bulk Statement File Prefix: This four-character code is used by external statement processing companies to identify your company.
Matrix and Other: Identifies the statement processing company being used.

NOTE: The options above are used with Matrix Imaging or similar statement processing companies. Contact ARS for further information.

Postal Indicia:
Class: This field displays the mailing permit class used for statements.
**Type:** This field displays the type of permit you have.

**City, State:** City and state information is typically entered on the third line of your postal indicia.

**Permit No:** Your permit number is usually entered on the fourth line of your postal indicia.

**Credit Cards Accepted:**
Indicate the types of credit cards you accept as a form of payment. The options selected will print out on your statements as acceptable forms of payment.

- American Express
- Discovery Card
- Visa
- MasterCard

**Address Adjustment:**

**Company Offset:** This allows your company address to be adjusted by moving it down and to the left.

**Address1 Offset:** This allows you to adjust your customer’s statement address.

**Address2 Offset:** This allows you to adjust your companies return statement address.
Handheld Tab

The *Handheld* tab contains items that relate to the handheld.

**Drags & Specials:**

**Run on Holidays:** Select this option to allow ‘Drag’ stops and ‘Special Orders’ to be scheduled on holidays set up within the *Holiday Calendar*.

**Run on Saturdays:** Select this option to allow ‘Drag’ stops and ‘Special Orders’ to be scheduled on Saturdays.

**Run on Sundays:** Select this option to allow ‘Drag’ stops and ‘Special Orders’ to be scheduled on Sundays.
Equipment Tab

The Equipment tab contains information related to equipment options in RM2000.

Equipment Defaults:

Start Rent ( ) Days After Install: The default number of days you would like the system to begin billing rent. This is calculated from the install date but can be overwritten with each installation.

Prorate Rent: Check this option if you would like to prorate rent the first month of installation based on the customer’s start rent date. If this option is not selected, the system will bill a full month’s rent regardless of start rent date.

NOTE: You can only prorate rents on Statement Billed equipment.

Statement Billed Rents: Check this option to automatically default to the ‘Statement Billed’ option when creating new pieces of equipment in RM2000 — this option will not override existing settings for equipment.

Bill Partial Rents: This option works exclusively with the Prorate Rent option above. By selecting this option, the system will generate partial rental amounts based on the customer’s Start Rent Date.

NOTE: If the option above is not selected and you are using Prorate Rent, each customer will be billed their first month’s rental plus any prorated amounts due on their first bill.
Use Product Description for Rent Charges: Select this option to use the Product Charge Code description of the rental code assigned to the piece of equipment on printed statements. If this option is not selected, the system will use the Cycle Description associated with the Cycle Code found on the right of the Equipment tab.

NOTE: Rent Cycle Descriptions can be modified, if desired.

Allow Installed Equipment to be Re-Installed: Check this box to allow equipment to be installed on an account when it is already installed on another account. If this is not checked, you will first need to remove the equipment from the existing account before you can assign it to a new account.

Equipment Location after Pickup:
Select the default location that equipment should be transferred to after being picked up from customers.

- Warehouse
- Received
- Service

This new location is automatically entered upon completion of the afternoon data transfer from the handheld computer.

NOTE: Equipment cannot be assigned to an account until it is transferred to the ‘Warehouse’ location.

Repair Rate:

Hourly Rate: This rate is applied to the time spent by your shop personnel when repairing equipment as used in the Equipment Service module. It is added to the total repair cost in the Equipment Master List.
Rent Billing Calendar:

To properly bill rentals on equipment, you must first set up your billing calendar. You can choose whether you want to bill in advance or for the current month.

Cycle Code: Displays a single character ID assigned to each Rent Cycle Code.

Cycle Description: Displays a description of each Rent Cycle Code. This information can be overwritten, if necessary.

Clear all Unbilled Cycles: This option lets you clear out future periods of the calendar so that you can change all billing periods or those that need new descriptions.

NOTE: To create a standard rent calendar, click on one of the following options.

Create Standard Months Billed in Arrears: Creates a standard current month rent billing calendar.

Create Standard Months Billed Ahead: Creates a standard month in advance rent billing calendar.
Logging Tab

The **Logging** tab contains settings established for logging information in RM2000.

![Company Setup](image)

### Contact Messages:

**Delete Messages Older Than ( ) Days:** Enter a value in this field to indicate the number of days to save messages on the **Contacts** tab of Customer Information.

**Keep Last ( ) Messages:** Enter a number to indicate the minimum number of Contact Messages to keep for all customers.

### Telephone Messages:

**Telephone Request Promise Days:** Enter the default number of days that the system will assume it will take to honor Telephone Orders.

**Delete Completed Messages Older Than ( ) Days:** Enter the maximum number of days the system should keep completed Contact Messages.

**Don’t send diagnostic information to Advantage Route Systems:** Select this option to disable the automatic transmission of diagnostic information when an error is received in RM2000.

**NOTE:** Information sent to ARS is only used for debugging purposes.
Docking Tab (Optional)

The Docking tab only applies to companies that are using the Docking program. The Docking program allows companies to integrate the use of handheld computers into their existing accounts receivable system.

Fields:

**DL Directory:** Location where RM2000d will look for the DL files.

**UL Directory:** Location where RM2000d will place all UL files.

**Number of Days for DL/UL:** The default number of days RM2000 will store DL and UL files before they are deleted.

**Use History from DL File:** Check this box to use the history information from the DL file instead of the history information collected in RM2000d.

**Overwrite Employee(s):** Check this box to overwrite the employee file each time you run Download from Host.

**Branch Code:** The two-character branch code used by RM2000 Docking.
Calendars Tab

The *Calendars* tab contains calendar information associated with route scheduling.

*Holiday Calendar:*

The *Holiday Calendar* allows you to set up all days designated as a holiday. Simply click on each holiday to mark it on the calendar. We recommend setting up the calendar at least a year in advance, for routing purposes.

*Clear All:* Clicking this button will clear all scheduled holidays from the calendar.

Use the *Month* and *Year* buttons to navigate through the calendar.
**Day Label Calendar:**

The *Day Label Calendar* allows you to set up labels for each day of your delivery cycle. Each customer will be assigned to one or more *Day Labels* to determine their scheduled delivery days. The screen below shows an example of a standard *Day Label Calendar* for a company that delivers to their customers *Weekly* (W01-W05), *Bi-Weekly* (B01-B10), and *Monthly* (M01-M20) — take a few moments to study the calendar. Regardless of how often you deliver to your customers, the *Day Label Calendar* will accommodate for all cycles needed.

**NOTE:** The *Holiday Calendar* should be established prior to creating *Day Labels*. Additionally, you will have the option to skip deliveries on holidays, slide deliveries around holidays, or ignore holidays all together in the *Day Label Calendar*.

**Fields:**

**Route Schedule End Date:** This date determines when the current route schedule will terminate. Generally, this date should be extended for about one year in advance — extending this calendar once per year makes it easier to schedule unforeseen holidays as they arise from year to year.

**Rebuild Day Label:** Select this option if you have made changes to your *Holiday Calendar* after the *Day Label Calendar* has been extended.

**Add Day Label:** Select this option to create a new *Day Label*.

**NOTE:** Double-clicking any day on the calendar will enable you to manually create a single *Day Label*. This can be used to schedule a *Day Label* that will not repeat.
**Clear Day Label:** Select this option to clear a *Day Label* from the calendar.

**Clear All:** Select this option to clear all *Day Labels* from the calendar.

These buttons scroll through the calendar by month.

![MONTH MONTH](image)

These buttons scroll through the calendar by year.

![YEAR YEAR](image)

This button highlights the current day on the calendar.

![TODAY](image)

This button allows you to go directly to a month and year on the calendar.

![GOTO](image)
Creating Day Labels

Clicking the Add Day Label button brings up a screen that allows you to create a Day Label. Refer to the field definitions below for further information.

**Fields:**

**Day Label:** Enter the Day Label Code you would like to create.

**Starting Date:** Enter the date that you would like this Day Label to begin.
**Frequency:**

Choose the frequency of which you would like the current *Day Label* to repeat on the calendar.

**Holiday:**

*Skip:* Select this option to skip service for any stops assigned to this *Day Label* that fall on a scheduled holiday.

*Slide:* Select this option to slide any stops assigned to the current *Day Label* to the next scheduled delivery day.

---

**NOTE:** By selecting this option any accounts assigned to similar *Day Labels* will be advanced by one delivery day (i.e., Monday slides to Tuesday permanently).

**Ignore:** Select this option to ignore scheduled holidays and deliver to customers assigned to the current *Day Label*.

**Run on:**

*Saturday:* Select this option to allow the *Day Label* to be scheduled on a Saturday.

*Sunday:* Select this option to allow the *Day Label* to be scheduled on a Sunday.
Rent Schedule 1 and 2:

The Rent Schedule calendar is an additional rental option in RM2000 (alternative to Rent Calendar on Equipment tab) that allows you to establish 28 day and 56 day rent billing cycles for equipment.

NOTE: If your rent schedule follows normal monthly billing, there is no need to set up Rent Schedule calendars.

Schedule 1 (or 2):

28 Day Cycle: Select to indicate a 28-day rent billing cycle.

56 Day Cycle: Select to indicate a 56-day rent billing cycle.

Clear All: Clicking this button will clear all scheduled Day Cycles from the calendar.

NOTE: When using rent cycles, rent must be generated on the last day of each cycle. If you require both a 28 and 56-day cycle, separate them by using both Rent Schedule Calendars (1&2).
GPS Tab

The GPS tab is used with the Advanced Mapping Module. Here you will be able to define the length of time designated for each stop and the degree of difficulty.

**Default Stop Time:** Enter the minutes and seconds for the default stop length.

**Default Degree of Difficulty:** Here you can define the degree of difficulty the driver has with each stop. Enter the number of minutes to add to the default stop time to achieve the overall stop length.
Optimizations Tab

The Optimizations tab allows you to ensure that RM2000 is running as efficiently as possible on your PC when running a large database — this is particularly useful if you are using Terminal Services.

Memory:

**Foreground Memory:** Enter a ‘1’ in this field to optimize your system for a large database. It will automatically update the lowest needed value when you click Save.

**Background Memory:** Enter a ‘1’ in this field to optimize your system for a large database. It will automatically update the lowest needed value on Save.

**Backup:**

**Backup Copies:** This spinner is used to set the maximum number of backup copies that will be placed in one location (up to 5).
Local Settings

The Local Settings option allows each user to establish a handful of settings for their workstation. The options include printers, export directories, and more.

NOTE: Local Settings is unique to each computer running RM2000.

Desktop Tab

The Desktop tab includes settings related to the desktop and card reader.

Misc:

Phone Message Copies: Select the default ticket format to use when printing Telephone Orders in RM2000 (S = Small, W = Wide, F = Full).

Use 8 1/2 x 11 Invoice Format: Select this option to convert handheld invoices to a full page when printing them from the desktop.

One Invoice per Page: Select this option to only include one invoice per page when printing handheld invoices on the desktop.

Ask to load profile when running reports: Check this box to prompt the user to load the same criteria previously entered on each report — helpful if you run the same report and criteria frequently.

Browse Orientation Bar:

Every [ ] Lines: The number entered here will control the number of lines between the colored bars when you are in a browse window.

Red [ ]: Use this field to add red to your colored browse bars.

Green [ ]: Use this field to add green to your colored browse bars.

Blue [ ]: Use this field to add blue to your colored browse bars.
Customer:

**Default Tab in Customer Info Screen:** Select the default tab that will be displayed when entering the Customer Information screen.

**Browse Order:** Select the default sort option to use when selecting the Browse key on the toolbar in Customer Information, Account or Name.

**Package Plan Contract Expiration Days:** Enter the default number of days the Package Plan expiration date should be projected to when an account is assigned to a plan (not required).

**Default Number of Periods in Drilldown:** Select the default number of periods to automatically select when entering the Invoice Lookup screen under Customer Information > Finance ($) tab.

**Enable Mid String Search for Fast Find:** Select this option to enable partial match results when using the Customer Fast Find.

**Drives:**

**Floppy Drive:** Using a single character, specify the floppy disk drive in your system (not required).

**Card Reader:** If your computer has an internal or external card reader, enter the drive letter of the active drive used for your route cards.
Communications Tab

This tab allows you to identify the settings for data transfer to the handheld computer. Also, use this screen if you are using terminal services.

Communications Options:

Handheld Upload Method (Advanced Communications Module):
Select the wireless data transfer option being used:

- **Net/WiFi Only**: Select this option if you are only using the Network or WiFi communication methods for transferring data between the desktop and handheld.

- **Net/WiFi and Cable**: Select this option if you are using a combination of Network/WiFi and serial cable transfers between the handheld and desktop.

- **Net/WiFi and Modem**: Select this option if you are using a combination of Network/WiFi and modem transfers between the handheld and desktop.

**Com Port**: Select the com port on which the modem is installed when using the ‘Net/WiFi and Modem’ option.

**Baud Rate**: Select the proper baud rate for transfer when using the ‘Cable’ or ‘Modem’ option.
Thin Client Connection Type:
Choose the Thin Client connection type that you will be using, if applicable.

- **None**: Select this option if you are not using a Thin Client connection.
- **Citrix Meta Frame**: Select this option if you are using a Citrix Meta Frame client.
- **ARS TS Advanced Client**: Select this box if you are using ARS TS Advanced Client.

Phone Dialer Com Port (not commonly used): Select the com port on which the telephone dialer is installed when using an integrated phone system.

E-Mail Delivery Method:
The following options are used to establish e-mail transfers within RM2000.

**Microsoft Outlook**: Choose this option if you will be using Microsoft Outlook to process e-mails and will not be configuring SMTP transfers.

**SMTP Server**: Choose this option if you will be processing e-mail directly through an SMTP server.

**SMTP Server Address**: Enter the I.P. address or host name of the SMTP server.

**Use Login Authentication**: Enter the authentication code (or password) to process SMTP transfers.

**Login Name**: Enter the login name used to access the SMTP server.

**Login Password**: Enter the password used to access the SMTP server.
Directories Tab

The **Directories** tab contains directory options used for exporting backup files, reports, and optional modules.

### Directories:

**Backup Directory:** Enter the directory that will be used for storing RM2000 backups.

**GL Output Directory:** Enter the directory that will be used for exporting general ledger information.

**Credit Card Processing Directory:** Enter the directory that will be used for processing credit card transactions.

**Bank Transfer Processing Directory:** Enter the directory that will be used for processing bank transfers.

**NOTE:** The Credit Card and Bank Transfer options are only used with the Electronic Funds Module.

**EF2000 Document Directory:** Enter the directory that will be used for storing EF2000 documents.

**NOTE:** This option is only used with the EF2000 Module. This module allows you to scan original documents and keep them on file for each customer.

**Report Output Directory:** Enter the directory that will be used for exporting reports.
**Fax Server Directory:** Enter the directory that will be used for processing AF2000 documents.

**NOTE:** This option is used with the *AF2000 Module*. This module allows you to fax documents directly from the RM2000 program.

**Route Track 2000 Directory:** Enter the directory that will be used for processing Route Track 2000 data.

**NOTE:** This option is used with the *Route Track 2000 Module*. This module allows you to capture and upload route tracking data from your driver’s handhelds and GPS units for route optimization purposes.

**Map Point File:** Enter the directory that will be used for storing your Mappoint files.

**NOTE:** This option is used with the *Advanced Mapping Module*. This module allows you to plot your routes on a map and optimize your deliveries.

### Printers Tab

The *Printers* tab contains all of the available printer options in RM2000. Select a printer for each of the print options defined below.

#### Printers Information:

**Standard Printer:** Used for the majority of print jobs in RM2000, including reports.

**Use Standard Printer for All Printing:** Choose this option to use the *Standard Printer* for all of your printing needs.
**Afternoon Report Printer:** Used for printing reports during the transfer of data from the handheld to the desktop.

**Fax Printer:** Used only when selected. It should be connected to a fax ‘driver.’

**Telephone Request Printer:** Used for printing Telephone Orders.

**Impact Printer (Custom):** Impact or dot matrix printer used by delivery tickets, some customized statements, and self-mailers.

**9 or 24 Pin Head:** For dot matrix (impact) printers, indicate what type of printer you are using.

**Label Printer:** Used for printing customer mailing labels.

**Laser:** Used with the Label Printer, indicate whether or not it is a laser printer (this option will also enable multiple label formats).

**Statement Printer:** Used for printing statements.

**Invoice Reprint Printer:** Used for reprinting invoices and printing from the Invoices and Adjustments screen.

**Use Invoice Reprint Printer for Statements with Invoice Copies:** Choose this option to direct all of the invoices to the ‘Invoice Reprint Printer’ when printing a Statement with Invoices — the statement will always print on the ‘Statement Printer.’
Message Entry

The message entry option allows the ability to create custom messages based on specific criteria that can be relayed to your employees.

Message Type: Select the type of custom message that will be used:

1. Route Message: This message will be displayed within Customer Information based on the route assigned to each customer.

2. Employee Message: This message will be displayed for an individual employee when they log into the program.

3. Customer Message: This message will be displayed on an individual customer account.

4. Handheld by Route: This message will appear on the handheld for the route assigned.

5. Handheld by Area: This message will be displayed on the handheld based on the assigned Group Area Codes.

NOTE: The options displayed below vary based on the Message Type selected.

Route: The route that will receive the message.

All Routes: Select this option to send the message to all routes.

Entered By: The employee that created the message.

Message: The message to be displayed.

Start Date: The starting date for the message to appear.

Time: The starting time for the message to appear.

Expires Date: The ending date for the message.

Time: The ending time for the message.

Entry Date: The date the message was created.
**Time:** The entry time of the message.

**Load from Host (Docking Only)**

When using RM2000 Docking, this function allows new data to be imported into RM2000 from your host system. Do this once each day after going through the step of creating the ‘DL’ files on your host accounting system.

![File selection dialog](image)

**NOTE:** The Load from Host and Output to Host functions are only available for use with the RM2000d software. The specifications for these files are contained in the RM2000 Docking Manual.

Simply choose a file in the displayed box and click ‘OK’. The system will then begin to acquire the data from the ‘DL’ file and populate the RM2000 tables. To exit this program, click on the ‘Cancel’ key.
Output to Host (Docking Only)

This function creates a single data file containing all transactions from the handheld for a single date. The file can then be used with your host accounting system to eliminate the need to enter transactions manually.

Choose a date that should be exported as a ‘UL’ file. The file will then be created and placed into the directory specified within the Local Settings screen.
Import

The Import feature allows files for customer, equipment, and routing data to be imported.

- Customers
- Equipment
- Routing
- Driving Directions (Roadnet)

These options help to avoid manually entering each customer or each piece of equipment into RM2000.

Customers

You can import customers from your existing accounting software package (Peachtree, QuickBooks) by exporting your data into an excel spreadsheet file. A systematic guide has been created for this procedure and can be downloaded from our Web site at www.ARS247.com.

NOTE: Customers can only be imported during the initial setup process. Attempts to import more than once will override existing customer accounts.

Use the screen below to select the file you wish to import:

- **Import File Host Program:** Select the original accounting program the data is being imported from.
- **File to Import:** Select the file to import.
Equipment

The Equipment import option allows you to import equipment serial numbers from a spreadsheet file.

**Importing Equipment:**

To import data from a spreadsheet, the file must be placed in the root directory of your RM2000 program. Additionally, the file must have an .XLS extension and the name cannot contain any spaces (i.e., equipimport.xls, not equip import.xls).

Replace existing data: Check this box to overwrite existing coolers that have the same serial numbers when importing the equipment file.
**Spreadsheet file specifications:**

<table>
<thead>
<tr>
<th>Description</th>
<th>Bytes</th>
<th>Type</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Equipment Serial No.</td>
<td>16</td>
<td>C</td>
<td>Letters or Numbers</td>
</tr>
<tr>
<td>*Equipment Type</td>
<td>10</td>
<td>C</td>
<td>Must match desc. in RM2000</td>
</tr>
<tr>
<td>*Equipment Style</td>
<td>20</td>
<td>C</td>
<td>Must match desc. in RM2000</td>
</tr>
<tr>
<td>Purchase Date</td>
<td>12.31.2001</td>
<td>D</td>
<td>Use Standard Date format</td>
</tr>
<tr>
<td>Purchase From (vendor)</td>
<td>10</td>
<td>C</td>
<td>Name of Vendor or Manufacturer</td>
</tr>
<tr>
<td>Purchase Price (cost)</td>
<td>999,999,999.99</td>
<td>N</td>
<td>Cost from Vendor</td>
</tr>
<tr>
<td>Equipment Financed</td>
<td>True or False</td>
<td>L</td>
<td>Equipment Finance: TRUE or FALSE</td>
</tr>
<tr>
<td>Product Charge Code</td>
<td>5</td>
<td>C</td>
<td>Must be a valid product code in RM2000</td>
</tr>
<tr>
<td>Equipment Period Code</td>
<td>1</td>
<td>C</td>
<td>Default Rent Payment frequency: M=Month</td>
</tr>
<tr>
<td>Rent Rate for Period</td>
<td>999,999,999.99</td>
<td>N</td>
<td>Default Rent rate per month</td>
</tr>
</tbody>
</table>

* Denotes required fields.

**Preparing the file:**

An example of a properly formatted equipment import file is shown on the following page. Use the examples provided to assist you with preparing your equipment file for import.

**NOTE:** Only three of the ten columns are required.
The following example shows all ten fields that can be used:

![Excel spreadsheet showing ten fields]

This example shows an import file that contains only the minimum requirements:

![Excel spreadsheet showing minimum requirements]

---

Route Manager 2000 User Guide Chapter 5 – Company Information ● 70
**Importing the file:**

When you click on File > Import > Equipment, the file will appear in the import list. Select the file and click ‘OK’ to import the data.

Once the import is complete, print out an equipment list to verify that the information has been successfully imported.

**Import Routing**

This option is part of the *RDEX Module*, which is designed to work with routing programs such as *Territory Planner*. Please contact Advantage Route Systems or your reseller for additional information.

**Driving Directions (Roadnet)**

This option is used for importing driving directions for your routes when using the *Roadnet* program.
Export

The Export feature allows you to export any RM2000 database file into a format of your choice (e.g., Excel, Plain Text) as well as export routing information for third party programs (e.g., Territory Planner).

Export Databases

The Export feature allows any database file from RM2000 to be exported. You can use this option for any number of reasons, such as creating your own reports, creating mailing labels, and more.


Fields:

Save As: After you have selected a database file to export from the list, enter an easy to remember name here that will be assigned to the exported file.

Type: Choose the file format that you would like to save the exported file as (e.g., XL5 (Excel), Delimited (Plain Text)).

Delimited With (on Delimited only): Each string variable must be delimited with a character, such as “quote marks. Enter the character(s) to use.
**Delimiter (only available on Other below):** The Delimiter indicates a character that will separate each field in the file.

Choose one of the following field Delimiter options:

- **Other**
- **Blank**
- **Tab**

**NOTE:** If ‘Other’ is selected, enter the desired character in the Delimiter field.

---

**Export Routing**

This section is dedicated to exporting routing information that will be used by *Territory Planner*. If you purchase it, you will be given documentation for this section.

---

**Maintaining Data Files**

The following utilities help to maintain a clean database. They can also be used to upgrade your database or even correct problems with files. If you are working in a multi-user environment, make sure all users exit RM2000 before running these utilities.

**Rebuild Data Files**

If you are having problems with your data, our support staff may advise you to rebuild your system’s data files, this process can resolve a majority of data related issues that arise.

The three different processes of this function are displayed on the Rebuild Data Files screen below:

![Rebuild Data Files Screen](image)

*Rebuild Databases:* This option will optimize your data files and resolve data issues that arise. It is recommended that you do this once per week.
Rebuild History Files: This option will rebuild the system’s historical data tables.

NOTE: Rebuilding history files may take a while. We recommend only performing this step when you have adequate time to allocate for this process.

Perform Data Integrity Check: This option will run a check on the RM2000 data set for errors and problems — this option should be run periodically, but not every time you rebuild. The system checks all areas of the program for data-related errors.

You can make your selection by double-clicking on each item individually, or click on the ‘Select All’ and ‘De-Select All’ buttons to toggle the options globally. After you have made your selections, click Next. Click Abort to stop the Data Integrity Check at any time.

NOTE: The print button next to ‘De-Select All’ will give you a summary of errors in each category selected. This can be helpful for running a quick-check for problems in each section.

Pack

Run the Pack function periodically to clean out deleted records. This option will permanently remove the red background items you may encounter after deleting an item.

Select ‘OK’ to run the Pack function.
Backup/Restore

The Backup Files function gives you the option of backing up your data files or restoring them.

### Backup Data Files

Use the Backup Data Files function to create a backup copy of your RM2000 data. The backup destination drive is determined by the Backup Directory location established under File > Local Settings.

A description or comment concerning the contents of your backup can be entered in this screen if desired.

**NOTE:** If you are attempting to backup to CD-R, the writing software you choose may not allow you to copy data directly to the disk. If this is the case, then you must first backup your data to the hard drive, and transfer the RM2K backup file to a CD.

### Restore Data Files

Use the Restore Data Files function to restore previously backed up RM2000 data. In order for the backup file to be listed, then it must be placed in the original location where it was created.
CAUTION! Performing this function will over-write the data currently in your RM2000\DATA folder!

The screen below will appear when restoring data files is completed.

Printer Setup
The Print Setup procedure allows you to determine printer settings that will be used when generating reports.
Exiting the System

The following options are used to logout or exit from the RM2000 program.

Logout

This function allows a user to sign off and log on again as a different user.

By selecting ‘Yes’, you are returned to the Login screen. Enter a new user ID to log back in to RM2000.

Exit

If you would like to exit the RM2000 program; then select the Exit option.

Select ‘Yes’ to exit, or choose ‘NO’ to remain in RM2000.
Chapter 6 – Setting Up List Information

Overview

The Lists menu allows you to input and edit information that is used throughout both the desktop system and the handheld.

<table>
<thead>
<tr>
<th>Customer Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer Setup Codes</td>
</tr>
<tr>
<td>Product Codes</td>
</tr>
<tr>
<td>Accounting Setup</td>
</tr>
<tr>
<td>Equipment</td>
</tr>
<tr>
<td>Handheld</td>
</tr>
<tr>
<td>Employee Setup</td>
</tr>
<tr>
<td>Truck Information</td>
</tr>
<tr>
<td>Custom Report Groups</td>
</tr>
<tr>
<td>Wizards</td>
</tr>
</tbody>
</table>

These topics are described individually within this chapter.
Inputting Customer Data

The most important information in the RM2000 system is the customer data. This includes names, phone numbers, account balances, route information, and more. Before inputting customer information, certain codes and preliminary data must be set up. If you are unsure of what to do, refer to Chapter 3: Setting up Your System, or the Getting Started Guide.

Customer Information

The customer list contains several tabs. These tabs provide fields that display — and allow editing — specific information about customers.

Information Tab

The Info tab contains the address and contact information for each customer:

Fields:

Account Number: This field contains the customer’s account number, up to six characters.

Business License: Enter the customer’s Business License ID, if applicable.

SS Number: Enter the customer’s Social Security Number or any other desired information, up to 20 characters.
**Bill To:**

*Name:* Enter the customer’s *Bill To* name — for printing purposes and easier retrieval of information, enter the person’s last name, then the first name, separated by a semi-colon. When you print invoices or statements, each name will then print in the correct format: first name followed by last name. For businesses, enter the company’s complete business name.

*ZIP Code:* Specify the customer’s ZIP or postal code. You may do this by selecting one of the ZIP Codes from the drop-down list, or by typing it in.

[Check Address] Click this button to verify the customer’s address using the *Advanced Mapping Module* (requires additional software).

*Address:* Enter the customer’s billing address.

*Extra:* Use this field for any additional data that you would like to use for reference; for example, this can be an old account number.

**Contact Info:**

*Phone:* Enter the customer’s primary phone number. You can also include an extension number up to four digits.

*Fax:* Enter the customer’s fax number.

*Contact:* Enter the name of the person to contact for assistance with this account.

*Contact Phone:* Enter the phone number for the contact person.

*Email:* Enter the customer’s Email address.

[Email Icon] Click this icon to create a new Email that can be sent to the customer (requires additional setup).

*Sales Rep1 and Rep2:* Displays the customer’s assigned primary and secondary sales representative. The representative’s initials will be available from the drop-down list.

*Master Bill Account Number:* Enter the account number that will be responsible for all posted transactions on this account.

**NOTE:** A binoculars button will appear if the account is either a *Master* or *Sub-Account*. Clicking on the binoculars will either direct you to the *Master Account*, or display all of the associated *Sub-Accounts*, for quick access.
Note: This information box can be used to record permanent notes about the individual “personality” of the customer. Messages such as “Never pays on time,” “Promises check but sends it late,” or “Always speak with Mark to confirm special orders,” should be recorded in this area. These messages are only displayed on the screen, and the customer will never see them — this field is not to be used for contact history information. Instead, use the Contacts tab for this purpose.

Statement Message: This option allows you to add a customized message to this customer’s statement. Messages such as, “Give this statement to Mark in accounts payable,” or “Products delivered under this invoice qualify under the National Atmospheric plan,” can be helpful for billing purposes.

NOTE: This message will only print on the current customer’s statement. To display a universal message on all statements, use the Statement Notes option under Lists > Customer Setup Codes > Statement Codes, on the Messages tab.
**Finance Tab**

The *Finance* (§) tab includes information related to account balances, customer history, and finance charges.

**NOTE:** Depending on the values in your *Regional Settings*, there may be a character other than a $ sign representing the *Finance* tab. This is used in the United States and Canada.

### Balances:

**Balance Forward:** The customer’s ending balance carried forward from the previous month.

**Current:** The customer’s balance from their activity for the current month.

**31-60 Days:** The amount this account owes 31-60 days from the current date.

**61-90 Days:** The amount this account owes 61-90 days from the current date.

**91-120 Days:** The amount this account owes 91-120 days from the current date.

**120+ Days:** The amount this account owes 120 or more days from the current date.

**Total Due:** The amount the customer owes as of the last posting (the total for all balances owed).

**Highest Balance:** The highest balance ever reached on this account. This field automatically updates during the *Post Transactions* function.
Totals:

**View:** Allows you to view detailed lists of the sales and profits for both monthly and year-to-date totals. Select the Invoice Lookup button and a new screen will appear, similar to the one below, which displays the last 12 months of data as well as a list of the customer’s current Open Invoices (if enabled).

![Invoice Lookup Screen]

**Open Invoices:** The open invoice listing shows any open items on the account. These items are listed on this screen until a payment has been applied to them.

**NOTE:** The Open Invoices will only be listed if the ‘Open Invoice’ option has been selected on the Credit tab of the account.

Select one or more of the available periods (months) listed and click ‘Next’ to view the ledger of transactions. The following example has been obtained by selecting the ‘Current’ period on the previous screen.

![Invoice Listing Screen]
To view any invoice or payment listed, simply double-click directly on the item. RM2000 will then display the item on the screen. Additionally, the captured signature will appear if one was obtained, and you can print the item if needed.

Here is an example of an invoice with a captured signature:

![Invoice Example]

**NOTE:** If you would like the invoice to be converted to an 8 ½ x 11 format, you can go to File > Local Settings, and check the option ‘Use 8 ½ x 11 invoice format’.

**Other Options:**

- **Info:** Select a listed transaction and click this button to view additional information. When a payment is selected, RM2000 will display all invoices that the payment has been applied to (Payment Receipt). When an invoice is selected, RM2000 will display all payments that were applied to the invoice.

- **Fax (Requires Fax Server):** Select a listed transaction and click this button to send the selected item to the fax printer. You may choose multiple items by holding down the CTRL key on your keyboard.

- **Email:** Select a listed transaction and click this button to transmit the item via E-mail to the customer.

**NOTE:** In order for RM2000 to process E-mails successfully, you must have a valid email on the customer’s account (Info tab), and Microsoft Outlook, or SMTP options configured under File > Local Settings. > Communications tab. Refer to the Supplemental Guide for further information.
Totals, continued…

Sales: Displays the monthly and year-to-date sales figures on the account (sales tax is not included).

Profit: Displays the total monthly and year-to-date profits accumulated on the account.

NOTE: Product Costs must be up-to-date within Lists > Product Codes > Product Charge Codes in order to use this feature.

Invoices: Displays the total number of monthly and year-to-date invoices created on the account.

Finance Charges:

J F M A M J J A S O N D: Indicates each month of the year. RM2000 will automatically check the box under each month that the customer receives a Finance Charge.

Times Late: Displays the total number of times that the customer has carried a Past Due balance (as defined by their assigned Credit Class).

Unpaid: Displays the total dollar amount of unpaid Finance Charges that have accumulated on the account.

Y-T-D: Displays the total year-to-date dollar amount of Finance Charges generated on the account.

Last Date: Displays the last date that a Finance Charge was generated on the account.

History:

Last Transaction: The date of the customer’s last transaction or sale (invoice only – does not include payments, finance charges, or no-sale deliveries).

Last Payment: The date the customer last made a payment.

Last Pay Amount: The last amount paid by the customer.

Last Check Number: The last check number received from the customer (corresponds with the previous two fields).

Last Statement: The date that the last statement was generated for the customer.

Deposit: Amount of initial setup deposit or equipment deposit being retained by your company for this customer.
**Returned Checks:**

**Number:** The check number of the last returned check on the account.

**Date:** The date of the last returned check.

**Amount:** The amount of the customer’s last returned check.

**Returned Check:** This box will be automatically checked if the customer currently has a returned check being processed on their account. Additionally, a ‘Returned Check’ flag will appear on all screens for the customer.

**Paid:** This box will be automatically checked when a ‘paid’ entry has been completed for the current returned check under *Transactions > Payments > Returned Check Processing.*

**Credit Tab**

The *Credit* tab includes various account settings, such as account types, statement codes, and more.

**NOTE:** Most of the options on this screen are required and can be created under *Lists > Customer Setup Codes.*

---

**Credit Terms:**

**Customer Type:** Displays the assigned *Customer Type Code.*

**Credit Class:** Displays the assigned *Credit Class Code.*

**Finance Charge:** Displays the assigned *Finance Charge Code.*

**Administrative Charge:** Displays the assigned Administrative Charge Code. This option is typically used for generating additional ‘handling’ fees on large volume accounts.
**Statement:** Displays the assigned Statement Code.

**Rent Invoice:** Check this box to print rental invoices separately when generating statements on the account.

**Credit Limit:** Enter a credit limit on the account, if necessary.

**NOTE:** If you do not wish to establish a limit on the customer’s balance, leave this field defaulted to 0.00.

**Price Level:** Displays the assigned Price Level on the account.

**NOTE:** Up to ten different Price Levels can be selected. Each Product Charge Code should have a price entry for each level if you are going to use this option. Refer to Lists > Product Codes > Product Charge Codes, on the Pricing tab.

**Open Invoice:** Select this option to age and apply payments to all open items on this account. If this option is not selected, all items on the account will be combined, and payments can only be applied to the total amount due.

**Start Date:** The date the customer began service.

**Start Reason:** The reason the customer began service.

**End Date:** The date the customer terminated service.

**End Reason:** The reason the customer terminated service.

**Suspend Date:** Enter the date you wish to temporarily stop service on this account.

**Suspend Reason:** Select the reason that the customer’s service was suspended.

**End Suspend Date:** Enter the date you wish to end suspension of service to this customer.

**Email Type:**

**Plain Text:** Select this option to use a plain text format when emailing this customer.

**HTML:** Select this option to use an HTML format when emailing this customer.

**As Attachment:** Select this option to attach a .PDF file when emailing this customer.

**NOTE:** To email customers, you must have a valid email address on the Info tab. Additionally, email settings need to be configured under File > Local Settings, on the Communications tab.
Credit Card (EF2000 Module):

The Credit Card button allows you to store credit card details on the customer’s account. This information will be used to process transactions through a third party vendor.

Fields:

Cardholder First Name: Enter the cardholder’s first name.

Cardholder Last Name: Enter the cardholder’s last name.

Company Name: Enter the company name associated with the card, if applicable.

Individual / Business: If this card is part of a business account, select Business and enter a Company Name.

Cardholder Address: Enter the cardholder’s address.

Cardholder City/State/ZIP: Enter the cardholder’s City, State, and ZIP code.

Phone Number: Enter the phone number for the cardholder.

Email: Enter the cardholder’s email address.

Credit Card Number: Enter the number of the cardholder’s credit card.

Expiration Date: Enter the expiration date of the credit card.

Card Type: Select the appropriate credit card type from the drop-down list.

Last Bill Date: The date the last time the card was billed.

Last Bill Amount: The amount of the last credit card charge.

Last Bill Status: The status of the customer’s last billing.
Customer Notified: Enter the date the customer was notified of their status.

Don’t Bill: This option prevents this card from being billed during credit card processing.

Signature on File: Check the box if you have a hard copy of the customer’s signature in your office — some credit card processing systems require you to have a signature on file in order to process payments.

NOTE: When the Signature on File box is checked, the credit card flag will turn green. By default, the flag will be red.

C.V.V.: Enter the 3-digit code that is usually found on the back of the credit card.

Validate CC #: Press this button to ensure that the number entered is valid.

Bill:

Bill One Time Only On: Enter the date to bill the customer one time only using the credit card on file.

Amount: Enter the amount to bill the customer, or simply leave it blank to bill the customer for their total amount due when the transaction is processed.

Monthly: Select this option to bill the customer each month using the credit card on file.

By Group: Select this option if you would like to assign the current credit card to a Credit Card Group. This option allows you to bill credit cards in different batches throughout the month.

NOTE: Credit Card Groups can be set up under Lists > Accounting Setup.
Bank Transfer Info (EF2000 Module):
This optional module allows each customer’s bank information to be saved and billed on the customer’s account.

Fields:

**Bank Name:** Enter the name of the customer’s bank.

**Bank Address:** Enter the address of the bank.

**Routing Information:** Enter the routing code or information needed to access this customer’s account.

**Don’t Bill:** This option prevents this card from being billed during bank processing.

**Account Name:** Enter the name on the bank account.

**Account Number:** Enter the customer’s account number.

**Last Bill Date:** Enter the date of the last billing.

**Amount:** Enter the amount of the last billing.

**Status:** The status of the account.

**Customer Notified:** Enter the date the customer was provided with a status notification.

**Branch:** Enter the branch number of the bank.

**Authorization Expiration Date:** Enter the expiration date of this information.

**Maximum Amount Authorized:** Enter the maximum amount to bill.

**Amount Used:** Enter the amount billed to date.
**Bill:**

**Bill One Time Only On:** Enter the date to bill the customer one time only.

**Amount:** Enter the amount to bill the customer, or simply leave it blank to bill the customer for their total amount due when the transaction is processed.

**Monthly:** Select this option to bill the customer each month.

**By Group:** Select this option if you would like to assign the account to a Credit Card Group. This option allows you to bill your customers in separate batches throughout the month.

**Release Code:**

Selecting this option will generate a code that can be entered on the driver’s handheld to authorize a new invoice for customer’s that are past due, over their credit limit, or placed on hold service.

**NOTE:** Each Release Code option can be defined within Lists > Handheld > Handheld Options, on the Handheld tab.
Contacts Tab

The Contacts tab contains logged messages and order history on the customer’s account. It provides a useful log of events that have occurred with the customer. Some information is logged manually, while others are automatic.

NOTE: The automatic events can be defined under Company Setup, on the Defaults tab.

Fields:

Add: This button will allow you to create a new Contact Reason on the account. This will allow you to record any number of reasons why the customer was contacted, enter specific details, and schedule a follow-up if necessary.

Delete: This button will delete any selected records on the screen.

Modify: This button will allow you to edit any currently selected records.

Playback Message (RV2000 Module): This button will allow you to listen to voice messages left by the customer.

Handheld Notes: Click this button to view any handheld notes associated with the selected entry on the screen.

NOTE: Notes entered on the handheld can be automatically stored on the Contacts tab by selecting the Handheld Notes option under File > Company Setup > Defaults tab.

View Telephone Request: Select a Telephone Request on the screen and choose this button to preview the order on the screen.
**Other Fields:**

*View Files (EF2000 Module):* This button allows you to view scanned documents and agreements on the account.

**Creating Message Screen:**

The following screen will be displayed when the *Add* option is selected.

![Customer Information Screen]

**Fields:**

*Spoke with:* The name of the customer you are contacting.

*Date:* The current date.

*Time:* The current time.

*Follow Up:* The date the customer should be contacted again for follow-up.

**NOTE:** Leave the date defaulted to the current date if no follow-up is necessary.

*Who:* The employee that contacted the customer.

*Contact Reason:* Choose a ‘reason’ for the type of message. This list can be established under *Lists > Customer Setup Codes > Contact Reasons.*

*Show message on payment entry:* Select this option if you would like the current message to pop-up when entering a payment on the account.

*Message:* Enter the message details here.
Route Tab

The Route tab contains all of the customer’s routing information. Each account can have up to 99 stops on the Route tab. A record will exist for each stop that will include all of the required routing information. All of the options are discussed below.

Fields:

Delivery Name/Address: Enter the delivery name of the customer receiving the delivery.

ZIP Code: Select the delivery ZIP code from the drop-down list.

MangoGeo: Select this option to use the MangoGeo program for address verification and correction services.

NOTE: Try the MangoGeo program at no charge for fifteen addresses before being prompted to sign up for service. Additionally, you will automatically receive fifty additional usages by simply provided us with your contact information if you’re interested in the program.

Verify Address: Select this option to check the customer’s address on the USPS Web site (requires active internet connection).

Check Address: Select this option to verify address information using the Advanced Mapping Module.

NOTE: The Advanced Mapping Module integrates with Microsoft Mappoint to provide address correction and route optimization options. Contact Advantage Route Systems for further information.

Delivery Address: Contains up to two delivery address lines per account.
**Delivery Contact Info:**

- **Contact Name:** The name of the person to contact for deliveries.
- **Contact Phone:** The phone number for the contact person.
- **Delivery Phone:** The customer’s primary delivery phone number. You can also include an extension if necessary.
- **Phone:** Enter the customer’s delivery phone number. You can also include an extension number, up to four digits
- **Fax:** Enter the customer’s delivery fax number.
- **Email:** Enter the customer’s delivery email address.

**Other Delivery Name / Address Fields:**

- **Send Message:** This option can be used to send a message to the driver assigned to the customer’s route.

![Message Window]

- **To:** The recipients email address.

**NOTE:** You can establish an email address within each driver’s Employee Setup screen to automatically populate the address within this screen.

- **Cc:** Enter an address to send a copy of the message to, if desired.
- **Incl. Operator Name:** Select this option to include the name of the employee sending the message.
- **Incl. Operator Phone:** Select this option to include the phone number of the employee.
- **Call office first:** Select this option if the driver should call the office prior to acting on any instructions in the message.
**Driver:** This field displays the name of the driver that is assigned to the route selected for this customer.

**Route:** Enter or select the route code from the drop-down list, up to three characters.

**Next Sequence:** The route sequence will be displayed for the next delivery.

**Next Delivery:** This field displays the next delivery date for this customer.

**Last Delivery:** This field displays the last delivery date. The system updates this field each time a delivery is made.

**Latitude and Longitude:** Enter the coordinates of the customer’s delivery location. This is to be used with the optional mapping software.

**Map Page:** When using paper maps, designate the page/location on which this customer’s delivery point is located.

**Key No.:** Some delivery locations may require a key to enter. Usually a key is stored in a locked box at the office that is referred to by a code or number. Store that number here.

**Sales Tax:** Specify the customer’s sales tax rate using the drop-down list.

**Driver:** This field displays the name of the driver that is associated with the route assigned to the current stop.

**Route:** The route assigned to the current stop.

**Next Sequence:** The sequence number assigned to the next delivery date.

**Next Delivery:** The next scheduled delivery date for the customer.

**Last Delivery:** The last delivery date for the customer.

![Generate Lat/Long (Internet Required):](image) Select the ‘globe’ to populate the Latitude and Longitude fields — based on the customer’s delivery address.

**Latitude and Longitude:** The coordinates of the customer’s delivery address.

---

**NOTE:** This information is used with MangoGeo, TomTom, and the Advanced Mapping Module.

**Map Page:** This field can be used to reference a page number when using a map book (e.g., Thomas Guide) on route. The reference information is displayed within the *Driver Instructions* field on the handheld.

**Key No.:** This field can be used to store a key code, and is displayed within the *Driver Instructions* field on the handheld.

**Sales Tax:** The customer’s assigned Sales Tax Code. The rates listed are established under *Lists > Accounting Setup > Sales Tax Rates.*
DEX/EDI Info: This option is used to transfer transaction data to customers and requires custom programming. Contact ARS for further information.

Stop Navigation: These options allow you to navigate through each stop on a multiple stop account. Each stop is identified by a stop number. Click on the arrows pointing to the right or left to scroll through each stop, or choose the binoculars to manually select the desired stop.

Messages:
The Messages feature allows you to enter messages that can be viewed by your drivers on the handheld. These messages may include special instructions while on-site, or notes on how to get to a location.

Fields:

Alert Message: Enter a message here that you would like to popup automatically each time the driver accesses the customer on the handheld.

One Time Message: This message is similar to the alert message, except it will only appear on the handheld for the period of time defined in the Begin and End date fields to the right of the message.

Begin and End: These date fields control the duration of time the One-Time Message above will be displayed on the handheld.

Driver Directions: This message can be used to give the driver simple driving instructions to the stop.

Site Instructions: This message can be used to provide the driver with delivery instructions while on-site.

Invoice Messages: This message can be used to print additional information on the customer’s receipt with each delivery.
Route Calendar

Use the Route Calendar to set up your customer’s delivery days. To schedule the customer, each stop will be assigned to a Day Label on the calendar. The steps are covered after the field definitions below.

Fields:

**Acct Number:** This field displays the current customer’s account number.

**Route:** This is the route for this customer’s stop.

**Schedule by Day Label:** This gives you the option of choosing any day label in your calendar. The customer will receive a delivery each time the day label shows up on the calendar.

**NOTE:** Customers can be assigned to multiple Day Labels if necessary.

**Special:** This allows for a one-time route change. A new route can be specified for this particular day only.

**Skip Delivery/Stop:** To skip a delivery or stop, select this option.

**Clear:** This option clears the entire calendar for the selected customer.

**Color-Coded boxes:** The boxes below the calendar act as a key or a legend used to identify the type of stop that is entered:

- **Red:** Automated schedules. This appears when you use a repeating schedule.
- **Green:** A stop that was automatically “dragged” from a previous day.
- **Yellow:** A special delivery day. This appears after you have used the Special button or have scheduled a Telephone Request.
Scheduling a Customer:

After choosing the Schedule by Day Label button, the following message will appear. Make your selection and click OK to continue.

<table>
<thead>
<tr>
<th>Select Day</th>
</tr>
</thead>
<tbody>
<tr>
<td>Which day do you want to schedule by?</td>
</tr>
<tr>
<td>B01</td>
</tr>
<tr>
<td>B01</td>
</tr>
<tr>
<td>B02</td>
</tr>
<tr>
<td>B03</td>
</tr>
<tr>
<td>B04</td>
</tr>
</tbody>
</table>

Each stop will need to be ‘sequenced’ into the route based on delivery location. Enter the appropriate Sequence Number, or leave it blank for the driver to sequence the stop manually on the handheld.

<table>
<thead>
<tr>
<th>Stop Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter Sequence No. 0010</td>
</tr>
</tbody>
</table>

Click OK to complete the process.

**NOTE:** Each sequence number is always four digits in length (e.g., 0010, 1050).

Once you have successfully routed the stop, each delivery day will be colored red on the calendar.
**View Entire Route:**

Right-click on any date on the calendar and a box will appear, as shown below:

```
<table>
<thead>
<tr>
<th># of Stops</th>
<th>55</th>
</tr>
</thead>
<tbody>
<tr>
<td># of Bottles</td>
<td>0.00</td>
</tr>
<tr>
<td>View Route</td>
<td></td>
</tr>
<tr>
<td>Route R01</td>
<td></td>
</tr>
</tbody>
</table>
```

This enables you to view scheduled route deliveries in detail for that day.

**View Delivery Schedule:**

To view or print the current customer’s route calendar up to a year in advance: right click on the route Calendar button from the Route tab.

```
<table>
<thead>
<tr>
<th>June 2005</th>
<th>July 2005</th>
<th>August 2005</th>
<th>September 2005</th>
</tr>
</thead>
<tbody>
<tr>
<td>S M T W T S</td>
<td>S M T W T S</td>
<td>S M T W T S</td>
<td>S M T W T S</td>
</tr>
<tr>
<td>1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>S M T W T S</td>
<td>S M T W T S</td>
<td>S M T W T S</td>
<td>S M T W T S</td>
</tr>
<tr>
<td>1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>February 2006</td>
<td>March 2006</td>
<td>April 2006</td>
<td>May 2006</td>
</tr>
<tr>
<td>S M T W T S</td>
<td>S M T W T S</td>
<td>S M T W T S</td>
<td>S M T W T S</td>
</tr>
<tr>
<td>1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Click ‘OK’ to return to the main route screen.
DEX/EDI Info (RDEX Module)

DEX/EDI is a format used by large companies that allows the driver to electronically upload the customer invoice into their database system, rather than print a receipt for that customer.

**NOTE:** This is part of the RDEX Module, contact ARS for further information.

![DEX/EDI Information](image)

**Dunns:** This information will be provided to you by your DEX customer.

**Comm Id:** This information will be provided to you by your DEX customer.

**Location:** This information will be provided to you by your DEX customer.
Supplemental Route Options Menu

In this section, you can select from one of six different screens. Each option is described below.

<table>
<thead>
<tr>
<th>Handheld Options</th>
<th>PreCalling</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purchase Order</td>
<td>Water Analysis</td>
</tr>
<tr>
<td>Site Stats</td>
<td>Par</td>
</tr>
</tbody>
</table>

**Handheld Options:**

This section contains items that apply to the handheld for this stop.

- **Suppress Balance:** Check this box to prevent the account balance from appearing on your customer’s printed handheld receipt.
- **Signature Required:** Select this option if you would like to capture a signature from this customer with each delivery.
- **Remittance Stub:** Check this box to print a remittance stub with the printed handheld invoice.
- **Suppress Prices on Invoice:** Select this option to suppress all product prices on the printed handheld receipt.
- **Group Area Code:** This option allows you to separate customers by groups within the Off-Route List of the handheld. The codes can be set up under Lists > Handheld > Group Area Codes.

**NOTE:** This feature is enabled by choosing Filter Types 5 or 6 within Lists > Handheld > Handheld Options, on the General tab.

- **Invoice Copies:** Enter the number of invoice copies you would like to print for the customer with each delivery (0-9).

**NOTE:** If ‘9’ is entered, a ‘delivery ticket’ will be printed, which suppresses all pricing details on the receipt.
**Pre-Call Options:**

The following fields contain settings for the *Route Pre-Sale* feature and the optional *RV2000 Module*.

- **Don’t Call:** Check this box if you are using the *RV2000 Module* and the current customer should not receive calls.
- **Start Time:** Enter the earliest time to contact this customer, in military format (e.g., 3:45 pm is entered as 15:45).
- **End Time:** Enter the latest time to contact this customer, in military format.
- **Language (Not Currently Active):** Select the language required when contacting this customer.
- **Phone Number to Call:** Enter the phone number to use when pre-calling this customer.

**Purchase Order:**

This section contains standing *Purchase Order* information that will be applied to all sales associated with this stop.

- **Purchase Order (up to 3):** Enter a purchase order up to 30 characters on the account.
**P.O. Exp. Date:** If you would like this P.O. to expire, enter an expiration date.

**Available:** This field is automatically updated when an amount has been entered within the **P.O. Limit** field below.

**P.O. Limit:** Enter the maximum amount that can be billed under the current P.O.

**Water Analysis:**

The **Water Analysis** option allows you to enter chemical and foreign material readings collected at each customer’s location.

![Water Analysis Table]

**Number Of Occupants:** The number of residents in the dwelling or using water from the well or other point source.

**Regeneration Cycle:** Water treatment equipment such as water softeners need to be regenerated. Enter the number of days or gallons to circulate between cycles.

- **Gals:** The number of gallons of water circulated through the chemical bed of the water softener between re-generation cycles.
- **Days:** The number of days that water is circulated through the chemical bed of the water softener between re-generation cycles.

**Hardness:** A measure of the calcium and magnesium salts in the water. Hardness is often measured in grains per gallon of water.

**Iron:** Amount of Iron in mg/L.

**Nitrates:** Amount of Nitrates in parts per million.

**Manganese:** Amount of Manganese in milligrams/Liter (mg/L.)

**pH:** pH value of the water. This is a number between 6 and 8.

**Alkalinity:** Amount of sodium present in mg/L.

**Tannins:** Amount of Tannins in water. Units of measurement vary.

**Hyd. Sulfate:** Amount of Hydrogen Sulfate in water.

**Chloride:** Amount of Chloride in mg/L.

**TDS:** Amount of Total Dissolved Solids in mg/L.

**Turbidity:** Measurement of the cloudiness in water.

**Iron Bacteria:** Amount of Iron Bacteria in water.
Other: This may include Oxygen, organic carbon, ammonia nitrogen, phosphorus, fluoride, aluminum, barium, cadmium, chromium, lead, zinc, fecal coli-forms, etc.

Site Stats:
Site Stats allow you to enter specific data regarding well depths and tank settings on-site.

Test Date: Date the water sample(s) were obtained.
Test Location: Enter a description for the location.
Water Source: This may be a well, spring, stream, impounded water, Artesian well, cistern, etc.
Well Depth: The normal depth to water if a well is the water source.
Pressure Tank Settings: In/Out: This is the pressure in pound per square inch (PSI) in the water supply tank. The pump may start operating at a Cut In pressure around 20 PSI and turn off or Cut Out at about 40 PSI. These setting vary depending on the location of the pressure tank with respect to plumbing fixtures.
GPM: This is normally the pumping rate in gallons per minute at a pressure rating of 40 PSI. This is the flow rate to the pressure tank.
EWU: Estimated water use (or usage). This is gallons or liters per day.

NOTE: The above information is collected by the driver or sales representative to analyze a customer’s needs.
**PAR (Optional Module):**

The Par Module is used to maintain an established level of product at all times with each delivery.

![Par Module Table]

**Fields:**

- **Product:** The product code of the par item.
- **Par Value:** The quantity to be maintained with each delivery.
**Products Tab**

The *Products* tab displays all default products, bottle deposits and equipment information assigned to each stop.

---

**Default Products:**

The items listed in this section are considered standing orders on the customer’s account. These items will be displayed on the handheld with each delivery. Each product can be set up at the desired price and quantity within this screen.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Price</th>
<th>Qty</th>
<th>Pkg</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>5 GAL WATER</td>
<td>4.75</td>
<td></td>
<td></td>
</tr>
<tr>
<td>101</td>
<td>3 GAL WATER</td>
<td>3.25</td>
<td></td>
<td></td>
</tr>
<tr>
<td>200</td>
<td>5LB COFFEE</td>
<td>3.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>240</td>
<td>LARGE CUPS 120CT</td>
<td>2.50</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Fields:**

*Code:* The identification code of the product.

*Description:* The description of the product.

*Price:* The price assigned to the product (may differ per customer).

*Qty:* The quantity that will be sold to the customer with each delivery.
Pending Order: Clicking on this button will bring up any current pending orders this customer may have. These orders are generated from the Telephone Request, Route Pre-Sale, or can be established manually.

Add: Select this option to add a new Default Product to the account.

Delete: Select an item and choose the delete key to remove an item from the Default Products list.

Modify: Select an item and choose the modify key to update the price or quantity of an item already added to the Default Products list.

Move: Use the arrows to change the order of the products displayed on the screen. The products will also be listed on the handheld in the same order.

Delivery Summary:

Click the Delivery Summary button to view products sold to the customer during the last five deliveries.

Fields:

Charge Code: The product charge code for each product delivered.

Product Description: The charge code description for each product delivered.

Dates: The delivery date of the last five invoices.

Average: The average quantity of products delivered.
Deposits:

This section displays and maintains empty container and deposit information for each customer.

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Price</th>
<th>Qty</th>
</tr>
</thead>
<tbody>
<tr>
<td>500</td>
<td>5 GAL DEPOSIT</td>
<td>5.00</td>
<td>4</td>
</tr>
<tr>
<td>501</td>
<td>3 GAL DEPOSIT</td>
<td>3.00</td>
<td>0</td>
</tr>
</tbody>
</table>

Fields:

Code: The product charge code for the container deposit.

Description: A description of the container deposit.

Price: The price of the container deposit.

Qty: The container deposit quantity.

NOTE: This number represents the number of containers on hand at this location. Normally, each quantity is updated automatically as your delivery person picks up and delivers product.

Deposits Total: The total amount charged for container deposits on the account.

Equipment:

This section contains all equipment assigned to the current stop.

<table>
<thead>
<tr>
<th>Equip ID</th>
<th>Type</th>
<th>Style</th>
<th>Freq Code</th>
<th>Rent</th>
<th>Installed</th>
</tr>
</thead>
<tbody>
<tr>
<td>EQUIP01234</td>
<td>COLD ON3 MOSS STINK</td>
<td>400</td>
<td>10.00</td>
<td>10/01/2015</td>
<td></td>
</tr>
</tbody>
</table>

Fields:

Equip ID: The serial number of the equipment located at this site.

Type: The type of equipment located at this site.

Style: The style of equipment located at this site.

Freq.: The rent billing frequency code used for the equipment (e.g., ‘M’ for Monthly).

Code: The product code assigned to the equipment that will be used when generating rent.

Rent: The rent amount charged for the equipment.

Installed: The date the rented equipment was installed.
**Exchange:** Select a piece of equipment and choose this button to exchange it for a new one — using this option will apply the customer’s current rental settings to the new piece of equipment.

**Add:** Select this option to add a new piece of equipment on the customer’s account.

**Remove:** Select a piece of equipment and choose this option to remove the item from the customer’s account.

**Modify:** Select a piece of equipment and choose this option to modify settings on the item.

**Other Fields:**

**Recurring Charges:** Select this option to add or view any Recurring Charges on the customer’s account — this type of charge is generally used to bill fuel surcharges or processing fees.

<table>
<thead>
<tr>
<th>Charge Code</th>
<th>Product Description</th>
<th>Amount</th>
<th>Last Billed</th>
<th>Pending</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Recurring Charges</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Fields:**

**Charge Code:** The product code used to bill a Recurring Charge.

**Product Description:** The product description.

**Amount:** The amount of the recurring fee.

**Last Billed:** The last date that a recurring fee was billed on the account.

**Pending:** This date will appear if there is currently a recurring fee that has been generated, but not posted on the account.

**Other Fields (Continued):**

**Use Price List:** Check this box to assign a pre-established list of items to the customer’s account. Price Lists can be created under Lists > Product Codes.

**Package:** This field is used with the Package Plan Module. Contact Advantage Route Systems for further information.
Customer Setup Codes

In order to set up customers in RM2000, a majority of the items listed within this section will need to be established. Each item is defined in the order listed.

<table>
<thead>
<tr>
<th>Credit Class</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dunning Messages</td>
</tr>
<tr>
<td>Dunning Letters</td>
</tr>
</tbody>
</table>

| Finance Charge Codes       |
| Administrative Charge Codes|
| Statement Codes            |

| Start/Stopp Reasons        |
| Suspend Service Codes      |
| Contact Reasons            |

| Customer Type Codes        |
| ZIP Codes                  |
| Telephone Reasons          |

NOTE: For additional assistance with setting up these items, refer to the Getting Started Guide.
Credit Class

The Credit Class option is used to assign past due terms, dunning notices, and other balance related rules to each customer.

Information Tab

The Information tab contains the primary setup items required for each Credit Class.

Fields:

Credit Class ID: Enter a single character that will represent the Credit Class.

Description: Enter a description for the Credit Class (e.g., Standard Credit, Excellent Credit, COD).

Extended Description: Enter any additional description, for reference.

Average Days to Pay: The average number of days that an account assigned to this Credit Class takes to make a payment (display only).

Collections Class: Check this option to display a ‘Collections’ flag on each account assigned to this Credit Class.

COD Class: Check this option display a ‘COD’ flag on each account assigned to this Credit Class. This option will also be used to control other activities on the customer’s account (refer to Handheld Options).

Past Due At: Choose the default number of days to notify the user and customer that the account is Past Due.

Dunning Notice: Choose the default number of days to begin printing a Dunning Message with all printed invoices and statements.

Hold Service: Choose the default number of days to place an account on ‘Hold Service’ status.

Ignore if Below: Enter the maximum balance that should be ignored under each respective option (i.e., if 1.00 is entered, all balances at 1.00 or less will be ignored).
**Statement and Handheld Dunning Message Code:** Select the Dunning Message Code that should be used for printing past due messages on invoices and statements.

**Dunning Tab**

The Dunning tab allows past due letters to be assigned to each Credit Class.

**Fields:**

- **Dunning Letter Type:** Choose a Dunning Letter to assign to each level.
- **Include Balances:** Enter the range of balances to include on each level.
- **Over Credit Limit Notice:** Choose a unique Dunning Letter for customers that have exceeded established Credit Limits.
Dunning Messages

Dunning Messages are past due messages that can be distributed to your customers on statements and handheld invoices automatically. Each Dunning Message is controlled by the customer’s assigned Credit Class.

Statements/Handhelds

These past due messages can be automatically included on statements and handheld receipts based on each customer’s assigned Credit Class Code.

**Fields:**

**Message ID:** Enter a single character that will be used to represent the Dunning Message.

**Maximum Characters for Message:** Enter the maximum number of characters your handheld printer will allow to use as a guide when setting up your handheld dunning messages (up to 60).

**Monthly Message:** Enter a message that will print automatically on each desktop and handheld statement.

**30- 120 days:** Enter all of the past due messages you would like to include on statements and handheld receipts for the customers that qualify.

**Show Grid:** This places a grid over the message field. It should be used as a character guide.
Dunning Letters

*Dunning Letters* are past due messages that can be distributed to your customers through the mail. Each *Dunning Letter* is controlled by the customer’s assigned *Credit Class*. The Statements and Handhelds tab both display the same message format.

**NOTE:** For the *Dunning Letters* process to function you must have MS Word 2000 or newer installed on the workstation where the letters will be generated.

### Fields:

**Letter ID:** Enter a single character that will represent the *Dunning Letter*.

**Location of Letter:** Enter, or browse to, the location of the letter.

**Description:** Enter a description for the letter.

**Valid Until:** Enter a date that this letter will be valid through (for reference).

**Comments:** Enter any comments regarding the letter if desired.

**NOTE:** For more detailed information on this procedure, refer to the *Supplemental Guide*. 

![Dunning Letters Window](Image)
Finance Charge Codes

*Finance Charge Codes* are used to assess late fees on past due accounts. Multiple rates may be used, but only one code may be applied to each customer.

**Fields:**

*Finance Charge ID:* Enter a single character that will represent the *Finance Charge Code*.

*Description:* The description of the *Finance Charge Code*.

*Annual Rate:* Currently not in use.

*Period Rate:* The percentage applied as a late fee to each account that is past due.

*Min. Charge:* The minimum charge that will be added to an account that is past due.

*Apply to Balance at:* Select the number of days overdue that you would like to qualify for a late fee.
**Statement Message:** This message will be included on statements generated for customers that received a *Finance Charge* for the month. The following optional fields can be added to the message, as desired:

- **{Days}** – Includes the number of days until payment is due, based on the ‘Due [ ] days from Close Date’ field of the *Statements* screen.
- **{Date}** – Includes the approximate date that payment is due, based on the ‘Due [ ] days from Close Date’ field of the *Statements* screen.
- **{Due}** – Includes the total amount due, based on the *Total Due* field of the customer’s statement.
- **{Late}** – Includes the balance due if the payment is late, based on the amount entered in the *Min. Charge* field of the *Finance Charge Codes* screen.

![Statement Message](image)

---

**Sample:** Please send your payment of $100.00 by 03/20/2017 to avoid a late fee.
Administrative Charge Codes

*Administrative Charge Codes* are used to assess ‘handling’ fees on large accounts that demand a high level of resources and time in the office. Multiple rates may be used, but only one code may be applied to each customer.

**Fields:**

*Administrative Charge ID:* Enter a single character that will represent the *Administrative Charge Code*.

*Description:* The description of the *Administrative Charge Code*.

*Rate:* The percentage applied to each account as an administrative fee.

*Minimum Charge:* The minimum charge that will be applied to each account.

*Charge Code:* Select the *Product Charge Code* that will be used to apply administrative fees to each account.
Statement Codes

RM2000 contains multiple statement types that can be configured to suit the needs of each company.

Layout Tab

The Layout tab controls the type of statement that will be used and a majority of the configuration options available.

Fields:

Statement ID: Enter up to two characters that will represent the Statement Code.

Description: Enter the description of the Statement Code.

Statement Label: Enter a title that will appear on the statement (e.g., Statement, Monthly Statement, Account Status).

Due Date... From Close Date: Enter a value that will be used to calculate the due date printed on each statement (i.e., if ‘15’ is entered and the statement is printed on 12/31, the due date used will be 1/15).

Exclude Amounts:

Minimum and Maximum: Enter a range of customer balances for which you would like to exclude statements from printing (i.e., in the example screen above, a statement will not be printed for any customer with a balance less than 1.00).
Statement Types:

No Statement: Select this option for customers that do not require a statement.

8.5" X 11" Statement: Select this option to use a standard printed 8 ½ x 11 statement format.

Bulk Statements: Select this option to create a bulk file that will be sent to an external statement processing company (e.g., Matrix Imaging).

Handheld Statements: Select this option to use a statement that will be printed from the handheld automatically during the last delivery of the month for each customer.

Fax: Select this option to use process fax statements to your customers (requires additional setup).

Email: Select this option to process statements via Email using Microsoft Outlook or SMTP service (requires additional setup).

Standard Postcard (Custom Only): Select this option to process statements using postcard paper stock.

Self Mailing (Custom Only): Select this option to process a 3-fold paper statement type.

Custom Statement: Select this option to process a custom statement.

Options:

The items listed below are available based on the Statement Type selected.

Include Payment Voucher: Select this option to include a payment voucher on Standard Statement types.

Include Invoices: Select this option to include separate invoice copies with each statement.

Rental Invoices Only: Check this box to only print Rental Invoices with each statement.

NOTE: This option only applies to customers with the ‘Rent Invoice’ option selected on the Customer Information > Credit tab. Additionally, in order for the invoice to be processed with the statement, the ‘Rent Invoice’ option will need to be selected prior to generating the customer’s rental.

Pre-Printed Form: Select this option to suppress information on the top left portion of the statement to allow room for pre-printed information.

Open Item Statement: Select this option to replace all of the monthly transactions with only the items that remain open on the account.

Day Aging: Enter a value here that will be used to separate each transaction into one of five aging levels (i.e., if 30 is entered, 5 aging buckets separated by 30 days each will be used).
Suppress Aging: Select this option to suppress all aging details from each statement.

Include Stop Information: Select this option to include detailed stop information on each statement (helpful with multi-stop accounts).

Include Bottle Count: Select this option to include a summary of the total number of bottles (containers) exchanged for the current period on the statement. This option also includes an ‘On-Hand’ total per container type.

Exclude Postal Bar Code: Select this option to suppress the USPS bar code from the statement.

Detail Side First (Custom Only): Select this option to print detailed line items on Postcard Statements first.

8 ½ X 11 Invoice Format: Select this option to convert all invoices to the 8 ½ X 11 invoice format (when selecting Include Invoices).

Include No Charge Items: Select this option to include items on the statement that were sold to the customer at 0.00 price.

Do Not Include Invoice Details: Select this option to suppress individual invoice details from each statement (will include invoice number and total only).

Suppress Options During Printing: Select this option to force the selected options to be used within the Statements screen (disables on-the-fly changes from being made).

Print Statements by Date Range: This option enables you to print statements for a specified date range. This is helpful if you want to show activity from the 25th of one month to the 24th of another.

Hide Payment Barcode: Check this box to suppress the payment barcode from printing on statements (requires scanner).
Messages Tab

The Messages tab contains company address details and special messages that can relay important information to each customer.

Statement Address:

Name: Enter the name of your company here. This will appear on the top of the statement.

Address: Enter the address for your company here.

Email Address: Enter an Email address for your company here.

Phone: Enter the company’s business phone number.

Accounting Message:

The Accounting Message can be used for relaying account related information to your customers.

Statement Notes:

The Statement Note can be used for promotional messages or general information that you would like relayed to your customers.
Start/Stop Reasons

Start/Stop Reasons are used to specify why customers start or stop service with your company.

Fields:

**Reason:** Enter the description for the Start or Stop Reason (e.g., Yellow Pages, Friend, Moving, Competitor).

**Moved:** Check the box if this reason will be assigned to accounts that have left your service area and terminated service, for reference.

**Start and Stop Figures:** Each box displays the total number of starts and stops for each period listed.

**NOTE:** More detailed information is provided in the Start and Stops report found under Reports > Management Reports.

**Reason Type:** Select the type of Start/Stop Reason this item represents.

**NOTE:** Select Both if you would like this item to show up as a Start and Stop Reason option.
Suspend Service Codes

Suspend Service Codes are used to temporarily remove customers from route for a given period of time.

**Fields:**

**Code:** Enter a single character that will represent the Suspend Service Code.

**Reason:** Enter a description for this Suspend Service Code.

**Default Days:** Enter the default number of days to suspend service for this code.
Contact Reasons

Contact Reasons are primarily used to identify correspondence between a customer and employee.

Fields:

**ID:** Enter a single character that will represent the Contact Reason.

**Description:** Enter a description for the Contact Reason.

**Follow-up Days:** Enter the standard number of days that will be assumed for following up on messages logged using this Contact Reason.

**NOTE:** Contact Message rules can be found under File > Company Setup > Logging tab.
Customer Type Codes

*Customer Type Codes* are the primary option to categorize customers into groups, and are used to assign a series of default customer settings from within the *New Customer Wizard*.

Common *Customer Types* used are:

- Residential
- Commercial
- COD

You may also establish types for school districts, store chains, etc.

**NOTE:** *Customer Type Codes* are used as filters on many reports in RM2000.

### Fields:

**Type ID:** Enter up to two characters to use as a customer type identifier.

**Description:** A description of the customer type.

### Customer Defaults:

To speed up data entry, the default settings below will automatically be assigned to accounts within the *New Customer Wizard* upon selection of the *Customer Type Code*.

**Credit Class:** Select the default *Credit Class Code* that should be used.

**Finance Charge:** Select the default *Finance Charge Code* that should be used.

**Admin. Charge:** Select the default *Administrative Charge Code* that should be used (optional).

**Statement:** Select the default *Statement Code* that should be used.
**Sales Tax:** Select the default *Sales Tax Code* that should be used.

**Price Level:** Select the *Price Level* that should be assigned to this *Customer Type Code*. Each *Price Level* relates to the *Pricing* tab within the *Product Charge Code* screen (up to ten levels of pricing can be established).

**Use Price List:** Check this box to assign a *Price List* to this *Customer Type Code*.

**Price List:** Select the desired *Price List* to assign to this *Customer Type Code*.

**Credit Limit:** Enter a default *Credit Limit*, if necessary. Leaving the amount at 0.00 is considered unlimited credit.

**Open Invoice:** Check this box to use the *Open Invoice* billing method as the default setting for this *Customer Type*. Using *Open Invoice* allows payments to be applied directly to open items on the account. If this option is not selected, the open items will not be tracked separately.

**Handheld Options:**

**Suppress Balance:** Select this option to suppress the customer’s balance from printing on the handheld receipt.

**Signature Required:** Select this option to require the customer’s signature with each delivery.

**Remittance Stub:** Select this option to print a payment remittance stub with the customer’s handheld receipt.

**Group Area Code:** This option allows you to separate customers by groups within the *Off-Route List* of the handheld. The codes can be set up under *Lists > Handheld > Group Area Codes*.

**Invoice Copies:** Enter the number of handheld invoice copies to print with each delivery.

**RV2000 Options (Optional Module):**

**Don’t Call:** Select this option to prevent the customer from being called during *Route Pre-Sale* and *RV2000* pre-calls.

**Start Time:** This field indicates the default starting time to call this customer.

**End Time:** This field indicates the default ending time to call this customer.

**Language (in development):** Select the default language the *RV2000* program should use when calling this customer.
**Default Products Tab**

Establish *Default Products* that will be assigned to each customer’s account automatically.

**Fields:**

*Default Products*: Add all of the *Default Products* required for this *Customer Type* at the desired price and quantity.

*Bottle Deposit 1&2*: Select each container deposit code that will be used with this *Customer Type*.

*Recurring Charges*: Select this option to add a recurring charge to the customer’s account — this type of charge is generally used to bill fuel surcharges or processing fees.
ZIP Codes

The ZIP Codes option contains all of the ZIP codes assigned to your customers. If an account needs to be created with a ZIP code that does not exist in the database, it will need to be added in this screen prior to entering the account in the New Customer Wizard.

**Fields:**

**ZIP Code:** Enter up to nine characters for each ZIP code.

**NOTE:** To accommodate multiple markets, the ZIP code length can be adjusted under File > Company Setup > Defaults tab.

**City:** Enter the name of the city associated with this ZIP code.

**State:** Enter the abbreviated name of the state associated with this ZIP code.

**Last Updated (Display Only):** The date this entry was modified.

**Note:** An optional extended description can be entered here.
Telephone Reasons

The Telephone Reasons screen allows you to enter up to 24 custom messages to be used on the Telephone Message screen.

Fields:

**Reason ID:** Enter up to two characters that will represent the Telephone Order Reason.

**Reason:** Enter a description for the Telephone Order Reason.

**Mini Description:** Enter up to two characters to use as an abbreviation for the reason on certain reports.

**Equipment Movement Reason:** If the request involves equipment movement, check this box and select one of the following options:

- **Pickup:** Select this option if the equipment is being picked up.
- **Exchange:** Select this option if the equipment is being exchanged.
- **New Set:** Select this option if the equipment is being installed.

**Warn for Contract Violation:** Check this box to notify the user that the customer has breached a contract.
Organizing What You Sell

The *Product Codes* menu contains the product related items that need to be established prior to creating transactions in RM2000.

<table>
<thead>
<tr>
<th>Product Charge Codes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Class Codes</td>
</tr>
<tr>
<td>Product Price Lists</td>
</tr>
<tr>
<td>Gratis Reasons</td>
</tr>
</tbody>
</table>

Each item is explained in detail below.

**Product Charge Codes**

*Product Charge Codes* represent all of the products that you sell to your customers, with additional items created for additional functions in the program.

**Description Tab**

The *Description* tab contains the descriptions and various rules established for each item.
**Fields:**

**Charge Code:** Enter up to five characters that will represent the Product Charge Code.

**NOTE:** It is best to group types of products together numerically if possible. For example, product codes ‘001-099’ may be all of your water products.

**HINT:** by using the same number of characters for each Charge Code, it will make it easier to scroll through the items on the handheld.

**HH Description:** Enter a description for the item that will be used on the handheld.

**Statement Description:** Enter a description for the item that will be used on desktop statements.

**Mini-Description:** Enter an abbreviated description up to three characters that will be used on reports that cannot display the complete description of the item.

**Number of ( ):** Enter a number that will be used on the Business Pulse and other reports to show the number of units sold per month. The description can be changed (from Gallons) under File > Company Setup, on the Defaults tab.

**Internet Product (Requires EC2000 Module):** If this option is checked, customers may order this product from your Web site.

**NOTE:** For more information regarding the EC2000 Module, contact Advantage Route Systems or your reseller.

**Update Account Deposit:** Select this option to update the Deposit field within Customer Information > $ (Finance) tab with the total amount billed to the customer using this item.

**NOTE:** This option is generally used for miscellaneous account deposits, such as equipment. This does not apply to container tracking.

**Allow for Gratis:** Select this option to allow a Gratis Reason to be entered for the item if necessary (allows price change to 0.00 on the handheld).

**Coupon Product:** Select this option if the item is used with coupon processing.

**Inactive Product:** Select this option to inactivate the product and remove it from product entry screens.

**Require Manufacturing Control #:** Select this option to require a Manufacturing Control Number when this item is added to a delivery vehicle during the Morning Load process.
**Pricing Tab**

The *Pricing* tab determines the prices that will be charged to each customer. There are ten price levels that can be assigned to each product.

**NOTE:** This pricing method is only one of the many pricing options available in RM2000. For further information on pricing methods, please refer to the *Supplemental Guide*.

### Fields:

**Price/Cost/Default-Level 9:** Enter up to ten levels of prices and costs on each item.

**Tax Code:**

The category labels displayed determine how items are taxed in RM2000, and are established under *File > Company Setup*, on the *Taxes* tab. Select the appropriate tax category for the item:

**NOTE:** For a complete tutorial on the sales tax setup process, refer to the *Getting Started Guide*.

**Redemption Value:** In select states, a ‘redemption value’ may be placed on items as they are sold. Choose the redemption code that should be associated with this item.
**Handheld Tab**

The Handheld tab defines how a product is used on the handheld.

**Fields:**

**Handheld Product:** Select this option if the item will be used on the handheld.

**NOTE:** This option should be selected for certain non-inventory options as well, such as Skip Reasons and Rental Codes.

**Always show on Exception Report:** Check this box to always include sales of this product on the Exceptions report during the card upload process.

**Never print on Exception Report:** Check this box for sales and activity involving this product to be excluded from the Exceptions report during the card upload process.

**Truck Sequence Code:** The truck sequence code is used to change the order that products are listed on the handheld. If you would like a certain product to show up before others, this gives you the ability to sequence them differently — each code should be three digits in length.
**Accounting Tab**

The *Accounting* tab defines the product classification of each item.

**Product Charge Codes**

<table>
<thead>
<tr>
<th>Description</th>
<th>Pricing</th>
<th>Handling</th>
<th>Accounting</th>
<th>History</th>
<th>Class</th>
<th>Class</th>
<th>Class</th>
<th>Class</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Class</td>
<td>D</td>
<td>OAL WIDEPOSIT</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Fields:**

**Product Class:** Select a *Product Class Code* from the drop-down list. The class assigned to each item is used for tracking and reporting purposes.

**NOTE:** The assigned *Product Class Code* is fundamental to the operation of RM2000 and each class is designed to perform a specific function in the program. Refer to the *Getting Started Guide* for further information on this topic.

**Commission Class:** Select a *Commission Class Code* if commissions will be calculated on the item.

**Type 1&2 (Displayed on Class 7 items only):** Select the container tracking type used for the current item. Refer to the *Supplemental Guide* for further information on this topic.

**General Ledger:**

**Sales:** The total sales generated from this product charge code.

**Profit:** The profit generated from this product charge code.

**G/L Acct No:** Select the primary *G/L Number* that you would like to use for general accounting values for the item.

**Un-posted Amount:** This un-posted general ledger amount is automatically updated when posting new transactions. The value reverts to 0.00 when you do general ledger postings on the *Transactions* menu.

**Last G/L Date:** The date the last general ledger postings function was done. This date is updated automatically.
Inventory:

Quantity Sold: The number of units sold.

Quantity In: The number of units received.

Quantity On Hand: The number of units currently on hand.

Reorder Level: Indicates the minimum quantity cap before the item should be ordered.

Last Sold Date: The last date the item was sold.

Last In Date: The last date the item was received in inventory. This is automatically updated each time stock is received using the Receive Inventory screen found under the Transactions menu.

NOTE: To keep these quantities accurate, refer to the Receive Inventory section of the User Guide.
**History Tab**

The *History* tab displays the 24 most recent *Accounting Periods* of activity for this product.

**Fields:**

*Sales:* The sales total for this product during the *Accounting Period.*

*Cost:* The total cost for this product during the *Accounting Period.*

*Qty:* The quantity sold for this product during the *Accounting Period.*

**NOTE:** These totals are for reference only. Refer to the *Sales Detail Report* under Reports > *Accounting Reports* > *Sales* for detailed product sold information.
Product Class Codes

Product Class Codes are used to separate products for sales and data related purposes. Certain Product Classes are used internally by RM2000 to perform assigned functions in the program. Options such as charging rentals, deposits, or skipping a customer’s delivery are all controlled by the assigned Product Class.

The following Product Classes are used internally by RM2000 and should be assigned to the appropriate items:

- **0** – Item with deposit: Assign this class to all items that will be associated with Class 7, Type 1 items.
- **1** – Item with deposit: Assign this class to all items that will be associated with Class 7, Type 2 items.
- **4** – Equipment Rental: Assign this class to all rental codes assigned to equipment.
- **5** – Redemption Value: Assign this class to all redemption codes being used.
- **7** – Deposit Code: Assign this class to all container deposit codes.
- **9** – Skip Reasons: Assign this class to all Skip Reasons established in the product list.

**NOTE:** If the Product Classes above do not exist in RM2000, they will need to be added to the program.

**NOTE:** Refer to the Supplemental Guide for a complete tutorial on setting up container deposits.
Fields:

Class: Enter a single character that will represent the Product Class Code.

Description: Enter a description for the Product Class Code.

NOTE: In addition to the required Product Class Codes needed in RM2000, you can create your own classes using the letters of the alphabet (A thru Z) and the numbers 2, 3, 6, and 8.
**Product Price Lists**

The *Product Price Lists* option provides a convenient way of assigning a group of products to your customers at the prices and quantities entered within each list.

**Fields:**

*Price List:* Enter up to three digits that will represent the *Product Price List*.

*Description:* Enter a description for the *Product Price List*.

**Adding Products:**

Choose the *Add* button to add products to the *Price List*. Select a product, and enter the desired price and quantity.

**Fields:**

*Product Code:* Select the desired *Product Charge Code*.

*Description:* The description of the selected *Product Charge Code*.

*Product Code:* Select the product code to be added to the *Price List*. 
**Price:** The default price of the *Product Charge Code*. This price can be updated if necessary.

**Quantity:** The default quantity for the *Product Charge Code*. The quantity field can be updated if necessary.

### Package Plan (Optional Module)

This option is part of the *Package Plan Module*, which allows you to offer a flat-rate billing program to your customers. For example, a plan can be created that offers your customers 5 bottles of water and a rental for 35.00 dollars a month. This flat rate will be billed monthly.

**NOTE:** For further information on this module, please contact Advantage Route Systems.

### Gratis Reasons

*Gratis Reasons* can be logged on invoices for items given to the customer at no charge (e.g., Damaged Product, Promotion). This information is permanently stored per item and can be reviewed within the *Gratis Sales by Route Report*.

![Gratis Reasons](image)

**Fields:**

**ID:** Enter a single character that will represent the *Gratis Reason*.

**Description:** Enter a description for the *Gratis Reason*.

**Short Description:** Enter up to two characters that will represent the *Gratis Reason* on certain reports that cannot display the complete description.
Accounting Setup


Sales Tax Rates

Most states require you to collect sales tax from your customers on certain products. RM2000 allows you to control which products are to be charged sales tax, and the rates that apply.

Setting up sales tax in RM2000 involves two steps:

1. Creating component rates as Tax Authorities.
2. Creating Tax Codes by assigning one or more Tax Authorities.

NOTE: For a complete tutorial on setting up Sales Tax Codes in RM2000, refer to the Getting Started Guide.

Sales Tax Codes

Sales Tax Codes combine individual Tax Authorities to create the total tax rate that will be billed.

Fields:

Tax Code: Enter a two-character code that will represent the Sales Tax Code.
Description: Enter a description for the Sales Tax Code.
**Authorities:** Select up to four tax authorities that will create the total rate charged for sales tax.

**Total Tax Rates (Read Only):** Displays the combined rate of the selected authorities by product type.

**G/L No:** Select the general ledger number that the sales tax code should be assigned to (i.e., a liability account, such as *Sales Tax Payable*).

**Authorities Tab**

Tax *Authorities* represent the individual entities that create the total tax rate (i.e., State, County, Local) in your area. The following screen allows each tax authority and rate to be entered individually.

**Tax Authority:**

**Authority ID:** Enter up to two characters that will represent the *Tax Authority*.

**Authority Description:** Enter a description for the *Tax Authority*.

**Tax Rates:**

Enter the tax rate for the individual authority within each tax category displayed.

---

**NOTE:** Each category displayed can be modified under *File > Company Setup*, on the *Taxes* tab. Additionally, each category is listed within the *Product Charge Codes* screen. For further detail on this information, refer to the *Getting Started Guide*. 

---
General Ledger Setup

RM2000 will be used for customer related Accounts Receivable tracking in your business. Add all of the general ledger accounts that apply.

NOTE: The accounts added should fall under one of five general ledger types available: Cash, Accounts Receivable, Liability, Revenue, and Expense.

Fields:

G/L Number: Enter up to twelve characters that will represent the General Ledger Code.

G/L Description: Enter a description for the General Ledger Code.

G/L Date: The date the record was last modified, for reference.

G/L Acct Type: Select the type of account that applies to the current entry:

- Cash: Add one account that will be used for payments received in RM2000.
- Accounts Receivable: Add one account that will control all sales in RM2000.
- Liability: Add multiple accounts for any long or short-term liabilities (e.g., Sales Tax Payable, Container Deposits).
- Revenue: Add multiple accounts for product sales (e.g., Water Sales, Coffee Sales, Equipment Rent).
- Expense: Add multiple accounts for expenses (e.g., Write-Offs, Refunds).

NOTE: You only need one Cash and Accounts Receivable account in RM2000. These should be stand-alone accounts, meaning, they should not have any product codes assigned to them. You can have as many of the remaining account types as needed (Revenue, Liability, Expense).
Current Unposted: Currently not in use.

January-December (Read Only): Displays posted totals per account for each General Ledger Period.

Used by (Read Only): Displays the Product Charge Codes assigned to each account.

Credit Card Groups Setup

Credit Card Groups allow you to bill customers in separate batches throughout the month when using the EC2000 Module.

NOTE: The EC2000 Module allows you to process credit card transactions within RM2000, contact Advantage Route Systems for further information.

Group ID: Enter a single character that will represent the Credit Card Group.

Description: Enter a description for the Credit Card Group.
Organizing and Tracking Equipment

Equipment tracking in RM2000 allows you to keep track of equipment rented, loaned, and sold to customers. Each piece of equipment will also have a complete history of service performed, previous locations, and other valuable information.

Equipment

The RM2000 program has been designed to keep track of equipment, provide maintenance records, and much more. This list contains four sub-categories, described in detail below.

### Equipment Master List

The Equipment Master List screen contains multiple tabs to keep track of important equipment information.

#### Information Tab

The Information tab contains basic information about each piece of equipment.
**Equipment Info:**

**Equip. ID (Read Only):** Displays the equipment identification code.

**Unit Type:** Displays the *Equipment Type Code* selected for this piece of equipment.

**Unit Style:** Displays the *Equipment Style Code* selected for this piece of equipment.

**NOTE:** *Equipment Type and Style Codes* can be added to RM2000 under *Lists > Equipment*.

**Last Change:** Each time a record is updated, the ‘change’ date is automatically updated.

**Location:** Displays additional text regarding the specific location of the piece of equipment.

**Capacity:** If this piece of equipment is a rack, cage, or similar, enter the number of items this storage container can hold.

**Comment 1 and Comment 2:** Enter optional comments that can be added to each piece of equipment for reference.

**Purchased / Sales Info:**

**Purchased From:** Enter the vendor the equipment was purchased from, for reference.

**Date Purchased:** Enter the date the unit was acquired from the vendor.

**Purchase Cost:** Enter the purchase price from the vendor.

**Warranty Exp:** Enter the date the warranty expires with the vendor.

**Financed:** Select this option if the equipment is financed with the vendor.

**Sold Price:** Enter the purchased price if the unit has been sold to a customer.

**Sold Date:** Enter the date the unit was purchased by a customer.

**Sold As:** Check the appropriate box to indicate whether the unit was new or used at the time of the sale, for tax reference purposes.

**Owned By Customer:** Select this option if the customer owns their own equipment. This option can be used to offer equipment servicing on customer owned equipment.
**Equipment Service Calendar:** This button allows equipment service scheduling to be established.

To schedule equipment service, simply click on the appropriate day on the calendar and you will be prompted to enter an *Equipment Service Code*.

**NOTE:** *Equipment Service Codes* can be added to RM2000 under *Lists > Equipment > Service Codes*. Refer to the *Supplemental Guide* for further information.

On the calendar, regular delivery days for the customer will be displayed in green, while scheduled service days are displayed in red.

**Billing Info:**

**Statement Billed:** Select this option to bill rent for this piece of equipment on the desktop. Alternatively, leave the option unchecked to bill rent on the handheld.

**NOTE:** For more information on generating rent, refer to the *Supplemental Guide*.

**Charge Code:** Displays the rental code assigned to this piece of equipment.
**Period Code:** Displays the default rent billing frequency. There are multiple options available, refer to the chart below:

<table>
<thead>
<tr>
<th>Freq:</th>
<th>Due in:</th>
<th>Code:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Annually</td>
<td>January</td>
<td>A</td>
</tr>
<tr>
<td></td>
<td>February</td>
<td>B</td>
</tr>
<tr>
<td></td>
<td>March</td>
<td>C</td>
</tr>
<tr>
<td></td>
<td>April</td>
<td>D</td>
</tr>
<tr>
<td></td>
<td>May</td>
<td>E</td>
</tr>
<tr>
<td></td>
<td>June</td>
<td>F</td>
</tr>
<tr>
<td></td>
<td>July</td>
<td>G</td>
</tr>
<tr>
<td></td>
<td>August</td>
<td>H</td>
</tr>
<tr>
<td></td>
<td>September</td>
<td>I</td>
</tr>
<tr>
<td></td>
<td>October</td>
<td>J</td>
</tr>
<tr>
<td></td>
<td>November</td>
<td>K</td>
</tr>
<tr>
<td></td>
<td>December</td>
<td>L</td>
</tr>
<tr>
<td>Monthly</td>
<td>Monthly</td>
<td>M</td>
</tr>
<tr>
<td></td>
<td>Odd Months</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>Even Months</td>
<td>P</td>
</tr>
<tr>
<td>Quarterly</td>
<td>1st month of Quarter</td>
<td>Q</td>
</tr>
<tr>
<td></td>
<td>2nd month of Quarter</td>
<td>R</td>
</tr>
<tr>
<td></td>
<td>3rd month of Quarter</td>
<td>S</td>
</tr>
<tr>
<td>Semi-Annually</td>
<td>Jan. / July</td>
<td>T</td>
</tr>
<tr>
<td></td>
<td>Feb. / August</td>
<td>U</td>
</tr>
<tr>
<td></td>
<td>Mar. / September</td>
<td>V</td>
</tr>
<tr>
<td></td>
<td>Apr. / October</td>
<td>W</td>
</tr>
<tr>
<td></td>
<td>May / November</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>June / December</td>
<td>Y</td>
</tr>
<tr>
<td>Misc.</td>
<td>No Rent</td>
<td>Z</td>
</tr>
<tr>
<td></td>
<td>Rent Schedule</td>
<td>1 &amp; 2</td>
</tr>
</tbody>
</table>
Period Rate: Displays the rental rate assigned to this piece of equipment.

Last Rent Billed: Displays the last date that rent was billed for this piece of equipment.

Start Rent On: Displays the start rent date for this piece of equipment. This can be helpful for delaying a rental charge for a period of time.

Year Rent: Displays the total amount in rent billed for the year.

Year Repair: Displays the total amount billed in repairs for the year.

Total Rent: Displays the total amount billed in rent for the life of the unit.

Total Repair: Displays the total amount billed in repairs for the life of the unit.

Rent Pending: This date is used internally by the system to prevent double-billing customer rentals and should not be modified.
**Customer History Tab**

The *Customer History* tab contains historical data on previous installation locations.

**NOTE:** Data cannot be changed on this screen. The information is automatically updated when equipment is placed in a new location.

**Fields:**

- **Acct Number:** Displays the account number where the piece of equipment is currently assigned.
- **Account Name:** Displays the name on the account where the piece of equipment is currently assigned.
- **Date Installed:** Displays the installation date of the equipment currently assigned to the account.
- **Gross Rents:** Displays the total rental amount billed on the account for the piece of equipment.
- **Date Out:** Displays the date the piece of equipment was removed from the account.
**Location Tab**

The Location tab displays the current location of the selected piece of equipment.

NOTE: Data cannot be changed on this screen. The information is automatically updated when equipment is placed or removed on each account directly, or while using the Equipment Movement option. Refer to the Supplemental Guide for further information.

**Fields:**

Each ‘radio’ button listed represents the current location of the piece of equipment. The options are:

- **Warehouse:** Currently assigned to the warehouse, ready to be installed.
- **On Truck:** Currently out for delivery or left on a delivery vehicle.
- **Installed:** Currently assigned to a customer’s account.
- **Picked Up:** Currently picked up from a customer, and pending location update.
- **Received:** Currently received in a staging area.
- **Service:** Currently out for equipment service.

**Date:** The date the equipment entered the location.

**Time:** The time the equipment entered the location.

**By:** The initials of the employee that transferred the equipment to the indicated location.

**Name:** The name of the employee that transferred the equipment to the indicated location.
Service History Tab
This tab displays the complete service history for this piece of equipment.

NOTE: Data cannot be changed on this screen. The information is automatically updated when an entry is made on the handheld, or from within the Equipment Service option on the desktop. Refer to the Supplemental Guide for further information.

Fields:

**Code:** The Equipment Service Code used.

**Service Description:** The Equipment Service Code description.

**Date:** The date the equipment service was performed.

**Time:** The time of day the equipment service was performed.

**By:** The employee that performed the equipment service.
Equipment Type

*Equipment Type Codes* represent the various types of equipment available to your customers.

**Fields:**

*Equipment Type*: Enter up to three characters that will represent the Equipment Type Code.

*Description*: Enter a description for the *Equipment Type Code*. 
Equipment Style

*Equipment Style Codes* represent the various styles of equipment available to your customers.

**Fields:**

*Equipment Style:* Enter up to three characters that will represent the *Equipment Style Code.*

*Description:* Enter a description for the *Equipment Style Code.*
Service Codes

An *Equipment Service Code* should be created for each reason that equipment service will be scheduled and performed.

### Fields:

- **Service Code**: Enter up to three characters that will represent the *Equipment Service Code*.
- **Description**: Enter a description for the *Equipment Service Code*.
- **Service Hours**: Enter the number of hours required to perform the indicated service.
- **Service Parts $**: Enter the cost of all parts necessary to perform the service.
Configuring Handheld Options

Use the following items to configure a majority of the handheld options available in RM2000.

Handheld Options

The following tabs will allow you to enter handheld information into RM2000:

<table>
<thead>
<tr>
<th>Handheld Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hardware</td>
</tr>
<tr>
<td>General</td>
</tr>
<tr>
<td>Handheld</td>
</tr>
<tr>
<td>Labels</td>
</tr>
<tr>
<td>Messages</td>
</tr>
<tr>
<td>Receipt</td>
</tr>
<tr>
<td>Upload Reports</td>
</tr>
</tbody>
</table>

**Hardware Tab**

The *Hardware* tab contains set up information related to the handheld.

**Communications Options:**

*Cable:* Select this item if you use a serial cable for communications between the handheld and the desktop.
**Modem:** Select this option if the handheld connects to the desktop via dial-up modem.

**Network:** Select here if the handheld communicates with the desktop through a network connection.

**NOTE:** The Modem and Network options require the Advanced Communications Module. Please contact Advantage Route Systems or your reseller for further information.

**Card:** Select this option if a card reader is being used for transferring data between the handheld and the desktop.

**Baud Rate:** Select the baud rate of your dial-up modem.

**WiFi/Bluetooth (Requires Network option above):** Select the connection method being used to connect to the network.

**Data Transfer:**

**Compress data for transfer:** Choose this option to compress data prior to transfer (ideal for slow transfer speeds).

**Don’t use WiFi Power Saver:** Select this option to prevent RM2000 from disabling WiFi on the handheld when NOT transferring data.

**Miscellaneous Options:**

**Dial Back Number:** Enter the primary phone number that should be used when attempting a dial-up modem transfer.

**NOTE:** The remote phone line must be dedicated and cannot be shared with a fax machine or any auto-answer device.

**Alternate Number:** You may enter an alternate phone number to select when attempting a dial-up modem transfer.

**Transfer Security Code:** In order to eliminate the chance of another user calling into your system and downloading data, you may choose a number from 1 to 9999, to be verified whenever a data transfer is to take place.

**Network Options:**

**Network Path:** Enter the remote directory that will be used for handheld data transfers. For example: `X:\RM2000\HANDHELD\DATA\ROUTES`

**Network Login:** Enter the network username that will be used for wireless handheld data transfers.

**Network Password:** Enter the network password that will be used for wireless handheld data transfers.

**FTP Port Number (Port 21 used if blank):** The port number used by the remote server.
**Time Server:** Enter the I.P. address or server name of your time synchronization server. Leave this blank if you are not using this feature.

**Port Num (37):** Enter the port number used by the time synchronization server. Port 37 will be used if this is left blank.

**General Tab**

This tab contains options about general filters that are used on the handheld.

**Miscellaneous Options:**

**Enable Notes Function on Handheld:** Select this option to allow route drivers to enter notes from within the handheld program. Each note will be logged and uploaded to the desktop.

**Only Add Default Products for On-Route Customer:** By selecting this option, the system will only display Default Products on accounts that are scheduled on route.

**Exclude Suspended Accounts on Pre-Route Report:** Select this option to exclude all suspended customers from the Pre-Route Report.

**Exclude Suspended Accounts on Handheld:** Select this option to exclude all suspended accounts from the handheld.

**Disable Card Eject Protection on Handheld:** Select this option to disable the ‘safely remove card’ message that is temporarily displayed when exiting RM2000 on the handheld.

**Hide Account Balances on Handheld:** Select this option to suppress all account balances from being displayed on the handheld.
Retrieve GPS Log (Requires RT2000 Module): Select this option to retrieve GPS information during the Afternoon Card process.

NOTE: The Route Track 2000 Module is used to log detailed GPS coordinates on the driver’s route card throughout the day for tracking stop times, locations, duration, and more. Contact Advantage Route Systems for further information.

Off-Route Customers:

Filter Type: Choose one of the following Off-Route Filter Types to apply on the handheld:
1. Include all customers on the off-route list.
2. Include only customers on route being processed.
3. Include only today’s customers in the off-route list.
4. Only include customers in group areas assigned to route.

Information for Off-Route Customers:
Select each item that you would like to include with your accounts serviced ‘Off-Route’ on the handheld:
- Alert Messages
- Statement Messages
- Invoice Messages
- Driver/Site Instructions
- PO Numbers
- Invoice History

Special Accounts:

New Customer: Select an account number that will be used to temporarily store new customer data captured on the handheld.

Cash Sale: Select an account number that will be used for cash sales on the handheld (i.e., used for walk-ups or off-the-truck sales).

Geo-Coding:

Show GPS location button: Select this option to enable the ‘Capture GEO-Coding’ button on the Confirm Sale screen of the handheld. This allows you to capture the customer’s Latitude/Longitude Coordinates for mapping purposes (requires an active GPS connection).

NOTE: This information will be uploaded and stored on the customer’s Route tab within Customer Information.

Allow for mileage entry on each stop: Select this option to require each driver to input a current mileage entry per stop.
**GPS Navigation Software:** Select the navigation program you are using from the drop-down menu.

**Sequencing:**

**Ignore Driver Resequencing On Handheld Upload:** Choose this option if re-sequencing customers should only be handled on the desktop.

**Reorder Stops On Upload:** Select this option to automatically assign new sequence numbers to your accounts during the Afternoon Card process (i.e., sequences 0001, 0002, and 0003 are renumbered 0010, 0020, and 0030).

**Use Follow-me tracking for Resequencing:** This option re-sequences customers based on the order that your route driver delivered during the route day — this will not include any off-route deliveries.

**Handheld Tab**

The Handheld tab includes truck options and sales rules.

![Handheld Options](image)

**Truck Options/Rules:**

**Load Verification Required:** Select this option if each driver will need to verify product loads placed on the trucks prior to delivery.

**Lock Morning Load After Verify:** Choose this option to disable the ability to edit the Morning Load screen after it has been verified.

**Exclude Equipment on Variance Report:** Checking this option will suppress all equipment from the handheld Variance Report.

**Leave Clean Equipment on Truck:** Select this option to leave undelivered equipment within the truck’s inventory from day-to-day.
Show Large Bay at Rear of Truck: Select this option to enable a loading bay at the rear of your truck on the Bay screen within the handheld program — this is only used when there are an odd number of bays on the truck.

Enter Load Using Product List: During the check-out process, each driver can enter products by choosing them from a list, or by entering the Product Code ID manually. Selecting this option defaults to the ‘list mode’ entry; however, drivers will still have the ability to toggle between each mode on the handheld at any time.

Verify Equipment ID’s on Handheld: Select this option to prevent each driver from keying in equipment that does not currently exist in RM2000.

Default Number of Bays to: Enter the number of bays on your route trucks. If you have both eight-bay and ten-bay trucks, then set the value to the largest number of bays in your fleet.

Copies of Day End Cash Reports: Enter the default number of Day End Cash Report copies to print from the handheld each day.

Copies of Load Verification Reports: Enter the default number of Load Verification Reports to print from the handheld each day.

Missed Stop Action: If any stops are left un-serviced on the handheld, you can select which of the following actions are to be taken.

- Nothing: No action will be taken on the missed stops and a report will be generated showing which stops were not serviced.
- Drag: Missed stops will be rescheduled for the next available delivery day. A report will be generated showing which stops were rescheduled.
- Force Service: The driver will not be able to print the Driver Closeout Reports from the handheld until all stops have been serviced.

NOTE: On Force Service, the driver may select the ‘Skip Remaining Stops’ option from within the Afternoon screen on the handheld.

Use Asset Scanning: Select this option to scan bins onsite using the handheld (used in the Paper Shredding industry).
**Use Perpetual Inventory:** Choose this option to enable the *Perpetual Inventory* module.

**NOTE:** The *Perpetual Inventory* feature allows you to carry product inventory totals on your truck from one day to the next — this is especially helpful for companies running coffee service or snack routes. Refer to the *Supplemental Guide* for further information.

**Sales History:**

**Days of History on Handheld:** Enter the number of history days you would like the drivers to view on the handheld.

**Include This Month Last Year:** Select this option to include the same month of the previous year within the history screen of the handheld (recommended for seasonal accounts).

**Sales Options/Rules:**

**Allow Price Overrides:** Select this option to allow price changes on the handheld.

**Default Payment Type to ROA:** Select this option to establish the *ROA* (*Received on Account*) payment type as the default choice within the payment screen on the handheld.

**NOTE:** The driver can easily toggle between *ROA* and *COD* (*Cash on Delivery*) on the handheld, regardless of selection here.

**Allow Rent Charges to be Removed:** Select this option to allow the driver to remove any rent charges that may appear on the handheld.

**Allow Refunds on Payment Screen:** Select this option to allow your drivers to enter negative amounts from within the payment screen.

**Reverse Names on Handheld:** Select this option to reverse the order of each customer name on the handheld — this option will only work if semicolons (;) separate each name.

**Require Past Due Authorization:** Select this option to require a *Past Due Authorization Code* if a driver attempts to service an account that is past due.

**Require Authorization for COD Customers:** Select this option to require a *COD Authorization Code* if a driver attempts to service an account that is assigned to a *COD Credit Class*. 
Require Authorization for Over Credit Limit Customers: Select this option to require an authorization code if a driver attempts to service an account that has exceeded an established Credit Limit.

NOTE: Daily authorization codes can be printed and distributed on each route using Reports > Route Reports > Past Due Authorization Codes. Additionally, individual authorization codes can be retrieved per customer under Lists > Customer Information, and select the Release Code button on the Credit tab — this method can be used if you would prefer the driver to call the office for the authorization code.

Show Equipment Rental on Day end Report: Select this option to include the total rental amount billed to customers on the Day End Cash Report.

Invoice Date Defaults to Route Date: Select this option to force the invoice date to match the route date being processed. This is helpful because the handheld may have the wrong date established internally.

Show Detail for Today’s Invoice on Statement: Select this option to include the current invoice’s details on the statement when printing a handheld statement.

Do not print Credit Message on Invoice: Check this option if you do not want to print a credit memo on the customers invoice if the customer has a negative balance.

Always Require Signature on Delivery: Select this option to require a signature on each invoice created on the handheld.

Block Customer Balances on Handheld: Check this option if you do not want to show customer balances on the handheld.

Force Input of Bottles Returned: Select this option to force the driver to input a ‘returned’ quantity on each invoice.

NOTE: The driver will be forced to select the Returns “spinner” or input screen before saving the invoice.

Do Not Display Bottle(s) on Hand: Choose this option to remove the Bottles on Hand (containers) display from the invoice screen.

Force Signature if Customer Signature Required: Select this option to force a signature if the ‘Signature Required’ option is selected within the customer’s account.

Use Alphanumeric Keypad to Enter Products: Choose this option if you are using alphanumeric product codes and would like to enter them using the keypad.

Use Classic Resequencing Method: Choose this option to use a cut-and-paste method of re-sequencing stops on the handheld.

Don’t Use Color on Customer Totals: Choose this option to disable the color display on the handheld screen for balance totals.
**Labels Tab**

This tab contains options about general labels that are used within RM2000.

**Standard Charge Codes:**

- **Default Product:** Enter a Product Charge Code that will be assigned to all accounts on the handheld. This should be a product that most customers purchase.

  **NOTE:** If this field is empty, the system will use the first valid (non Skip Reason) product in the Product Charge Code file.

- **Deposit Code 1 & 2:** Enter a deposit Product Charge Code in each field that applies.

  **NOTE:** Refer to the Supplemental Guide for further information on deposit setup and tracking.

- **Label:** Enter a description for each deposit field being used (i.e., 5 Gal. Returned, 3 Gal. Empties).
**Labels:**

**Tax Categories:** This description is used on the handheld when entering a new customer. This label is displayed above the tax rates.

**History Page:** Historical data can be accessed and printed from the handheld on each account, enter a description for this option (e.g., Customer History, Statement of Account).

**Product on Hand:** Enter a description for products or containers on hand (e.g., Bottles on Hand, Crates, or Pallets).

**Redemption Label:** Enter a standard label that will relate to the redemption value of a container (i.e., in California, it is C.R.V.).

**Invoice Label:** This is the word printed at the top of the receipt (e.g., Delivery Note, Invoice).

**Messages Tab**

The Messages tab contains header and footer information that will print on each customer’s receipt.

**NOTE:** For further information on setting up and formatting your receipt, refer to the Handheld User Guide.

---

**Tabs:**

**Header Tab:** The text in this field prints before the main body of the receipt.

**Footer Tab:** The text in this field prints after the main body of the receipt.

**Options Tab:** This tab is reserved for future enhancements.
60, 90, 120 Days: Past due messages can be entered here and manually printed from the handheld by the route driver — these messages are not connected to the customer’s Credit Class.

Post Receipt (Paper Shredding Only): The text in this field will print on a Certificate Of Destruction for the customer.

Include Post Receipt Document (select Post Receipt): Choose this option to include a Post Receipt message with the invoice.

Require a signature with Document (select Post Receipt): Choose this option if you require the delivery driver to enter a signature on the certificate of destruction.

Fields:

Justify: Enter an L (left), R (right), or C (centered) that corresponds to how you would like the text to be aligned on the printed receipt.

Font: Enter a letter corresponding to the font size you would like to use on the printed receipt.

NOTE: Refer to Appendix B of the Handheld User Guide for examples.

Message: Enter the information that you would like to print on each line.
**Receipt Tab**

The *Receipt* tab contains formatting options for the printed receipt.

**Receipt Options:**

- **Print Last Payment on Invoice:** Check this box if you would like the last payment date and amount to print on the receipt.
- **Print Bottles on Hand on Invoice:** Select this option to include the containers on hand total on the customer’s printed receipt.

**NOTE:** This information is stored within the *Deposits* section of the customer’s account, on the *Products* tab.

- **Block Account Balance on Invoice:** Select this option to suppress the customer’s balance from printing on the invoice.
- **Always Print Deposit Exchange on Invoice:** Select this option to include the current delivery’s container exchange on the printed receipt.
- **Include Remittance Stub with Invoice:** Select this option to include a payment remittance stub with each printed invoice.
- **Block Printing of Next Delivery Date on Invoice:** Select this option to suppress the customer’s next delivery date from printing on the invoice.
- **Print Product Charge Codes on Invoice:** Select this option to include product code ID’s on each printed invoice.
- **Paper Saver Receipt:** Select this option to print a condensed receipt for the customer (disables bold text and minimizes text spacing).
- **Pause Printing Between Invoice and Payment Coupon:** Check this option to pause printing between an invoice printout and a remittance stub.
**Pause Printing Between Invoice and Statement:** Check this box if you want the printer to pause between printing the invoice and statement.

**Allow Printing of Statement without Printing Invoice:** Check this option to print a handheld statement without printing an invoice for the customer.

**Print Barcode on Payment Slip:** This option enables a barcode used for scanning payments into the system from remittance slips (handheld scanner required).

**Use Standard Font for Account Balance:** Select this option to print the customer’s balance on the receipt using the same font as all of the other totals included (suppresses bold type font).

**Print PAR Value on Receipt:** Choose this option to print PAR values on receipts when using the *Par Module.*
Upload Reports

The Upload Reports tab contains a list of all the report options available when uploaded route data during the Afternoon Card process.

NOTE: Specify the number of copies of each report desired. If ‘0’ is entered, the report will not print.

Upload Reports:

Transaction Detail: This report includes a detailed list of all transactions that occurred while out on route.

NOTE: Entering a quantity of ‘9’ will print a Transaction Detail Report Summary, suppressing all of the detailed information.

Blank Lines on Transaction Detail: This option represents the number of blank lines to include between transactions, giving you additional space to write in notes or changes.

Exceptions: This report includes price changes, skipped stops, sales to past due accounts, and much more.

NOTE: Select the boxes to the right of this report to choose the detailed options you would like to include daily.

Resequenced Stops: This report includes stops that were re-sequenced by the driver.

Driver Commissions: This report includes commission totals accumulated for the current route day.

Payment Summary: This report includes a summary of all payments collected on route.
**Inventory Sold:** This report includes inventory totals for the route day.

**Driver Notes:** This report includes all notes entered on the current route by the driver.

**Equipment Transfer:** This report includes all equipment movement for the route day (i.e., picked up, dropped off, and equipment left on the truck).

**Variance Report:** This report includes morning Driver/Checker product load details.

**Material Pickup:** This report provides detail for contents picked up at each location. Generally used in the Paper Shredding industry.

**Report Sort Order:** Choose a sorting order from the drop-down list to be used on transaction reports.
- Invoice No.
- Account No.
- Name
- Time
- Sequence No.

**Exception Report Options:**

**Show Refunds:** Includes any refunds given on the handheld.

**Show Hold Service Customers:** Includes customers serviced that are on ‘Hold’.

**Show Past Due Customers:** Includes customers serviced that are considered ‘Past Due’.

**Show COD Customers:** Includes customers serviced that are ‘COD’ only.

**Show Past Credit Customers:** Includes customers serviced that have exceeded their ‘Credit Limit’.

**Show Cash Customers:** Includes any sales made to the ‘Cash’ account.

**Show New Customers:** Includes any sales made to the ‘New Customer’ account.

**Show Off Route Customers:** Includes sales made to customers that were ‘Off-Route’.

**Show Gratis Products:** Includes any products sold using one of the ‘Gratis Reasons’.

**Show Products Sold less Than the Default Price:** Includes products sold for less than the default price.

**Show Products Sold Greater Than the Default Price:** Includes products sold for more than the default price.

**Show Products Sold less Than the Recurring Price:** Includes products sold at a price less than the recurring product price.
Show Products Sold Greater Than the Recurring Price: Includes products sold at a price more than the recurring product price.

Show Products Sold Less Than the Price Level Price: Includes products sold at a price less than the price level assigned to the customer.

Show Products Sold Greater Than the Price Level Price: Includes products sold at a price more than the price level assigned to the customer.

Show Products Sold at 0.00 price: Includes products sold at ‘0.00’ price.

Show Skipped Stops: Includes any stops that were assigned a ‘Skip Reason’ on route.

Driver Setup

The Driver Setup screen allows you to set up additional information for all employees that are setup as Drivers and Checkers within the Employee Setup screen.

Fields:

Employee ID: Displays the route driver’s ID.

Initials: Displays the route driver’s initials.

Name: Displays the route driver’s name.

Truck ID: Select the Truck ID that the employee regularly uses on route.

Handheld Password: Enter a numeric password for employees that will be using the handheld program.
**Handheld Type:**
Select the type of handheld that the current driver will use on route:

<table>
<thead>
<tr>
<th>Handheld Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dell Axim X51</td>
</tr>
<tr>
<td>ARM WIFI</td>
</tr>
<tr>
<td>E-15 / E-100 Series</td>
</tr>
<tr>
<td>EG-800</td>
</tr>
<tr>
<td>Compaq Aero 1500 Series</td>
</tr>
<tr>
<td>IT-70 / 700</td>
</tr>
<tr>
<td>Ipaq 3000 Series</td>
</tr>
<tr>
<td>Dell Axim</td>
</tr>
</tbody>
</table>

**NOTE:** Your version may include additional choices, as we frequently update this list.

**Handheld Printer Type:**
Select the type of printer that the current driver will use on route:

- None
- Automatic
- O’Neil
- IPC PP-55

**NOTE:** Select Automatic if your printer is not listed. If the printer does not work, contact Advantage Route Systems.

**Printer Connection Type:**
Select the connection method your printer uses to communicate with the handheld:

- Serial
- IR
- BlueTooth

**Show Route Map (Advanced Mapping Module):** Use this option to view the route map used for optimizing routes.

**Copy to Handheld during morning process (Advanced Mapping Module):** Select this option to transfer a copy of the route map to the handheld during the Morning Card process.

**TomTom – Automatically Pop-up Directions for Each Stop (Requires ARS TomTom Module):** Select this option to automatically access TomTom when selecting each stop on the handheld screen.

**Default Pin (Advanced Mapping):** Choose the pin style/color that should be used for this driver when exporting mapping data.
**Route:** Enter up to three characters that will be used as the driver’s route code.

**Route Type:** Select the route type that applies to this route (e.g., Delivery, Service).

**NOTE:** The Route Types option allows you to color-code your routes, to easily identify them within the Route Dispatch Manager. Route Types can be set up under Lists > Handhelds in RM2000.

**NOTE:** The Route Dispatch Manager is a unique routing tool that simplifies your daily route management routines. Contact ARS for further information.

**Starting Invoice:** Enter any six-digit number from 000001-999999 that will be assigned to this driver’s handheld for invoicing.

**NOTE:** It is recommended to use a different range of numbers for each driver to prevent duplicate invoice numbers in the program.

**Use Invoice Pool:** Select this option to use the company Invoice Pool established under File > Company Setup > Setup.

**NOTE:** Selecting this option will disable the driver’s individual invoice pool.

**Current Invoice:** This field displays the next invoice number available in the driver’s invoice pool. This field is updated automatically.

**Invoice Quantity:** Enter the number of invoice numbers that should be sent to the handheld each day.

**NOTE:** Enter a number that is adequate for the maximum number of daily deliveries as well as unplanned stops, such as special orders. If the number is too high, duplicate invoice numbers will appear quickly. If the number is too low, the handheld will not be able to create additional invoices.

**Invoice Rollover:** Enter the maximum invoice number that can be reached before the system reverts to the original Starting Invoice number.

**Transfer Time (Advanced Communications Module Only):** Enter the time (in military format) that wireless data transfers should take place.

**Group Area:** Select each Group Area Code that this route services.

**NOTE:** Group Area Codes are used as customer filters on each route, and can be added to RM2000 under Lists > Handheld.
Route Types

The Route Types option is used within the Route Dispatch Manager, found under the Route menu in RM2000. This option allows you to color-code each route type (e.g., Delivery, Service), to assist with identifying routes within the dispatch screen.

**NOTE:** The Route Dispatch Manager is a unique routing tool that simplifies your daily route management routines. Contact ARS for further information.

**Fields:**

- **Code:** Enter up to two characters that will represent the Route Type.
- **Description:** Enter a description for the Route Type.
- **Color 1, 2, 3:** Select up to three colors to create the desired color and shade for the Route Type.
Site Inspection Reasons

The Site Inspection Reasons are used on the handheld to verify the condition of equipment on-site.

**Fields:**

**Code:** Enter up to two characters that will represent the Site Inspection Reason.

**Description:** Enter a description for the Site Inspection Reason.

**Contact Reason:** Assign a Contact Reason to the current code to log the information on each customer’s Contacts tab.
Group Area Codes

*Group Area Codes* allow you to separate customers by geographic region for *Off-Route* customer filtering purposes on the handheld.

**NOTE:** The *Group Area Code* options available on the handheld can be found under *Lists > Handheld > Handheld Options*, on the *Off-Route* tab. If your company database contains less than 5000 customers, it is not necessary to use this feature.

**Fields:**

*Area Code:* Enter a single character that will represent the *Group Area Code*.

*Description:* Enter a description for the *Group Area Code*.

![Group Area Codes](image)
Container Contents

The *Container Contents* option is used in the *Paper Shredding* industry to identify the contents of the containers being picked up, emptied, or destroyed.

**Fields:**

*Code:* Enter up to two characters that will represent the *Container Content Code*.

*Description:* Enter a description for the *Container Content Code*. 
Employee Setup

The Employee Setup menu contains all information relating to employees, security, and commissions. Because much of this information is considered confidential, only supervisors should be allowed to access, view, and change this information.

| Employees | Security Level Codes | Commission Class Codes |

These three options will be discussed in the following sections.

Employees

Each employee that will use the RM2000 desktop and handheld program will need to be entered into the Employees database.

Information Tab

The Information tab contains common employee information and security settings.

Fields:

**Inactive:** Select this option to inactivate the employee and remove him/her from the login screens.

**Employee ID:** Enter up to eleven characters that will represent the employee.

**Initials:** Enter the employee’s initials.

**NOTE:** The Employee ID and Initials fields are required. You may not change the employee ID or initials once they have been saved.
**Name:** Enter the employee’s name.

**NOTE:** For larger companies, it may be helpful to add employees last name first, to assist with logging in and employee based report sorting.

**SSN (Optional):** Enter the employee’s Social Security Number.

**Phone:** Enter the employee’s phone number.

**Email Address:** Enter the employee’s Email address.

**Security Level:** Select the desired *Security Level Code* for this employee.

**NOTE:** *Security Level Codes* must be assigned to each employee to determine the level of program access granted to each user. *Security Level Codes* can be set up under *Lists > Employee Setup*.

**Hire Date:** Enter the date the employee was hired.

**Release Date:** This field displays the employee’s termination date.

**NOTE:** Employees with a termination date will not be able to log into the system or have access to a handheld.

**Password:** Enter a desktop password for the employee.

**Re-Enter Password:** Re-enter the desktop password to confirm that it has been entered correctly.

**Master User:** Select this option for employees that will be allowed to make changes to *Security Level Codes* within RM2000 — typically, only one or two users should have this option enabled.

**Restricted Invoice Entry:** Not currently in use.

**Employee Type:** Select the employee type from the options shown below:

- **Clerical:** Employee will only use the desktop program.
- **Driver:** Employee will use the handheld program and be assigned to a route.
- **Checker:** Employee will use the handheld program and verify product loads on delivery vehicles.
**Commissions Tab**

The *Commissions* tab contains commission settings for each employee.

**NOTE:** For further information on setting up commissions, refer to Chapter 2.05 of the *Supplemental Guide*.

![Commissions Tab Image]

**Fields:**

*Class:* The *Commission Class Code* assigned.

*Rate:* The commission rate being used.

*Percentage/Units:* The type of commission rate being used, valid options are:

- **P (Percentage):** the *Rate* entered is treated as a percentage (i.e., 5.000 is 5%).

- **U (Unit):** The *Rate* entered is treated as a flat rate per unit (i.e., 5.000 is 5 dollars).

*Balance (Optional):* Allows you to enter a running balance that will be included on the *Route Commission Report*.

*Quantity:* Allows you to enter a running quantity that will be included on the *Route Commission Report*. 
Security Level Codes

The Security Level Codes screen allows you to establish specific user rights within RM2000.

Fields:

Level Code: Enter a single character that will represent the Security Level Code.

Description: Enter a description for the Security Level Code.

Find: To search for a field name in the Selection column, enter the data and click ‘GO’.

Selection: This field displays the menu items in RM2000.

Level: This field displays the access level given to a particular option.

NOTE: Double-click on each field name to modify security level access. Each option available is defined on the next page: Write, Read, and None.

Mark all as: To globally change all of the items to the same security level, click on one of the following buttons:

- **Write**: Allows users to access and modify data, but they cannot delete it.
- **Read**: Allows users to view information, but they cannot modify it.
- **None**: Disables access to all options. Users will not be able to view or modify any data.

As more users are added to the system, you may want to restrict access to various system features. To do this, create new Security Level Codes and restrict user access accordingly.
Commission Class Codes

The *Commissions Class Codes* option is used to pay your drivers a point-of-sale commission rate.

**NOTE:** For further information on setting up commissions, refer to the *Supplemental Guide*.

**Fields:**

- **Class:** Enter a single digit character that will represent the *Commission Class Code*.
- **Description:** Enter a description for the *Commission Class Code*. 
Truck Information

The Truck Information section contains settings related to your delivery vehicles.

This section will help you set up your trucks and even use an optional module that lets you do an inspection of your vehicle before you leave the yard each morning. This is done on your handheld computer.

Trucks

The Trucks option allows you to create an entry for each delivery vehicle in your fleet. This information will be used on each route and handheld.

Fields:

Truck ID: Enter up to five characters that will represent each Truck.

Bays: Enter the number of bays on the current delivery vehicle.

Mileage: Displays the truck’s current mileage. Mileage is automatically updated from the handheld when entries are made.

Description: Enter a description for the delivery vehicle.

License (Optional): Enter the truck’s license plate information.

VIN (Optional): Enter the truck’s vendor identification number.

Bottle Capacity: Enter the maximum number of products this truck can carry.
Vehicle Condition Inspection

The Vehicle Condition Inspection option allows you to create a list of safety items that will need to be verified on the handheld each day prior to delivering to customers. Additionally, the checklist can be printed from the handheld after the inspection.

### Fields:

**ID:** Enter up to three digits that will represent a Category ID.

**NOTE:** To group items of the same type together, use the same Category ID (i.e., all items related to the engine may be assigned ‘01’).

**Item:** Enter up to three digits to designate the inspection item number.

**Description:** Enter a description for the item.

**Type:** Select the item type from the following list:

- **Yes / No:** Select this type if the item requires a ‘Yes’ or ‘No’ answer (i.e., “Does the engine run?”).
- **Numeric Value:** Select this type if the item requires a numeric value within a preset range. You can enter the lowest and highest value accepted (e.g., Tire Pressure).
- **Text:** Select this type if the item requires a text response. You can enter the maximum length accepted (e.g., Need Wiper Fluid).
- **List:** Select this type if the item will accept one of multiple options on a list (e.g., Excellent, Average).
- **Category Heading:** Select this option to designate the item as a category heading (e.g., Engine).

**Mandatory:** Select this option if the item will be required prior to completing the inspection.
**Non-Drive Warning:** Select this option to display a warning message if the response on the item is outside of an acceptable range.

**NOTE:** This option only applies to the ‘Yes/No’ and ‘Numeric Value’ item types.

**Print:** Select one of the following print options:

- **Always:** Select this option to always include this item on the Vehicle Inspection Report printed from the handheld.
- **Non-Drive Only (Requires Non-Drive Warning Option):** Select this option to include this item on the Vehicle Inspection Report only if it fails inspection.

---

### Custom Report Groups

The Custom Report Groups option allows you to link your own reports to the RM2000 menu for convenience to your desktop users. This can be helpful if your employees are calling up external spreadsheets or documents frequently.

**NOTE:** Refer to the Supplemental Guide for further information on this topic.

![Custom Report Groups](image)

**Fields:**

- **Menu Title for Report Group:** Enter the name of the external report.
- **Shortcut Character:** Select the shortcut letter that will be used within the RM2000 reports menu.
**Report folder location:** Enter the directory that contains the shortcut file to the external report.

**NOTE:** The *Report Folder Location* must contain a shortcut file to the report with an `.lnk` extension.

**Inactive Reports Folder:** Choose this option to inactivate the *Custom Report Group*.

**Security Level Access:**

*Available:* This field contains all of the *Security Level Codes* in RM2000.

*Selected:* This field displays all of the *Security Level Codes* that will view the *Custom Report Group*.

**NOTE:** Double-click on an individual *Security Level Code*, or use the arrows to enable the *Custom Report Group* for your employees that qualify.
Setup Wizards

Setup wizards allow you to input information quickly and accurately into RM2000.

New Customer Wizard

The New Customer Wizard allows you to enter all of the information required to create a new customer in RM2000.

NOTE: Before a new customer can be created, basic Lists menu items must be learned and created. Refer to each item discussed earlier in this manual and the Getting Started Guide for further information.

Step 1 of 5

This tab contains all of the customer’s billing and delivery contact information.

Billing Info:

Billing Account Name and Address: Enter the customer’s billing name and address information.

Billing ZIP Code: Select the customer’s ZIP Code from the drop-down list.

NOTE: All ZIP Codes that will be assigned to customers must be added to RM2000 under Lists > Zip Codes.
Verify Address: Select this option to lookup the ZIP+4 information for the entered address at www.USPS.com.

MangoGeo: Select this option to use the MangoGeo program for address verification and correction services.

NOTE: Try the MangoGeo program at no charge for fifteen addresses before being prompted to sign up for service. Additionally, you will automatically receive fifty additional usages by simply provided us with your contact information if you're interested in the program.

Master Billing Account Number: Enter an account number to which all transactions for this customer will be posted and billed. For standard accounts, leave this option blank.

NOTE: Refer to the Supplemental Guide for further information.

Phone: The new customer’s phone number and extension (if any).

Fax: The new customer’s fax number.

Contact: Enter the person to contact regarding billing information on the account.

Contact Phone: Enter the phone number to call if you have questions regarding this account.

Email: Enter the customer’s Email address.

NOTE: If the location where you deliver is the same as the billing address, then click this arrow to copy the information into the Delivery Info fields.

Delivery Info:

Delivery Account Name and Address: Enter the customer’s delivery name and address information.

Delivery ZIP Code: Select the customer’s ZIP Code from the drop-down list.

NOTE: All ZIP Codes that will be assigned to customers must be added to RM2000 under Lists > Zip Codes.
**MangoGeo:** Select this option to use the MangoGeo program for address verification and correction services.

**NOTE:** Try the MangoGeo program at no charge for fifteen addresses before being prompted to sign up for service. Additionally, you will automatically receive fifty additional usages by simply provided us with your contact information if you're interested in the program.

**Check Address:** Select this option to verify address information using the Advanced Mapping Module.

**NOTE:** The Advanced Mapping Module integrates with Microsoft Mappoint to provide address correction and route optimization options. Contact Advantage Route Systems for further information.

**Phone:** Enter the new customer’s phone number and extension (if any).

**Fax:** Enter the new customer’s fax number.

**Contact Name:** Enter the primary contact person to contact regarding deliveries on the account.

**Phone:** Enter the phone number of the delivery contact person.

**E-mail:** Enter the customer’s e-mail address.
Step 2 of 5

This screen contains credit and general settings on the account.

Fields:

Customer Type: Select the Customer Type Code that should be applied to this account.

Credit Class: Select the customer’s Credit Class Code.

Finance Charge: Select from the customer’s Finance Charge Code.

Admin. Charge: Select the customer’s Administrative Charge Code.

Statement: Select the customer’s Statement Code.

Sales Tax: Select the customer’s Sales Tax Code.

Price Level: Select the product price level to apply to the account.

NOTE: For further information on the pricing options above, refer to the Supplemental Guide.

Credit Limit: Specify the credit limit on the account.

NOTE: Leave the number at ‘0.00’ to establish unlimited credit on the account.

Open Invoice: Check this box if you would like to apply payments directly to the customer’s open invoices from within the payment screen. If this option is not selected, the customer’s invoices will not be itemized within the payment screen (Balance Forward) and each payment will be applied to the total amount due on the account.
Rent Invoice: Select this option if you would like to print a copy of the customer’s rental invoice when generating a statement on their account. The customer will need to be assigned to a statement with invoice copies in order for this option to function properly.

NOTE: Selecting this option will only print rental invoices for the customer in addition to the statement. All other invoice copies will be suppressed. Generally, customers with the Rent Invoice option selected are assigned to their own statement type.

Opening Balance: Enter an opening balance on the account.

Extra: Enter reference information of your choice (e.g., previous account number).

Notes: This permanent message will be logged on the Info tab of the customer’s account.

NOTE: You may elect to popup this message each time the customer’s account is accessed by selecting the ‘Popup Customer Note’ option found under File > Company Setup, on the Desktop tab.

Statement Message: This permanent message will be displayed on the customer’s desktop statement each month.

Business License: Enter the business license for this customer.

Sales Rep 1 & 2: Enter up to two separate sales representatives on the account.

Start Date: Enter the date that the customer signed up for service.

Start Reason: Choose a Start Reason for this account.
**Step 3 of 5**

This tab contains the customer’s product and equipment information.

**Default Products:**

Add items here to establish a standing product order on the account permanently.

To add a new product to the customer’s default list, click the button and the screen below appears. Select an item and the description appears. Override the price and quantity if necessary, and click ‘OK’ to complete the process.

**Code:** Select the product code from the list.

**Description:** The description of the selected product is automatically displayed.

**Price:** The price of the listed product. You may override this price if necessary.

**Quantity:** Enter a standing quantity to deliver with each stop, if desired.

**Par (Optional Module):** Enter the standing par level that should be maintained for the item.

**Use Price List:** Select this option to assign the customer to a Product Price List.
Package Plan (Package Plan Module Only): Choose the Package Plan Code to apply to the account.

NOTE: For further information on this module, please contact Advantage Route Systems.

Recurring Charges: Select this option to add a Recurring Charge to the customer’s account.

Bottle Deposits 1 & 2:

Code/ Description/Price/Quantity: Choose a container deposit within each line that applies to the account. Initial quantities may be entered, if necessary.

Step 4 of 5

Use this screen to manually assign equipment to the customer’s account. Up to 99 pieces of equipment may be added to each account.
Adding Equipment:

To add equipment to the customer’s account, click the button.

<table>
<thead>
<tr>
<th>Equipment ID</th>
<th>Type</th>
<th>Style</th>
<th>Frequency</th>
<th>Charge Code</th>
<th>Rent</th>
</tr>
</thead>
<tbody>
<tr>
<td>901269524</td>
<td>HOT/COL</td>
<td>WHITE CF</td>
<td>M</td>
<td>400</td>
<td>10.00</td>
</tr>
</tbody>
</table>

**Equipment ID:** Select the equipment ID from the drop-down list. You may only enter equipment that has been previously added to the equipment database.

**Type:** This field displays the type of equipment assigned to the piece of equipment.

**Style:** This field displays the style of equipment assigned to the piece of equipment.

**Frequency:** Displays the rent billing frequency code assigned to the piece of equipment. This code can be updated if necessary.

**Charge Code:** Displays the default rental code assigned to the piece of equipment. This code can be updated if necessary.

**Rent:** Displays the default rental rate assigned to this piece of equipment. This field can be updated if necessary.

**Installed:** The date the equipment was installed.

**All Rents Statement Billed:** Select this option to override individual equipment settings and bill all rentals on the desktop on the account.

**Comment 1:** Enter any optional notes regarding the piece of equipment.

**Comment 2:** Enter any optional notes regarding the piece of equipment.
Step 5 of 5

This screen contains the customer’s route settings.

Handheld Options:

Remittance Stub: Select this option to print a payment remittance stub with the customer’s handheld receipt.

Suppress Balance: Select this option to suppress the customer’s balance from printing on the handheld receipt.

Signature Required: Select this option to require the customer’s signature with each delivery.

Invoice Copies: Enter the number of handheld invoice copies to print with each delivery.

NOTE: Enter ‘9’ to print a Delivery Receipt, which suppresses all financial data.

Suppress Prices on Invoice: Select this option to suppress all product prices on the printed handheld receipt.

RV2000 Options (Optional Module):

This optional module pre-calls your customers regarding upcoming deliveries and items such as leaving bottles out and keeping their accounts current.

Don’t Call: Select this option if your customer does not want to be called by the automated system.

Start Time: The earliest time possible to call this customer.

End Time: The latest time possible to call this customer.

Language: Select the language that should be spoken to the customer.
Phone Number to Call: Enter the phone number to use when pre-calling the customer.

Other Options:

Route: Select the route the customer is to be assigned to.

Latitude and Longitude: Enter the coordinates of the customer’s delivery location.

Map Page: Enter the map page this stop can be found on within a Thomas Guide or similar.

Key Number: This field can be used to store a key code, and is displayed within the Driver Instructions field on the handheld.

P.O. Number: Enter a standing purchase order given to you by your customer.

P.O. Exp Date: Enter the purchase order expiration date.

P.O. Limit: Enter the original dollar value of the purchase order.

Delivery Calendar: Select this option to setup the customer’s permanent delivery schedule.

NOTE: Refer to the Getting Started Guide for further information on scheduling customers for delivery.

Group Area Code: This option allows you to separate customers by groups within the Off-Route List of the handheld. The codes can be set up under Lists > Handheld > Group Area Codes.

Messages: This feature allows you to enter messages that can be viewed by your route driver on the handheld.

For a detailed explanation of this screen, refer to the Customer Information section of this manual.
Water Analysis: The Water Analysis option allows you to enter chemical and foreign material readings collected at each customer’s location.

Site Stats: Site Stats allow you to enter specific data regarding well depths and tank settings on-site.

Bank Information: This information will be used by the optional Electronic Funds Module (EFT) when processing ACH direct debit transactions.

Open Telephone Request on Save: Select this option to automatically popup the Telephone Request screen after Save is selected within the New Customer Wizard.

Visa (EFT Module): The Credit Card button allows you to store credit card details on the customer’s account. This information will be used to process transactions through a third party vendor. For further information on these fields, refer to the Customer Information section of this manual.
Saving the New Account:

After all steps have been completed, click the **Save** button and the *New Account* box will appear:

![New Account # Box]

The next available account number will be automatically displayed. Click ‘OK’ to accept the number and create the account, or override the account number manually.

![Account number created]

Equipment Setup

The Equipment Setup Wizard allows you to add all of your equipment to RM2000.

NOTE: Refer to the Equipment Import document available on www.ARS247.com for information on importing all of your equipment globally.

Step 1 of 5

This step allows you to enter equipment identification information.

General Information Fields:

Equipment ID: Enter up to sixteen characters that will represent the piece of equipment.

Unit Type: Select the Equipment Type Code that applies to this piece of equipment.

Unit Style: Select the Equipment Style Code that applies to this piece of equipment.
## Step 2 of 5

This step contains billing information for each piece of equipment.

### Billing Information:

**Period Code:** The frequency that you bill rents. Refer to the chart below for further information:

<table>
<thead>
<tr>
<th>Freq.</th>
<th>Due in</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>January</td>
<td>A</td>
</tr>
<tr>
<td>N</td>
<td>February</td>
<td>B</td>
</tr>
<tr>
<td>N</td>
<td>March</td>
<td>C</td>
</tr>
<tr>
<td>U</td>
<td>April</td>
<td>D</td>
</tr>
<tr>
<td>A</td>
<td>May</td>
<td>E</td>
</tr>
<tr>
<td>L</td>
<td>June</td>
<td>F</td>
</tr>
<tr>
<td>L</td>
<td>July</td>
<td>G</td>
</tr>
<tr>
<td>Y</td>
<td>August</td>
<td>H</td>
</tr>
<tr>
<td></td>
<td>September</td>
<td>I</td>
</tr>
<tr>
<td></td>
<td>October</td>
<td>J</td>
</tr>
<tr>
<td></td>
<td>November</td>
<td>K</td>
</tr>
<tr>
<td></td>
<td>December</td>
<td>L</td>
</tr>
<tr>
<td>Monthly</td>
<td>Monthly</td>
<td>M</td>
</tr>
<tr>
<td></td>
<td>Odd Months</td>
<td>O</td>
</tr>
<tr>
<td></td>
<td>Even Months</td>
<td>P</td>
</tr>
<tr>
<td>Quarterly</td>
<td>1st month of Quarter</td>
<td>Q</td>
</tr>
<tr>
<td></td>
<td>2nd month of Quarter</td>
<td>R</td>
</tr>
<tr>
<td></td>
<td>3rd month of Quarter</td>
<td>S</td>
</tr>
<tr>
<td>Semi-</td>
<td>Jan. / July</td>
<td>T</td>
</tr>
<tr>
<td>Annually</td>
<td>Feb. / August</td>
<td>U</td>
</tr>
<tr>
<td></td>
<td>Mar. / September</td>
<td>V</td>
</tr>
<tr>
<td></td>
<td>Apr. / October</td>
<td>W</td>
</tr>
<tr>
<td></td>
<td>May / November</td>
<td>X</td>
</tr>
</tbody>
</table>
**Charge Code:** Select the *Rental Code* that will be used on this unit.

**Period Rate:** Enter the rental rate that will be used on this unit.

**Statement Billed:** Select this option to bill all rentals for this unit on the desktop. Alternatively, if this option is not selected, equipment rentals will be billed on the handheld.

**NOTE:** For further information on rental setup and billing, refer to the *Supplemental Guide*.

**Install Date:** The date the piece of equipment was installed (if applicable).

**Start Rent On:** Enter the starting rental date for this unit (if applicable).

### Step 3 of 5

This step contains purchasing information for each piece of equipment.

#### Purchase Information:

**Purchased From:** Enter the manufacturer that you purchased the equipment from.

**Date Purchased:** Enter the date you acquired the unit.

**Purchase Cost:** Enter the purchase amount for the unit.

**Warranty Exp:** Enter the warranty expiration date.

**Financed:** Check this box if the equipment was financed when purchased.

**Sold Price:** If the customer purchased the unit from your company, enter the sold price.
Sold Date: The date the unit was sold.

Sold As: Select whether the unit was sold as ‘New’ or ‘Used’.

Owned By Customer: Select this option if the customer owns the piece of equipment.

NOTE: Adding customer owned equipment to RM2000 will allow you to offer equipment servicing to the customer.

Step 4 of 5

This step contains optional comment fields that can be used for storing miscellaneous information on each unit.

Fields:

Comments 1 & 2: Enter any miscellaneous comments about this piece of equipment.
Step 5 of 5

This step allows you to install the new piece of equipment on an account, if desired.

Fields:

Account Number: Enter the account number where the unit will be/is assigned.

NOTE: Leave this option blank if the unit is not being installed.

Name (Installed Only): Displays the name on the customer’s account.
Address (Installed Only): Displays the address on the customer’s account.
Stop Number (Installed Only): Displays the stop number on the customer’s account.
Chapter 7 – Daily Processing and Transactions

Overview

The Transaction menu gives you access to a variety of functions relating to daily processing. These functions include making invoices, receiving payments, altering invoice data, posting transactions, calculating charges, equipment transactions, inventory, and purchase orders.

<table>
<thead>
<tr>
<th>Invoices and Adjustments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payments</td>
</tr>
<tr>
<td>Transaction Reports</td>
</tr>
<tr>
<td>Post Transactions</td>
</tr>
<tr>
<td>General Ledger Postings</td>
</tr>
<tr>
<td>Generate Rent Charges</td>
</tr>
<tr>
<td>Package Plan</td>
</tr>
<tr>
<td>Calculate Finance Charges</td>
</tr>
<tr>
<td>Calculate Administrative Charges</td>
</tr>
<tr>
<td>Generate Recurring Billing Charges</td>
</tr>
<tr>
<td>Close Period</td>
</tr>
<tr>
<td>Print Refund Checks</td>
</tr>
<tr>
<td>Equipment Processing</td>
</tr>
<tr>
<td>Receive Inventory</td>
</tr>
<tr>
<td>Purchase Orders</td>
</tr>
</tbody>
</table>

Each item is addressed in the order listed.
Entering and Modifying Invoice Data

The *Invoices and Adjustments* screen is used for daily transactions. Most of your invoice data input will be done via the handheld computer. However, additional items may need to be entered on the desktop (i.e., sales in the office, hand written tags, adjustments).

**Fields:**

*Account Number:* Enter the customer’s account number.

**NOTE:** Choose the *Fast Find* binoculars to search for the customer by name.

*Invoice Number:* Enter the desired invoice number, or press the *Tab* or *Enter* key to automatically generate an invoice number for this customer.

*Name:* This field displays the customer’s name.

*Address:* This field displays the customer’s address.

*City:* This field displays the customer’s city.

*Tax Code:* This field contains the customer’s *Sales Tax Code*.

*Date:* This field displays the date the invoice was created.

*Start Time:* This field displays the time the invoice was created.

*Time:* This field displays the time the invoice was created.

*Load Order:* Displays the *Load Order* number (if applicable).

*Route:* Displays the *Route ID* assigned to the stop.

*Seq. No:* Displays the *Sequence Number* assigned to the stop.

*Truck:* Displays the *Truck* used on route.

*Employee ID:* Displays the employee initials that created the transaction.
Employee Name: Displays the employee name that created the transaction.

**This Invoice:**

- **Previous Balance:** Displays the customer’s previous balance.
- **Sub Total:** Displays the sub-total for all items added to the invoice.
- **Tax:** Displays the total tax amount on the invoice.
- **Total:** Displays the total invoice amount, including the sub-total and tax.
- **Payments:** Select this button to enter a payment on the invoice.
- **Total Due:** Displays the total due amount minus any payments entered on the invoice.

**Detail Lines:**

- **Charge Code:** Displays the Product Charge Code added to the invoice.
- **Description:** Displays the description of the Product Charge Code.
- **Qty:** Displays the quantity being sold.
- **Price:** Displays the unit price.
- **Total:** Displays the product total per line item.
- **Tax:** Displays the product tax total per line item.
- **Serial / Control #:** Depending on the type of item added this field may display equipment serial numbers and Production Batch Codes (if applicable).

- **Gratis Reason:** If a product is being provided free of charge, a Gratis Reason may be displayed per line item.

**Available invoice options:**

- **Add:** Choose this option to add products to an invoice.
- **Delete:** Choose this option to delete items from the invoice.
- **Modify:** Choose this option to modify an item on invoice.
Payments

The Payments feature allows you to record payments collected, apply credits, and much more.

```
<table>
<thead>
<tr>
<th>Enter Payments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payments by Type</td>
</tr>
<tr>
<td>Credit Cards</td>
</tr>
<tr>
<td>Bank Transfer</td>
</tr>
<tr>
<td>Lock Box</td>
</tr>
<tr>
<td>Returned Check Processing</td>
</tr>
<tr>
<td>Payment Lookup</td>
</tr>
</tbody>
</table>
```

Each item is explained within this section.

Enter Payments

The Enter Payments option is used to enter standard payments received in the office.

**Fields:**

*Acct Number:* Enter or browse for the customer’s account number.

*NOTE:* Choose the Fast Find binoculars to search for the customer by name.

*Amount Paid:* Enter the amount paid.

*Payment Date:* Enter the date the payment was made.

*Check Date:* Enter the check date (if applicable).
Route: Select the route assigned to the customer.

Account Balance: Displays the total amount due on the account.

Unapplied Amount: Displays the total unapplied amount for the current payment.

Unapplied Discount: Displays the remaining discount amount that has not been applied.

Batch Number: Enter a batch number that can be assigned to groups of payment entered.

Employee: Select the employee that created the payment.

Name: Displays the customer’s name.

NOTE: Right-click on the Name field to view a mini-screen that displays the customer’s aged balance.

Address: Displays the customer’s address information.

Payment Type: Select the payment type from the following options:

- Cash
- Check
- Credit Card
- Coupon
- Money Order
- Debit Card
- Bank Transfer
- Barter

Check Number: Enter the check number or reference number on the payment (if applicable).

Account Balance: Displays the total amount due on the account.

Note: Enter any desired miscellaneous note in this field.

Discount Amount: Enter a discount or ‘write-off’ amount that will be added to the payment.

Pay All/Oldest: Select this option to automatically apply the payment to the oldest open items on the account.
Open Item Fields:

If Open Invoice is selected within the customer’s account (on the Credit tab), the following fields will be displayed on the screen.

NOTE: Selecting the Open Invoice option will allow payments to be applied directly to unpaid open items.

<table>
<thead>
<tr>
<th>Acct #</th>
<th>Invoice #</th>
<th>Date</th>
<th>Inv. Amt</th>
<th>Pending</th>
<th>Open Amt</th>
<th>Discount</th>
</tr>
</thead>
<tbody>
<tr>
<td>009011</td>
<td>000157</td>
<td>08/18/06</td>
<td>40.71</td>
<td>0.00</td>
<td>40.71</td>
<td>0.00</td>
</tr>
<tr>
<td>009011</td>
<td>000414</td>
<td>07/27/06</td>
<td>4.39</td>
<td>0.00</td>
<td>4.39</td>
<td>0.00</td>
</tr>
<tr>
<td>009011</td>
<td>0001390</td>
<td>08/28/06</td>
<td>3.41</td>
<td>0.00</td>
<td>3.41</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Acct Number: Displays the customer’s account number.

Invoice #: Displays the invoice number assigned to the item.

Date: The date of the invoice.

Inv. Amt: The original invoice amount.

Pending: The payments applied to this invoice that have not been posted on the account.

Open Amt: The amount of the invoice that is not paid.

Discount: The discount amount applied to the invoice.

Print Item: Select an invoice on the screen and choose this option to print a copy of the item.

Search: Select this option to search for a particular invoice number or amount within the customer’s Open Invoices.

Lookup Invoices: Select this option to search for an invoice on all customer accounts.
Payments by Type

The Payment by Type option is used for rapid payment entry. This option also includes automatic batch numbers, and balance sheets to ensure accuracy.

Fields:

Payment Date: Enter the date that will be used on all payments entered in the current batch.

Employee: Select the employee that will be assigned to all payments entered in the current batch.

Payment Type: Select the payment type that will be used on all payments entered in the current batch.

Automated Payment: Select this option to use a handheld barcode scanner to enter payments (requires additional setup).

Get Batch: Select this option to edit an existing payment batch.
The Payments by Type screen has been designed for quick entry. The differences between Enter Payments and Payments by Type are noted below:

**Fields:**
- **Done:** Choose this option when payment entry is complete.
- **Clear:** Choose this option to clear the current payment being entered.

**Payment by Type Check-Out:**

After entering your batch of payments, choose the Done button.

In order to complete the Payment by Type entry, the following balance sheet dialog box is included to double-check the payment totals entered. Enter the total amount of payments entered in this batch within the Total Amount field and click ‘OK’.
If the amount entered matches the payment amounts entered, the system will prompt you to lock the batch.

Alternatively, if the amounts do not match, the system will not allow you to continue.

**Additional Options:**

- **Delete:** Highlight a payment and choose this option to delete it from the batch.
- **Edit:** Highlight a payment and choose this option to delete it from the batch.
- **Add:** Select this option to add a new payment to the batch.
Credit Cards (Electronic Funds Module)

The *Electronic Funds Module* allows you to process credit cards directly with your bank or credit card processing software. Please contact Advantage Route systems for further information.

Bank Transfer (Optional Module)

The *Electronic Funds Module* allows you to process checking account information directly with your bank. Please contact Advantage Route systems for further information.
Lock Box Import

The *Lock Box* option is used to globally import payment transactions entered on an external spreadsheet.

**Fields:**

- **Account Number:** The account number to receive the payment posting.
- **Amount Paid:** The total amount of the payment.
- **Payment Type:** Select the type of payment the customer used from the drop-down list. Your options are:
  - Cash
  - Check
  - Credit Card
  - Coupon
- **Multiple Items:** Check this box if more than one item is being imported.
- **Employee:** The employee code of the person entering this transaction. You can type it in or select it from the drop-down list.
- **Date:** The date for the payment being acquired. It does not have to be today’s date.
- **Check Number:** If your customer paid by check, enter the check number used for this payment.
- **Filename:** Enter the name of the file or choose a file from the browse window.
Spreadsheet Example:
When importing payment data, you have the option of either importing a single payment that will be applied to multiple invoices, or you can import multiple payments that will be applied manually.

Single Payment Option:
To import a single payment using the Excel option, the data must be formatted as shown below:

Fields:
- **Date**: The date of the posted invoice.
- **Invoice #**: The invoice number assigned to the item.
- **Account #**: The customer’s account number.
- **Amount**: The total due amount of the invoice.
Multiple Payments Option:

To import multiple payments using the Excel option, the data must be formatted as shown below:

![Excel spreadsheet](image)

**Fields:**

**Date:** The date of the payment.

**Account #:** The customer’s account number.

**Check #:** The check number assigned to the payment (if applicable).

**Amount:** The payment total.

**Name:** The customer’s name.
Procedure to Import Data:

When you are importing a file using the Excel import option, it must be saved as type: ‘Microsoft Excel 5.0/95’ from within the ‘Save As’ screen in Microsoft Excel. After the file format has been updated, use the browse option to select the directory where the file is stored on your PC, and click ‘OK’. Once the information has been imported, you will receive a report listing all of the transactions processed.
Returned Check Processing

The Returned Check Processing option allows you to enter, track, and bill your customers for insufficient funds.

**Fields:**

- **Acct Number:** The customer’s account number.
- **Invoice Number:** Displays the invoice number that was generated to add the insufficient funds back to the customer’s account.

  **NOTE:** The invoice is generated after the Post option has been selected on the bottom-right portion of the screen.

- **Check Number:** The check number that was returned.
- **Check Amount:** The amount of the returned check.
- **Check Date:** The date on the returned check.
- **Entry Date:** The date the returned check entry was made in RM2000.
- **Paid Date:** The date the customer paid your company for the insufficient funds.

  **NOTE:** Once the ‘Paid Date’ is entered and the record is saved, select the Post button to clear the Returned Check flag from the customer’s account.

- **Contact Reasons:** Select a Contact Message Reason to associate with the returned check. This is used for reference on the Contacts tab of the customer’s account.
- **Employee:** The employee that created the returned check entry.
**Note 1-4:** Use the notes fields to input any information desired, for reference.

**Paid Note:** Enter a miscellaneous paid note for reference.

**Product Charge Codes:**

**Returned Check Balance:** Enter a *Product Charge Code* that will be assigned to the invoice created for the returned check payment.

**Returned Check Fee:** Enter a *Product Charge Code* that will be assigned to the returned check invoice to bill the customer a penalty fee.

**NOTE:** The *Product Charge Codes* above can be established as default selections by going to *File > Company Setup > Banking* tab.

**Returned Check Fee Amt:** Enter the penalty fee that the customer will pay for the returned check.

**NOTE:** If this option is left at 0.00, the default price assigned to the *Returned Check Fee Product Code* will be used.

**Post:** This button is selected after a new returned check entry is saved. RM2000 will create an invoice that includes the *Returned Check Balance* and *Returned Check Fee* options listed above. Additionally, the customer’s account will be flagged with ‘Returned Check’ throughout the program, and a new message will be added to their *Contacts* tab.

**NOTE:** The returned check invoice created will need to be posted on the customer’s account using the standard *Post Transactions* process.

**Additional Steps:**

When the ‘Save’ option is selected, the system will ask you to *Purge (Delete)* any entries marked as paid. Select ‘Yes’ to permanently remove previous returned check entries that have been resolved.
Clearing a Returned Check:

Once the customer resolves the returned check issue, simply return to the Returned Check Processing screen and modify the existing entry.

1. Enter a date into the Paid Date field.
2. Enter any desired notes in the Paid Note field.
3. Choose Save.
4. Select the Post button.

After the Post button has been selected, the ‘Returned Check’ flag will be removed from the customer’s account.

Employee: The initials of the employee who last edited this transaction.

Payment Lookup

This function allows you to search for payments, either by check number or payment amount. Press ESC during the lookup process to abort the lookup and display the results found to that point.

Fields:

Check Number: Enter a check number to include in the search (if applicable).

Payment Amount: Enter the payment amount to include in the search.

Include Previous Months: Indicate the number of months of history to include in the search.

Line Details:

Check No.: Displays matching check numbers.

Pay Date: Displays matching payment dates.

Amount: Displays payments matching the amount.

Account Number: Displays matching account numbers.

Customer Name: Displays matching names.
Posting Transactions

The items contained in this section are used to manage transaction posting procedures.

Transaction Reports

The following Transaction Reports are available to help you with your daily accounting:

- Transaction Detail
- Deposit Slip

These reports are described in detail within the section below.

Transaction Detail

The Transaction Detail Report provides you with detailed invoice and payment information entered into RM2000.

NOTE: This report can be configured to automatically print during the Afternoon Card process under Lists > Handheld > Handheld Options, on the Upload Reports tab.

Fields:

Primary and Secondary Sort: from the following sort options:

- Invoice Number
- Account Number
- Customer
- Time
- Sequence Number
Route Manager 2000 User Guide Chapter 7 – Daily Processing and Transactions

Route: Select the route you would like to view.

Invoice Date: Enter the date range to include in the report.

Blank Lines: Enter the number of blank lines you want between each record on the report (for writing notes).

All Routes for Date: Select this option to include all transactions for the date specified on the report.

Include Inventory Sold Summary: Select this option to include an inventory sold summary for the route entered.

All Unposted Transactions: Select this option to include all un-posted transactions on the report.

List Only for Selected Employee: Select this option to view transactions entered by a specific employee (choose an employee from the list upon selection).

Deposit Slip

This report allows you to print a deposit slip for payments entered. It can also serve as a cash receipts journal.

Fields:

Primary Sort: Select from the following sort options:

- Record Order
- Batch Number

Account Number: Enter the range of account numbers to include in the report.

Payment Date: Enter the range of payment dates to include in the report.
**Payment Type:** Select one or more payment types from the available options:

- Cash
- Check
- Credit Card
- Coupon
- Money Order
- Debit Card
- Bank Transfer
- Barter

**Use Permanent Payment File:** Select this option to run the report for posted payments.

**NOTE:** When this option is not checked, the report will only include un-posted payments.

**List Only for Selected Employee:** Select this option to view payments entered by a specific employee (choose an employee from the list upon selection).

**Include Cash Detail:** Select this option to include customer account detail on cash payments.

**Include Summary by Employee:** Select this option to include an additional report that will summarize payment totals entered per employee.

**Show Customer Names:** Select this option to include customer names in the report.

**Only Hold Service Accounts:** Select this option to generate a report that only includes ‘Hold Service’ status customers.
Post Transactions

The Post Transactions option is used to permanently add transactions to each customer’s account. In addition, the posting process will update product sales information, equipment, and much more.

**Post Transactions**

<table>
<thead>
<tr>
<th>Select transactions to post</th>
</tr>
</thead>
<tbody>
<tr>
<td>□ Invoice Transactions</td>
</tr>
<tr>
<td>□ Payment Transactions</td>
</tr>
<tr>
<td>□ Finance Charges</td>
</tr>
<tr>
<td>□ Equipment Movement</td>
</tr>
</tbody>
</table>

Payment Batch(s):

Invoice Transactions: Select this option to post invoice transactions.
Payment Transactions: Select this option to post payment transactions.
Finance Charges: Select this option to post generated Finance Charges.
Equipment Movement: Select this option to post equipment changes.
Payment Batch: Select an individual payment batch to post, if desired.
General Ledger Postings

This option creates a G/L Posting Report from your accounts receivable transactions.

**Fields:**

* **Sort by GL Account Number:** Select this option to sort the report based on the general ledger account numbers.

* **Reset G/L Un-posted Totals:** Select this option to reset the G/L totals to ‘0.00’ after the report has been previewed or printed. This option is generally selected during the *Month End* process.
Calculating Charges and Closing the Month

The following topics are part of the RM2000 Month End process. Before proceeding with any of the following functions, ensure that the Module Date is set to the last day of the month being processed and closed.

NOTE: Refer to the Supplemental Guide for further information on Month-End processing.

Generate Rent Charges

The Generate Rent Charges option is used to create equipment rental transactions.
**Fields:**

*Billing Period:* The current billing period and rent cycles being charged.

**NOTE:** Equipment Rent Cycles are set up in Company Setup, on the Equipment tab.

**Billing Type:**

*Statement Billed:* Select this option to generate rentals for customers that are billed on the desktop.

*Rents Not Billed:* Select this option to generate rentals for customers that are billed on the desktop, and any handheld billed customer’s that have not been charged for their rental.

**Rent Schedule:**

*Regular:* Check this box to generate rents using the normal monthly billing cycle.

*Scheduled 1:* Check this box to generate rent according to your custom Schedule 1 (if applicable).

*Scheduled 2:* Check this box to generate rent according to your custom Schedule 2 (if applicable).

**Other:**

*Customer Type:* Select the range of customer type to include in generating rent charges.

*Equipment Type:* Select the range of equipment type to include in generating rent charges.

*Employee:* The employee who is generating the rent charges.

*Use This Employee for all Rents:* Checking here will cause all rents created under this function to be credited to the employee selected, not to the usual Route Drivers.

**Report Options:**

Select the desired report(s) to print when generating rentals:

*Billing Summary Report:* This report includes a summary of the total amount billed per rental code.

*Rent Billing Detail Report:* This report includes detailed customer information per rental.

**Delete Pending Rents:**

Click this button to delete any pending rents that have already been generated.
Package Plan (Optional Module)

The Package Plan feature is an optional module; please contact Advantage Route Systems for further information.

Calculate Finance Charges

The Calculate Finance Charges option allows you to generate late charges on past due accounts.

Fields:

Customer Range: Enter the range of account numbers to include when generating late fees.

Minimum Balance: Enter the minimum balance a customer must have to qualify for a late fee (any balance under this amount will not be charged).

Delete Unposted Late Charges: Click this button to delete any pending late charges that have already been generated.
Calculate Administrative Charges

The Calculate Administrative Charges option is used to assess ‘handling’ fees on large accounts that demand a high level of resources and time in the office.

Fields:

Account Number: Enter the range of account numbers to include when generating administrative charges.

Administrative Charge Code: Select the range of Administrative Charge Codes to include when generating administrative charges.

Minimum Balance: Enter the minimum balance a customer must have to qualify for an administrative fee (any balance under this amount will not be charged).

Show Detail on Administrative Charges: Select this option to include detailed account information on the Administrative Charges Report.

Delete Unposted Administrative Charges: Click this button to delete any pending administrative charges that have already been generated.
Calculate Recurring Billing Charges

The Generate Recurring Billing option allows you to bill your customers for recurring fees such as fuel, invoicing, etc.

**Fields:**

- **Account Number**: Enter the range of account numbers to include when generating recurring charges.
- **Customer Type**: Select the range of Customer Type Codes to include when generating Recurring Billing Charges.
- **Charge Code**: Select the range of Product Charge Codes to include when generating Recurring Billing Charges.
- **Minimum Balance**: Enter the minimum balance a customer must have to qualify for a recurring charge (any balance under this amount will not be charged).
- **Show Detail on Recurring Billing Report**: Select this option to include detailed account information on the Recurring Billing Report.
- **Delete Unposted Recurring Charges**: Click this button to delete any pending recurring charges that have already been generated.

Close Period

The Close Period function is used to reset totals, archive customer data, and other important information at the end of each accounting period.

**NOTE:** You MUST close the period at the end of each month. Refer to the Supplemental Guide for a complete tutorial on the Month End process.
Other Transaction Processing

The following topics can be used at any time and are not directly related to the Month End process.

Print Refund Checks

The Print Refund Checks option allows you to refund your customers that have a credit balance.

NOTE: There are four available check printing options under Company Setup, on the Accounting tab. If the available check formats do not fit your needs, the Print Refund option still makes it convenient for creating refunds within the system, and the checks can be written by hand.

Fields:

Primary and Secondary Sort: Select from the following sort options:

- Account Number
- Date
- Refund Amount

Term Date: Enter the range of termination dates (the customer’s End Date) to include when generating refunds.
Account Number: The range of accounts to include in this report. This screen will automatically default to include all accounts.

Amount: The range to include in this report, up to $999,999.99.

Accept Criteria: Select this option to search for customers that qualify for a refund based on the criteria entered.

NOTE: You can single click on each account to include or exclude from generating and printing a refund.

Print: Select this button to generate the refund invoices, and print the refund checks (if applicable).
Equipment Processing

The Equipment Processing options allow you to manage equipment movement and servicing.

Equipment Transfer

The Equipment Transfer option is used to manage equipment movement entered on the handheld. New records are created as each route is uploaded, and the transfers are completed by selecting the Equipment Movement option within the Post Transactions screen.

NOTE: Each entry can be modified or deleted prior to posting, if desired.

Fields:

Account Number: Displays the account number associated with the entry.
Serial Number: Displays the equipment serial number associated with the entry.
Period Code: Displays the period code assigned to the unit.
Period Rate: Displays the rental rate assigned to the unit.
Start Rent: Displays the start rent date assigned to the unit.
Name: The name of the selected customer.
Name: Displays the customer’s name.
**Statement Bill:** This option corresponds to the *Statement Billed* setting on each unit.

**Charge Code:** Displays the rental code assigned to the unit.

**Transaction Date:** Displays the date of the entry.

**Action:** Displays the ‘action’ taken for the entry, the choices are:

- *Picked Up (P)*
- *Dropped Off (D)*
- *On Truck (T)*

**Equipment Movement**

The *Equipment Movement* option allows you to manually move equipment on the desktop.

**NOTE:** For further information on moving equipment in RM2000, refer to the *Supplemental Guide*.

**Equipment ID:** Select an equipment ID from the list.

**Date:** Displays the date of the entry.

**Time:** Displays the time of the entry.

**By:** Displays the employee that created the entry.
**Move To:**
Select the location that the unit will be moved to, the choices are:
- Warehouse
- On Truck
- Picked Up
- Received
- Service

NOTE: Once you have entered all of the information, the unit will be moved automatically when the Save or More button is selected.

**Equipment Service**
The *Equipment Service* option allows you to enter and track the service performed on each piece of equipment.

NOTE: For further information on equipment service options in RM2000, refer to the *Supplemental Guide*.

**Fields:**

*Equipment ID:* Select the equipment ID to service from the list.
Adding a Service Code:

To add a service code to the equipment ID selected, choose the Add key and the following screen will appear:

![Equipment Service Screen]

**Fields:**

- **Service Code:** Select the Equipment Service Code desired from the list.
- **Description:** Displays the description corresponding to the service code.
- **Date:** Enter the date the service was performed on this unit (double-click to choose on calendar).
- **Time:** Enter the time the service was performed.
- **By:** Select the employee that performed the service.
- **Hours:** Enter the number of hours spent performing the service.
- **Cost Part:** Enter the cost of parts used for the service.
Equipment Service Call

The Equipment Service Call option allows you to create service tickets that can be printed and distributed to your service technicians.

**NOTE:** For further information on equipment service options in RM2000, refer to the Supplemental Guide.

**Fields:**

- **Account Number:** Enter or browse for the customer’s account number.
- **Equipment ID:** Select the unit that will be serviced.
- **Date:** Displays the date the entry was created.
- **Call Type:** Select the Equipment Service Reason that applies to the request.
- **Time:** Displays the time the entry was created.
- **Message:** Enter any notes desired for the service technician.
- **Service History:** Displays any previous equipment services performed on the unit.
- **Employee ID:** Displays the employee that created the entry.

**Follow Up Info:**

- **Maintenance Personnel:** Select the service technician that will perform the service on the unit.
- **Follow Up Date:** Enter the date to schedule the service.
- **Follow Up Time:** Enter the time to perform the service.

**Other:**

- **Under Warranty:** Displays the warranty status of the unit.
Service Follow-Up Tab:
The Service Follow Up tab is used to enter all of the information associated with completing the service call.

Fields:
Maintenance Personnel: Select the service technician that completed the service.

Start and Finish Information:
Date: Enter the start/finish date of the service call.
Time: Enter the start/finish time of the service call.

Other:
Mechanical Problems: Select the Equipment Service Codes related to the service performed.

Cost:
Hours: Enter the number of hours it took to complete the service.
Amount/ Hour: Enter the rate per hour to perform the service.
Total Cost: Displays the total labor cost associated with the service performed.
Comments: Enter any comment desired regarding the service.
Service Call Complete: Select this option to indicate that the service call is completed.

Equipment Master Tab:
The Equipment Master tab allows you to quickly access the Equipment Master screen of the unit being serviced.
Receive Inventory

This feature allows you to enter inventory as it is created or received from your supplier.

**NOTE:** For further information on inventory options in RM2000, refer to the Supplemental Guide.

**Fields:**

- **Charge Code:** Select the *Product Charge Code* being updated.
- **Entry Date:** The date that the product was received.
- **Entry Date:** Enter the date the product is being updated.
- **Quantity:** Enter the number of units being updated.
- **Cost:** Enter the cost of the unit.
- **P. O. Number:** Enter an associated P.O. Number that will be used for tracking the item(s).
- **Vendor Name:** Enter the name of the vendor that the items are being received from (for reference only).
- **Employee:** The employee responsible for receiving inventory.
- **Post:** After an entry is made and saved, select the *Post* button to update the inventory.
Purchase Orders

The *Purchase Orders* option allows you to enter and track purchase orders used by your company for purchased products.

**NOTE:** For further information on the *Purchase Order* feature, refer to the *Supplemental Guide.*
Chapter 8 – Reports

Overview

The Reports menu gives access to a variety of reports that can be created in RM2000. The Reports menu is shown below.

- Accounting Reports
- Management Reports
- Communications Reports
- Route Reports
- Inventory Reports
- Equipment
- Statements
- Dunning Notices
- List Reports
- Graphs
- Custom Reports

These report options and their submenus (indicated by black arrows to the right) are described in detail within this chapter.
Accounting Reports

This section has several reports that will help your accounting department track important data in a variety of formats. These reports are as follows:

<table>
<thead>
<tr>
<th>Invoice Reprint</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invoice Lookup</td>
</tr>
<tr>
<td>Payment Lookup</td>
</tr>
<tr>
<td>Open Invoices</td>
</tr>
<tr>
<td>Paid Invoices</td>
</tr>
<tr>
<td>Sales Detail Report</td>
</tr>
<tr>
<td>Daily Sales Report</td>
</tr>
<tr>
<td>Gratis Sales Summary</td>
</tr>
<tr>
<td>Sales History Report</td>
</tr>
<tr>
<td>Cash Received by Sales Rep</td>
</tr>
<tr>
<td>Sales Tax Report</td>
</tr>
<tr>
<td>Sales Tax Collected Report</td>
</tr>
<tr>
<td>Reprint G/L Report(s)</td>
</tr>
<tr>
<td>Reprint Deposit Slip</td>
</tr>
<tr>
<td>Aging Analysis</td>
</tr>
<tr>
<td>Collections Agency Accounts Report</td>
</tr>
<tr>
<td>Returned Check Report</td>
</tr>
<tr>
<td>Inactive Accts w/Balances</td>
</tr>
<tr>
<td>Customer Refunds Report</td>
</tr>
<tr>
<td>Miscellaneous Accounts Deposits Report</td>
</tr>
<tr>
<td>Bottle(s) in Field Report</td>
</tr>
<tr>
<td>Month End Summary</td>
</tr>
</tbody>
</table>

The above menu picture groups the accounting reports by categories, so you can easily find the ones you need.
Invoice Reprint

The Invoice Reprint option can be used to reprint any invoice created on the desktop or handheld.

NOTE: Additionally, you can reprint individual invoices using the Invoice Lookup option within each customer’s account.

Fields:

Primary Sort: The primary field to sort by. You can choose from the following categories:
- Account Number
- Invoice Date
- Invoice Number

Account Number: The range of accounts to include in the report.

Date: The range of invoice dates to include in the report.

Invoice Number: The range of invoice numbers to include in the report, from the first to last invoice number.

Customer Type: The range of customer types to include in the report.

Include Summary: Prints a summary of reprinted invoices.
Invoice Lookup

The Invoice Lookup option allows you to search for a specific invoice based on the invoice number, amount, or P.O. number.

NOTE: You may search by the invoice number, the invoice amount or both. However, if both the invoice number and amount are used, they must match for results to be shown.

Fields:

Invoice Number: Enter the invoice number, up to six characters.
Invoice Amount: Enter the dollar amount of the invoice.
Include Previous: Specify how many months back the report will print.

NOTE: It is possible to search by the invoice number, the invoice amount or both. However, if both the invoice number and amount are used, they must match for results to be shown.

- Inv. No.: The invoice numbers that match the one specified.
- Inv. Date: The date of each matching invoice.
- Amount: The amount of the invoice.
- Account Number: Account number assigned to an invoice.
- Customer Name: The customer’s name.
After specifying an invoice number and the report time frame, click OK to initiate the search. The results include each instance when an invoice number has been used, along with associated dates, invoice amounts, account numbers, and customer names.

**NOTE:** Depending on the speed of your computer and the number of invoices on file, a report of over two years may take a few minutes to generate.

**Payment Lookup**

This option searches for payments entered into RM2000™, either by check number or by payment amount.

![Payment Lookup Window]

**Fields:**

**Check Number:** The check number to look up.

**Payment Amount:** The payment amount to look up.

**Include Previous Months:** Indicate the number of months to include in the search.

- **Chk. No.:** The invoice numbers that match the one specified.
- **Pay. Date:** The date of each matching invoice.
- **Amount:** The amount of the invoice.
- **Account Number:** Account number assigned to an invoice.
- **Customer Name:** The customer’s name.

**NOTE:** Press ESC while looking up payments to abort the lookup and display the results already found.
After specifying a payment and the report timeframe, click OK to initiate the search. The results include each instance when a payment has been made, along with associated dates, amounts, account numbers, and customer names.

Open Invoices

If you are using the *Open Invoice* option, the system can print a report of all unpaid invoices in the system.

### Fields:

**Primary Sort**: The primary field to sort by. You can choose from the following categories:
- **Invoice Date**
- **Invoice Number**

**Account Number**: The range of accounts to include in this report.

**Invoice Date**: The range of invoice dates to include in the report.

**Customer Type**: The range of customer types to include in the report.

**Credit Class**: The range of credit classes to include in the report.

**Include Aging**: Select this field to include aging in the report.

**Only Unapplied Credits**: Select this to show only credit invoices or unapplied payments.
Paid Invoices

The Paid Invoices report will list all paid invoices if you are using this option to post payments against an invoice. Use the screen below to select the customers and dates that are needed.

Fields:

Primary Sort: The primary fields to sort by. You can choose from the following categories:

- Invoice Date
- Invoice Number

Account Number: The range of accounts to include in this report.

Invoice Date: The range of invoice dates to include.

Customer Type: The range of customer types to include in the report.

Credit Class: The range of credit classes to include in the report.

Payment Dates: The range of payment dates to include.
Sales Detail Report

This report will print out a list of all the sales of a particular product so you can see how frequently you sell certain products to different customers.

Fields:

Primary and Secondary Sort: The primary and secondary fields to sort by. You can choose from the following categories:

- Customer Type
- Account Number
- Date
- Charge Code
- Product Class
- Driver/Sales Rep
- None

Account Number: The range of account numbers to include in the report.

Customer Type: The range of customer types to include in the report.

Sales Rep 1: This specifies that the employee range is tied to the Sales Rep 1 field of Customer Information.

Sales Rep 2: This specifies that the employee range be tied to the Sales Rep 2 field of Customer Information.

Driver: This specifies that the employee range could be tied to route drivers.

Dates: The range of dates to include in this report.

Charge Code: The range of charge codes to include in this report.

Product Class: The range of product classes to include in this report.

All: Checking ‘All’ selects the full range of data.
Daily Sales Report

The *Daily Sales* report allows you to print out a sales report for a specific date.

![Select Date(s) dialog box]

You can either print or fax this report. You can also choose to have product class totals printed on this report. Simply select a date and click OK.
Gratis Sales Summary

The *Gratis Sales Summary* report gives you total amounts for all products that were given away free throughout the month.

**Fields:**

*Primary Sort:* This option is defaulted for you.

*Secondary Sort:* This option is defaulted for you.

*Request Date:* The range of invoice dates to include in the report.

*Class:* The range of product classes to include in the report.

*Charge Code:* The range of charge codes to include in the report.

*Gratis Code:* The range of gratis codes to include in the report.
Sales History Report

This item prints a report that shows the sales history for a particular year for the given set of criteria.

### Fields:

**Primary and Secondary Sort:** The primary and secondary fields to sort by. You can choose from the following categories:

- **Account Number**
- **Account Name**
- **Group Area Code**

**Account Number:** The range of accounts to include in the report.

**Amount:** The range of account balances to include in the report, from the smallest to the largest amount, each up to $999,999.99.

**Customer Type:** The range of customer types to include on this report.

**Include Detail:** This printed report will include detailed information about sales made during the selected year.

**Include Cost of Goods:** This printed report will include the cost of goods sold for the selected year. You must have cost information entered for each product for this to be accurate.

**Year:** Select the year for the report to be printed.
Cash Received by Sales Rep

The Cash Received by Sales Rep report allows you to view the amount of cash collected, grouped by your sales representatives. This will only work if you enter the employee initials.

Fields:

**Date:** The range of dates to include on the report.

**Employee ID:** The employee’s identification range to include in the report.

**Account Number:** The range of account numbers to include in the report.

- **Sales Rep 1:** This specifies that the employee range be tied to the Sales Rep 1 field of Customer Information.
- **Sales Rep 2:** This specifies that the employee range be tied to the Sales Rep 2 field of Customer Information.
- **Sales Rep 1 or 2:** This specifies that the employee range could be tied to either Sales Rep 1 or 2.

**Include Detail:** This will include detailed information about each sale to the customer when the report is printed.

**Exclude Deposit Products:** Check this option to exclude any deposit items sold.
Sales Tax Report

Each time you run a posting update, you accumulate sales tax totals information. On a monthly, quarterly, or yearly basis, generate a report that will list how much you have accumulated in each category. This information can be transferred to your tax forms.

**Fields:**

- **Primary Sort:** The primary field to sort by:
  - **Sales Tax ID**

- **Sales Tax ID:** The range of sales tax codes to include in the report.

- **Calculate from History:** Selecting this option will create the report from transaction data instead of the totals. It will take longer to generate the report this way.
Sales Tax Collected

This report will display sales tax collected for every sales tax rate.

Fields:

**Primary Sort**: The primary field to sort by is the category:
- **Sales Tax ID**

**Sales Tax ID**: The range of sales tax codes to include in the report.

**Date**: Choose the date range.

**Include Detail**: Choose this option if you would like to see account numbers and invoice dates included in the breakdown of each Tax Authority.

**NOTE**: This item only works with *Open item* customers. If you are using customers on a balance forward system, then you MUST use the *Sales Tax Report*.
Reprinting G/L Reports

At month end, or even during the month, you can transfer your postings to the General Ledger. A posting report will print out during the process. If you have a problem during the initial printing, or you would like another copy, you can print the G/L report again using this option. A screen like this one will appear so that you can choose the batch that you want to reprint.

Reprint Deposit Slip

During normal business operations, use a deposit slip at the end of the day to check your figures against the payments received that day. You can reprint the deposit slip with this program. Simply choose the report you want and click on OK.

NOTE: You can only reprint deposit slips that were generated from the Deposit Slip screen found in the Transaction Reports.
Aging Analysis

This report displays account customer balances by the number of days outstanding. This identifies customers behind in payments. Phone numbers are on the reports, allowing you to easily contact these customers.

NOTE: This report fulfills your banker’s request for “An Aged A/R.”

Fields:

Primary and Secondary Sort: The primary and secondary fields to sort by. You can choose from the following categories:

- Account Number
- Account Name
- Balance

Account Number: The range of accounts to include in the report.
Customer Type: The range of customer types to include in the report.
Credit Class: The range of credit classes to include in the report.
Balance: The range of balances to include, from low to high.

NOTE: Select the ‘All’ box beneath each option listed above to include all of the items within that field on the report.

Include: Choose the columns to include on your report. The program automatically lists all delinquent accounts. However, you can narrow the list by selecting: Current, 30, 60, 90, or 120 or more days overdue.

Active Account: Check the box to receive a report for active accounts only.
**Inactive Accounts:** Check the box to receive a report for inactive accounts only.

**Summary Report Only:** Only the aged A/R totals will print on the report.

**Collections Agency Accounts Report**

Once delinquent accounts are turned over to a collection agency, a “W” will appear in the credit status of these customers. This report will list all accounts that have been sent to “collections.”

**Fields:**

**Primary and Secondary Sort:** The primary and secondary fields to sort by. You can choose from the following categories:

- **Account Number**
- **Account Name**
- **Balance**

**Account Number:** The range of accounts to include in the report.

**Customer Type:** The range of customer types to include in the report.

**Credit Class:** Designate a specific credit class from the drop-down list. If you use a credit class code other than "W" to indicate collection accounts, select that code.

**Customer Ending Date:** The range of dates when a customer was marked as terminated.

**Balance:** The range of balances to include in the report, from low to high.

**Active Account:** Check the box to receive a report for active accounts only.
**Inactive Accounts:** Check the box to receive a report for inactive accounts only.

**NOTE:** Both boxes can be checked to get a report for active and inactive accounts.

### Returned Checks Report

If you enter returned checks into the system, run this report periodically. Paying close attention here can help keep an account from becoming a bad debt status account.

![Returned Checks Report](image)

**Fields:**

**Primary and Secondary Sort:** The primary and secondary fields to sort by. Choose from the following categories:

- **Account Number**
- **Entry Date**
- **Check Amount**

**Account Number:** The range of accounts to include in the report.

**Entry Date:** The range of dates when the check was entered into the system.

**Check Amount:** The range of check amounts to include in the report, up to $999,999.99.
Inactive Accounts with Balances

After a period of time, you may accumulate a few accounts that are inactive and need more focused attention. By running this report, you will know exactly which accounts have gone inactive.

Fields:

**Primary and Secondary Sort:** The primary and secondary fields to sort by. Choose from the following categories:

- **Customer**
- **End Date**

**Ending Date:** Enter the range to include in the report. The ending date is the last sale date on a customer record.

**Account Number:** The range of accounts to include in the report.
Customer Refunds Report

This option prints a report of the customers requiring a refund based on criteria shown. For example, you can select credit balances for all customers who terminated service last month.

Fields:

Primary and Secondary Sort: The primary and secondary fields to sort by. You can choose from the following categories:

- Date
- Account Number
- Refund Amount

Account Number: The account range to include in the report.

Amount: The range of account balances to use in the report, from the smallest to the largest amount, each up to $999,999.99.

Terminated Date: The range of dates to include in the report. This report selects dates based on the customer’s termination date.
Miscellaneous Accounts Deposits Report

This report prints a list of deposits that have been entered into the Deposits field on the $Tab on the Customer Information Screen.

Fields:

Primary and Secondary Sort: The primary and secondary fields to sort by. You can choose from the following categories:

- Date
- Account Number
- Account Name
- Customer Type
- Sales Rep

Account Number: The range of accounts to include on the report.

Start Date: Select the range of customer start dates to appear on the report.

Only Non-Terminated Customers: This option will cause RM2000 to filter out all inactive customers and give values that reflect only those customers with whom you are still doing business.
Bottles in Field Report

This report shows the total number of bottles being used by your customers. If you have different types of bottles (i.e. using different charge codes), you can choose one or more of each type every time you run the report.

**NOTE:** The fields described below are on the actual report.

**Fields:**

- **Primary and Secondary Sort:** The primary and secondary fields to sort by. You can choose from the following categories:
  - Account Number
  - Account Name
  - Charge Code
  - Quantity

- **Product ID:** The range of product ID’s to include in the report.

- **Print Details:** This will include detailed information about bottles in the field when the report is printed.
Month End Summary

The *Month End Summary* report is a collection of data from a number of areas within the RM2000™ system. It puts data right at your fingertips to give you valuable information about your company. It can be run any time during the month, but is especially helpful at month end.

### Month End Summary

09/22/2010

<table>
<thead>
<tr>
<th>Total Invoices</th>
<th>794.38</th>
</tr>
</thead>
<tbody>
<tr>
<td># of invoices</td>
<td>1</td>
</tr>
<tr>
<td>Total Rents</td>
<td>0.00</td>
</tr>
<tr>
<td># of Manual Rents</td>
<td>0</td>
</tr>
<tr>
<td>Total Payments</td>
<td>009.32</td>
</tr>
<tr>
<td># of Payments</td>
<td>2</td>
</tr>
</tbody>
</table>

| Total Due | 791.57 |
| Current   | -30.75 |
| 30-60 Days| 0.00   |
| 61-120 Days| 0.00 |
| 121-360 Days| 0.00 |
| 361+ Days | 822.32 |

<table>
<thead>
<tr>
<th>Tax Authority</th>
<th>Water</th>
<th>Coffee</th>
<th>Misc</th>
<th>Exempt</th>
</tr>
</thead>
<tbody>
<tr>
<td>COUNTY TAX</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>EXEMPT</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
<tr>
<td>STATE TAX</td>
<td>11.880</td>
<td>35.000</td>
<td>0.000</td>
<td>0.000</td>
</tr>
</tbody>
</table>

**Tax Totals**

<table>
<thead>
<tr>
<th>Change Code</th>
<th>Product Description</th>
<th>Number Gallons</th>
<th>Qty Sold</th>
<th>Product Sales</th>
<th>Product Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>180</td>
<td>6 GAL. WATER</td>
<td>0.000</td>
<td>50</td>
<td>237.50</td>
<td>237.50</td>
</tr>
<tr>
<td>228</td>
<td>FOLGERS 60 T</td>
<td>0.000</td>
<td>50</td>
<td>590.00</td>
<td>590.00</td>
</tr>
</tbody>
</table>

**Product Totals**

| Product Totals | 0.000 | 737.50 | 737.50 |
Management Reports

This section has several reports that will help your management team obtain information. These reports are:

<table>
<thead>
<tr>
<th>Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starts and Stops</td>
</tr>
<tr>
<td>Business Pulse Report</td>
</tr>
<tr>
<td>Route Commission Report</td>
</tr>
<tr>
<td>Driver Summary Report</td>
</tr>
<tr>
<td>Manufacturing Control Report</td>
</tr>
<tr>
<td>Master Billed Accounts</td>
</tr>
<tr>
<td>Projected Delivery Report</td>
</tr>
<tr>
<td>Route Planning Report</td>
</tr>
</tbody>
</table>

Each report is explained in the section below.
Starts and Stops

Based on the Start and Stop Reasons assigned to each account, this report summarizes the reasons your customers begin and end service with your company.

**Fields:**

**Primary and Secondary Sort:** The primary and secondary fields to sort by. You can choose from the following categories:

- Account Number
- Date
- Reason
- City
- Sales Rep
- ZIP Code

**Account Number:** The range of accounts to include in the report.

**Date:** The range of start dates to include in the report.

**Reason:** The range of Start/Stop Reasons to include in the report. You may specify a range if your codes are organized properly. The Start/Stop Reasons are set up in the List information and applied to each customer account.

**Which Report?** Select the type of report to print from the options below:

- Additions (Starts)
- Terminations (Stops)
Sales Reps:

- **Sales Rep 1:** This specifies that the employee range be tied to the Sales Rep 1 field of Customer Information.
- **Sales Rep 2:** This specifies that the employee range be tied to the Sales Rep 2 field of Customer Information.
- **Both:** This specifies that the employee range could be tied to either Sales Rep 1 or 2.

**Only include accounts with credit balances:** Check this box to include only accounts with a credit balance.

**Include start/stop reason summary:** Check this box to include a start/stop reason summary at the end of the report.

**Extended Information:** This option will enable further detailed information to be printed on the report.

**Include only active customers:** This option will include only active customers on the report.

**NOTE:** Extended Information is only available with Termination reports.

### Business Pulse Report

For a one-page consolidated summary of key accounting information, you may want to run this report. You will see such information as accounts receivable balances, cash collected, etc.

<table>
<thead>
<tr>
<th>Business Pulse Report</th>
<th>0304/2004</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Invoices</td>
<td>1155,43</td>
</tr>
<tr>
<td># of Invoices</td>
<td>11</td>
</tr>
<tr>
<td>Total Amounts</td>
<td>0.00</td>
</tr>
<tr>
<td># of Manual Receipts</td>
<td>0</td>
</tr>
<tr>
<td># of Handwritten Items</td>
<td>0</td>
</tr>
<tr>
<td>Total Days</td>
<td>1125,43</td>
</tr>
<tr>
<td>Current</td>
<td>0.00</td>
</tr>
<tr>
<td>31 l/0 Days</td>
<td>0.00</td>
</tr>
<tr>
<td>61-90 Days</td>
<td>0.00</td>
</tr>
<tr>
<td>91-120 Days</td>
<td>0.00</td>
</tr>
<tr>
<td>121+ Days</td>
<td>0.00</td>
</tr>
<tr>
<td>Tax Authority</td>
<td></td>
</tr>
<tr>
<td>STATE TAX</td>
<td>1083.50</td>
</tr>
<tr>
<td></td>
<td>6,4600</td>
</tr>
<tr>
<td></td>
<td>31,7900</td>
</tr>
<tr>
<td></td>
<td>13,3900</td>
</tr>
<tr>
<td></td>
<td>0.0000</td>
</tr>
<tr>
<td>COUNTY TAX</td>
<td>1006.50</td>
</tr>
<tr>
<td></td>
<td>0.0000</td>
</tr>
<tr>
<td></td>
<td>12,7900</td>
</tr>
<tr>
<td></td>
<td>5,3900</td>
</tr>
<tr>
<td></td>
<td>0.0000</td>
</tr>
<tr>
<td>Tax Totals</td>
<td>5,4600</td>
</tr>
<tr>
<td></td>
<td>43,7900</td>
</tr>
<tr>
<td></td>
<td>18,7900</td>
</tr>
<tr>
<td></td>
<td>0.0000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Change Code</th>
<th>Product Description</th>
<th>Number</th>
<th>Qty Sold</th>
<th>Product Sales</th>
<th>Product Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>400</td>
<td>EQUIP RENTAL</td>
<td>0.0000</td>
<td>3</td>
<td>26.00</td>
<td>26.00</td>
</tr>
<tr>
<td>101</td>
<td>5 GAL WATER</td>
<td>0.0000</td>
<td>24</td>
<td>89.50</td>
<td>59.50</td>
</tr>
<tr>
<td>500</td>
<td>5 GAL DEPOSIT</td>
<td>0.0000</td>
<td>11</td>
<td>55.00</td>
<td>55.00</td>
</tr>
<tr>
<td>101</td>
<td>3 GAL WATER</td>
<td>0.0000</td>
<td>6</td>
<td>19.50</td>
<td>13.50</td>
</tr>
<tr>
<td>501</td>
<td>3 GAL DEPOSIT</td>
<td>0.0000</td>
<td>2</td>
<td>6.00</td>
<td>6.00</td>
</tr>
<tr>
<td>200</td>
<td>5LB COFFEE</td>
<td>0.0000</td>
<td>5</td>
<td>25.00</td>
<td>25.00</td>
</tr>
<tr>
<td>730</td>
<td>65 SUBJECT</td>
<td>0.0000</td>
<td>0</td>
<td>65.00</td>
<td>65.00</td>
</tr>
</tbody>
</table>

This is one of the easiest ways to keep your finger on key indicators.
Route Commission Report

If your company pays commission on the products sold by your route salespeople, this report can be very helpful in calculating how much should be paid to each person.

Fields:

*Primary Sort:* This option is defaulted for you. This report can only be printed by employee ID.

*Employee:* The range of employees to include in the report. Select the type of employee to run this report for from the list:

- Drivers
- Sales Person (Rep) 1
- Sales Person (Rep) 2

*Un-posted Invoices:* Use this option to only include invoices that have not been posted on the report.

*Do not include secondary invoice date:* Click here if you want the report to only use the primary invoice date.

*Primary Invoice Date:* The range of invoice dates to include in the report. The primary invoice is typically the current month.

*Secondary Invoice Date:* Any range of dates to include in the report. This is useful in gathering year-to-date totals.

*Include Beginning Balance:* This includes the beginning balance or quantity into the figures for each commission class.
Driver Summary Report

This shows the product sales and payments received from all of the drivers.

**Fields:**

**Primary Sort:** This option is defaulted for you. This report can only be printed by the route drivers.

**Employee Initials:** The range of drivers to include in the report. The drop-down lists contain driver initials, up to three letters.

**All Employees:** Check this box to include all employees and drivers in the *Driver Summary* report.

**Invoice Date:** The range of invoice dates to include in the report.

**Un-posted:** This report is generated from un-posted transactions.

**Commission Codes:** Select the commission codes to include from the list that appears. If you do not select specific commission codes, the program will include all commission codes in the report.

**NOTE:** Once a commission code has been selected, the report will print.
Manufacturing Control Report

Some products are assigned a manufacturing control number for quality control, including recall purposes. This report will show which accounts have received products with manufacturing control numbers.

**Fields:**

**Primary and Secondary Sort:** The primary and secondary fields to sort by. You can choose from the following categories:

- Account Number
- Account Name
- Charge Code
- Quantity

**Manufacturing Control #:** Enter the range of batch numbers to include in this report.

**Date:** The range of dates to include in the report.

**Acct No.:** The range of accounts to include in the report.

**Include Un-posted Invoices:** Check this box to include in this report recent transactions that have not yet been posted.

**Summary Only:** Check this box to include only a list of account numbers in the report. Otherwise, the report will also print a list of products associated with the manufacturing control numbers.
Master Billed Accounts

This report will display master billed accounts.

Fields:

Account Number: The range of accounts to include in the report.
Start Date: The range of start dates to include in the report.
Only Non-terminated Customers: This option will include only customers who do not have an end date on their record.
Projected Delivery Report

This report calculates customer delivery needs based on their projected usage.

NOTE: This report is generally only used in the propane industry.

Fields:

Primary and Secondary Sort: The primary and secondary fields to sort by. You can choose from the following categories:

- City
- Percent Full
- Zip Code

Available Products: The product list available.

Selected Products: Add the product range that should be included in the report.

Cut Off Date: The projected end date the report should include, based on the customer’s delivery calendars (generally entered a week or more in advance).

% Full From/To: The projected amount full that the system should include in the report (e.g., 1 to 60%).
Route Planning Report

The Route Planning Report provides you with the number of deliveries per customer within a specific period of time.

### Fields:

**Primary Sort**: This report is automatically sorted by Route.

**Account Number**: Enter the account number range that you would like to include in the report.

**Route**: Enter the route range that you would like to include in the report.

**Period (Days)**: Enter the number of days to include in each period listed on the report (i.e., enter a ‘7’ to include the number of deliveries per week, or ‘1’ to include the number of deliveries per day).

**Start Date**: Enter the starting date for deliveries to include in the report.
Communications Reports

This section has reports that will help your managers when they need information about contact with your customers.

Telephone Messages

This report shows all of the telephone requests entered by your staff for the selected search criteria.

Fields:

Primary and Secondary Sort: The primary and secondary fields to sort by. You can choose from the following categories:

- Account Number
- Date
- Route

Acct No.: Enter the range of account numbers to include in the report.

Entered Date: Input the range of Telephone Message entry dates (created date) to include on the report.

Follow Up Date: Enter the range of assigned follow-up dates to include on the report.

Employee: Select the range of employee initials matching your requirements.

Reasons: You may choose the contact reasons you would like to include on the report.
**Selected Reasons:** This list shows the contact reasons you are including on the report.

[> ] Click this button to move the selected telephone reason from the list of *Reasons* to *Selected Reasons*.

[>>] Click this button to move all of the telephone reasons in *Reasons* to *Selected Reasons*.

[< ] Click this button to move the selected telephone reason from *Selected Reasons* to *Reasons*.

[<<] Click this button to move all of the telephone reasons in *Selected Reasons* to *Reasons*.

[Reset List] Click this button to clear all the selected reasons from the list.

**Open Tickets:** Select this option to view all telephone requests that have not yet been filled.

**Completed Tickets:** Select this option to view all telephone requests that have been completed.

**Both:** Select this option to view both open and completed telephone requests.
Contact History

This report allows you to print a summary of contact messages entered by your staff for the selected search criteria. The flexible format allows you to see a report by variety of parameters including dates, operators and reasons. This will allow you to maintain a high degree of control over customer service personnel so that quality service can be given to your customers.

NOTE: Contact history messages are originally entered on the Contact tab in the Customer Information screen.

Fields:

**Primary and Secondary Sort:** The primary and secondary fields to sort by. You can choose from the following categories:

- **Account Number**
- **Entered Date**
- **By Follow up Date**
- **By Contact Person**

**Acct No.:** Enter the range of account numbers to include in the report.

**Entered Date:** Input the range of Contact History entry dates (created date) to include on the report.

**Follow Up Date:** Enter the range of assigned follow-up dates to include on the report.

**Employee:** Select the range of employee initials you want displayed on this report.

**Reasons:** You may choose the contact reasons that you would like to include on the report.
**Selected Reasons:** This list shows which contact reasons you are including on the report.

- **>** Click this button to move the selected contact message reason from available Reasons to Selected Reasons.
- **>>** Click this button to move all of the available contact messages from Reasons to Selected Reasons.
- **<** Click this button to move the selected contact message reason from Selected Reasons to Reasons.
- **<<** Click this button to move all contact reasons from the Selected Reasons to Reasons.
- **ResetList** Click this button to clear all the selected reasons from the list.

**NOTE:** You may also double-click on a selected item to move it from one area to the other.
## Route Reports

This section has several reports that will help your route managers when they need information from the accounting department. These reports include the following:

<table>
<thead>
<tr>
<th>Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Past Due Average by Route</td>
</tr>
<tr>
<td>Average Price per Product</td>
</tr>
<tr>
<td>Past Due by Route Day</td>
</tr>
<tr>
<td>Past Due Authorization Codes</td>
</tr>
<tr>
<td>Suspended Accounts</td>
</tr>
<tr>
<td>Stops by ZIP Code</td>
</tr>
<tr>
<td>Route Stop Mapping</td>
</tr>
<tr>
<td>Customer Route List</td>
</tr>
<tr>
<td>Price List by Customer</td>
</tr>
<tr>
<td>Route Times</td>
</tr>
<tr>
<td>Payment Summary by Route</td>
</tr>
<tr>
<td>Sales by Route and Service Day</td>
</tr>
<tr>
<td>Last $ Delivery</td>
</tr>
<tr>
<td>Customer Purchases Report</td>
</tr>
<tr>
<td>Customers Without Delivery / Unscheduled Customers</td>
</tr>
<tr>
<td>Minimum Purchase Offenders Report</td>
</tr>
<tr>
<td>Reprint Product Sold Report</td>
</tr>
<tr>
<td>Customer Delivery Calendar</td>
</tr>
<tr>
<td>Calendars By Day</td>
</tr>
<tr>
<td>Expired Purchase Orders</td>
</tr>
<tr>
<td>Material Pickup Report</td>
</tr>
</tbody>
</table>

These reports will be explained in detail within the section below.
Past Due Average by Route

The *Past Due Average by Route* report will help determine the scale of delinquency, and which routes have the most problems with delinquent accounts. Priorities for collection and collection techniques can be established in terms of routes or areas to target when taking the necessary actions to correct the problems or prevent future problems.

**Fields:**

**Primary Sort:** Select this option to sort by a customer’s account number or name.

**Route:** The range of routes to include in the report.

**Balance:** The range of balances to include in the report. You must have the “Include Detail” box checked before you can input figures into this field.

**Include Detail:** Select this box to include the transaction details in the report.

**Show Column Totals:** Select this option to include a summary of each column listed on the report.
Average Price per Product

This report will show you the average price your customers are paying for your products. This can be helpful in determining the effectiveness of your current pricing structure. If you want a printout for only one charge code, enter the same code into both fields.

**Fields:**

*Primary Sort:* This option is defaulted for you. This report can only be printed by charge code.

*Charge Code:* The range of charge codes to include in the report.
Past Due by Route Day

If you only want to find customers who are past due on a specific day on a specific route, this report will allow you to do so. Daily urgency for route or sales personnel to make collections is built into this report.

Fields:

**Primary and Secondary Sort:** The primary and secondary fields to sort by. You can choose from the following categories:
- **Account Number**
- **Account Name**
- **Sequence**

**Route:** Specify a range of routes to include in the report from the dropdown list.

**Date:** The range of route dates to include in the report.

**Include:** Choose the past due data ranges to include in this report. The options are: Current, 30, 60, 90 and 120 or more days.

**All, including zero balances:** To include all of the routes in this report, check this box.

**Show Column Totals:** Select this option to include a summary of each column listed on the report.
Past Due Authorization Codes

This option will print a report of all customers requiring an authorization code for the criteria selected below.

Fields:

*Primary and Secondary Sort*: The primary and secondary fields to sort by. Choose from the following options:

- **Date**
- **Route**

*Route Date*: The range of delivery dates to include on the report.

*Route*: The range of routes to include on the report.
Suspended Accounts

Keeping track of your suspended accounts is easy when you generate a report from this program. There are several options available with the report making it easy to know who is suspended from service.

Fields:

**Primary and Secondary Sort:** The primary and secondary fields to sort by. Choose from the following categories:

- Date
- Account Number
- Account Name
- Customer Type
- Sales Rep

**Account Number:** The range of customer accounts to include in the report.

**Start Date:** The range of start/suspend dates to include in the report.

**Customer Type:** Choose the customer type range to include in the report.

**Sales Rep:** Choose the sales rep ID’s to be included in the report.

**Only Non-Terminated Customers:** Customers that have been terminated.
Stops by ZIP Code

You can generate a report of all your route stops according to ZIP Code using this option. This can be helpful when re-engineering any routes. It will also let you see how many customers you have in each area.

Fields:

Primary Sort: The primary sorting field. Choose from the following categories:

- ZIP Code
- City

ZIP Code: The range of ZIP Codes to include in the report.

Only Non-Terminated Customers: This option will only include customers who do not have an end date on their record.
Route Stop Mapping

Route Manager 2000™ lets you view your stops in Microsoft's® Streets & Trips 2004. Our program will help export the data to use with any mapping software. For more assistance, see our support Web site.

Fields:

**Primary Sort:** You can choose to sort by the following categories:
- **Sequence**
- **Account Number**
- **Account Name**

**Date:** Enter a date range for the routes you would like to export.

**Route:** The range of routes to include in this export process.

**Combine all into one file:** Check here to combine all routes selected into one export file.

**Include warehouse as first stop:** Check this box if you want to use your company warehouse address as the beginning of a route. Useful for optimization.

**Directory:** Enter the path (or directory) where the file should be saved. The path should include the drive letter, as in the following example: C:\MAPPING.
Customer Route List

Occasionally, you should examine the master accounts that are paying invoices for sub-accounts. This report generates a listing of each billing account and the associated delivery addresses.

Fields:

**Account Number:** The range of customer accounts to include in the report.

**Start Date:** The range of start dates to include in the report.

**Minimum Number of Stops:** Set the minimum number of stops for master billed accounts.

**Only Non-Terminated Customers:** Select this option to only include accounts that do not have an end date.
Price List by Customer

Use this report to print a list of customers grouped by the price list assigned to each.

Fields:

Primary and Secondary Sort: The primary and secondary fields to sort by. Choose from the following categories:

- Price List
- Account Number

Price List: Select the range of price lists to include in the report. If you only want to include one price list, then enter the same value in the “from” and “to” fields.

Account Number: Enter the range of account numbers to include in the report.
Route Times

Use this report to manage your routes more effectively. It allows you to look at a single route or several routes to see the times that each customer was serviced. The report also shows the sequence number so you can evaluate the route efficiency. Large gaps of time between stops may need to be investigated.

Fields:

Primary Sort: This option is defaulted for you. This report can only be printed by route.

Route Date: The range of dates to include in the report.

Route: The range of routes to include in the report.

Output to map file: You may choose to print this report to paper or output it to a file that can be imported into a mapping program such as Microsoft Streets & Trips. If you choose this option, it will prompt you for the next two fields. These are only required if you are using an output file. See our support Web site for more assistance.

Combine all into one file: If you are requesting more than one route, you can choose this option. This will combine stops from more than one route/day combination into a single file. If you do not check the box, the system will create a unique file for each route/day item. It will be named by route/day in order to identify your route.

Include warehouse as first stop: When using a mapping program to design your route, it is often useful to include your warehouse address as the first stop in the file. This will allow you to include it as a pushpin to show the entire route.

Directory: Enter the path (or directory) where the file should be saved. The path should include the drive letter, as in the following example: C:\MAPPING.
MapPoint button: If you are using the MapPoint program, you can use this option to plot the route times on a map to assist you in optimizing your route deliveries.

Payment Summary by Route

This report prints a summary by route of payments received for the criteria entered below. This can be helpful if you pay commissions to each route driver based on money collected.

Fields:

Primary Sort: This option is defaulted for you. This report can only be printed by route.

Date: The date of the payments.

Route: The range of routes to include in the report.

Include Off Route: Check this box to include payments collected from customers who were not assigned to the route.
Sales by Route and Service Day

Another tool to help you in managing your routes is the *Sales by Route* report. This report shows the sales for individual routes and service days. This printed report displays sales totals and details for individual charge codes.

**Fields:**

*Primary Sort:* This option is defaulted for you. This report can only be printed by route.

*Route Date:* The range of dates to include in the report.

*Route:* The range of routes to include in the report.

*Include Detail:* This option will include more details in the printed report.

*Include Off Route:* Check this box to include off-route customers in the selection process, in addition to the regular customers.
Last Five Deliveries

This report allows you to print a list of products that were sold on route during the last five deliveries. This can be useful in plant production planning, route truck balancing, and other management needs.

Fields:

Primary Sort: You can choose from the following categories:

- Sequence
- Date
- City

Account Number: The range of account numbers to include in the report.

Route: The range of routes to include in the report.

Date Range: The range of dates to include in the report.

Include Off Route Customers: To include off-route customer sales in the report, check this box. If you only want to include regular delivery customers, leave this box blank.
Customer Purchases Report

This report shows all of the products purchased by customers according to the criteria entered. It can be helpful in evaluating customer product requirements in planning for route deliveries.

Fields:

Primary and Secondary Sort: The primary and secondary fields to sort by. You can choose from the following categories:

- By Acct #
- By ZIP Code
- By Route
- Charge Code

Acct Number: Enter the range of account numbers to include in the report.

ZIP Code: Enter the range of ZIP codes to include in the report.

Route: Enter the routes to be included in the report.

Date: Enter the range of dates to be included in the report.

Products: A list of products that have been entered under List > Product Codes > Product Charge Codes.

Click this button to move the selected product from the list of Available Products to Selected Products.

Click this button to move all of the products in Available Products to Selected Products.

Click this button to move the selected product from Selected Products to Available Products.
Click this button to move all of the products in *Selected Products* to *Available Products*.

**Selected Products:** This list shows which products you are including on the report.

**Exclude Inactive Customers:** Check this box to ignore customers that are marked as inactive.

**Include Zero Quantity:** Check this box to include customers with zero quantity purchased on the report.

**Customers without Delivery / Unscheduled Customers**

This report prints a listing of customers who are without deliveries or unscheduled deliveries for the period of this report.

**Fields:**

**Account Number:** The range of accounts to include in the report.

**Route:** The range of routes to include in the report.

**Include Off-Route Customers:** To include off-route customers in this report, check this box.

**Unscheduled Customers:** Check this box to print a listing of customers who are not scheduled for any deliveries (on or after the current module date.)

**Customers without a Delivery:** Check this box to include customers that do not have deliveries scheduled in the report.
Minimum Purchase Offenders Report

This report is helpful for tracking quantities sold to your accounts to learn who may be buying fewer products than expected.

Fields:

Primary and Secondary Sort: The primary field is sorted by Charge Code.

Acct #: The range of accounts to include in the report

Date: The date range for sales to include in the report.

Route: The range of routes to include in the report.

Charge Code: The range of Charge Codes to include in the report.

Quantity: The quantity range of total products purchased by customers.

Customer Type: Select the range of Customer Type Codes to include in the report.

Only Non-terminated Customers: Check this and the report will only show active customers.
Reprint Product Sold Report

This report is used to reprint the Driver’s Product Sold report. It is printed when the driver returns from his route delivery.

Fields:

*Primary Sort:* This option is defaulted for you. This report can only be printed by charge code.

*Route:* The range of routes to include in the report.

*Invoice Date:* The invoice date for running the report.
Customer Delivery Calendar

The calendar function of your RM2000 software allows you to print out delivery schedule calendars for your customers. These reminders can prevent wasted trips on forgotten delivery days.

Fields:

Primary and Secondary Sort: The primary and secondary fields to sort by. You can choose from the following categories:

- Route
- Account Number
- ZIP Code
- Sequence

Account Number: Enter the range of accounts to include.

Route: Enter the range of routes to be included on the report.

Year: Select the current year to print the Customer Delivery calendar. All calendars are printed for one calendar year.

Print Style: Choose one calendar format. You can choose between:

- Mailable Postcard: Laser-shows address
- Standard Postcard: Laser-shows address
- Continuous Feed

NOTE: Mailable Postcards uses Avery 5389 or 8389 laser post cards.
Calendars by Day

This function allows printing out the delivery calendars for a specific delivery day. This is helpful if drivers are delivering the calendars while they are on route.

Fields:

Primary Sort: The primary sorting field. Choose from the following categories:
  - Sequence
  - Account Number
  - Account Name

Route: Select the range of routes for calendar printing.

Date: Input the date for processing and printing the calendars.
Expired Purchase Orders

Using and keeping track of customer purchase orders ensures payment for all invoices. This report should be run on a regular basis. However, make sure you run it before your purchase orders will expire. This will give ample time to get a new purchase order and keep service flowing to customers on an uninterrupted basis.

Fields:

Primary and Secondary Sort: The primary and secondary fields to sort by. You can choose from the following categories:

- Account Number
- Purchase Order Number

Expiration Date: The range of purchase order expiration dates to include in the report.

Customer Type: The range of customer types to include on the report.
Material Pickup Report

Generally used in the shredding industry, the Material Pickup Report provides detail by route and date of the contents picked up at each location. Furthermore, the total weight collected and container levels are reported.

Fields:

**Primary and Secondary Sort:** The primary and secondary fields to sort by. You can choose from the following categories:

- **By Date**
- **By Route**
- **By Contents**

**Route:** The range of routes to include in the report.

**Date:** The date range to include on the report.
Inventory Reports

Listed below are reports that relate to inventory.

Receive Inventory Posting - Reprint

The Inventory Receive Reprint option allows you to reprint past Receive Inventory reports. Simply select a date and click OK.

You will now be asked if you want to print the report. If you click NO, you will see a preview of the report, similar to the one below.

Otherwise, the report will print without any other operator action.
Inventory Status

The Inventory Status report helps you manage your inventory more effectively. At any time, you can choose to print out a list of all or some of your products to determine the inventory you have on hand.

**Fields:**

*Primary Sort:* This option is defaulted for you. This report can only be printed by charge code.

*Charge Code:* The range of charge codes to include in the report.

**NOTE:** All charge codes are included if no range is specified.

*Receive Date:* The range of dates inventory was received to include in the report.

*Only include products below reorder level:* To only print a list of products that need to be ordered, check this box.
Inventory Stock Take Report

This report is designed for taking a physical stock count in the warehouse.

Fields:

*Available Products / Selected Products*: Choose the product(s) to include in the report by choosing the arrow options on the screen.

*As of*: Enter the desired date.

*Show Units Less Than*: Insert a minimum number of items in inventory to be displayed on the report.
Equipment Reports

Listed below are several reports that relate to equipment.

<table>
<thead>
<tr>
<th>Equipment Master List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equipment Type List</td>
</tr>
<tr>
<td>Equipment Style List</td>
</tr>
<tr>
<td>Service Codes List</td>
</tr>
<tr>
<td>Print Service Tickets</td>
</tr>
<tr>
<td>Equipment Service Report</td>
</tr>
<tr>
<td>Equipment by Location</td>
</tr>
<tr>
<td>Equipment Sold</td>
</tr>
<tr>
<td>Customer Equipment List</td>
</tr>
<tr>
<td>Customers Without Equipment</td>
</tr>
</tbody>
</table>

These reports are described in more detail within the following section.
Equipment Master List

Select this program to generate a list of your equipment in the system. There are several selection options that will give you equipment information you need in a useable format.

Fields:

Primary and Secondary Sort: The primary and secondary fields available for sorting. You can choose to sort by:

- Equipment ID
- Equipment Type
- Account Number

Equip. ID: The range of equipment serial numbers to include in the report, from the first to last equipment ID, (up to 16 characters each).

Equip. Type: The range of equipment types to include in the report. You may select a single type or a range.

Account Number: The range of accounts to include in the report.

Short Listing: Select this box to print the report in a single line per unit format.

Include Equipment Not Installed: Select this box to include equipment that is not installed at a customer site.

NOTE: The next three reports are single formats that have no selection criteria.
Equipment Type List

A list of all entered equipment types can be printed using this report option. Choose your output destination to print the list.

Equipment Style List

A list of all entered equipment styles can be printed using this report option. Choose your output destination to print the list.

Service Codes List

A list of all entered service codes can be printed using this report option. Choose your output destination to print the list.
Print Service Tickets

You can print service tickets for drivers that will be servicing equipment. Each ticket includes the type of equipment, location, billing information (such as whether the equipment is still under warranty), past service history, and the employee taking the call. These tickets are provided to the drivers so they can perform the required service on the customer’s equipment.

Fields:

**Primary and Secondary Sort:** The primary and secondary fields to sort by. You can choose from the following categories:

- Date
- Employee ID
- Type

**Request Date:** The range of dates to include in the report.

**Equipment ID:** The range of equipment ID’s to include on the report.

**Employee ID:** The range of employees to include in the report, from the first to the last employee ID number.
Equipment Service Report

The Equipment Service Report is used to track servicing performed on equipment as well as making available a schedule of required servicing to be done by your organization. The report is flexible enough so that you can choose a variety of dates, types of equipment, etc.

Fields:

Primary and Secondary Sort: The primary and secondary fields to sort by. You can choose to sort by:

- Equipment ID
- Type
- Account Number
- Date

Equipment ID: Select the range of equipment ID numbers that you want to include on this report.

Equipment Types: The range of equipment types to include in the report.

Acct No.: Input the range of account numbers to include on the report.

Dates: Enter the date range that this report is to include.

Service Schedules: There are three options that you can choose to select a required report.

- Equipment with Service Schedule
- Equipment in place without Service Schedule
- Both
Equipment by Location

This module will print a report specifying the location for the specified range of equipment. This is useful in locating misplaced equipment as well as knowing what equipment you have available to rent. You may choose any or all of the default locations.

Fields:

Primary and Secondary Sort: The primary fields to sort by are chosen from the following categories:

- Account Number
- Equipment Identification
- Equipment Type
- Equipment Style
- Group Area Code
- Purchase Date

Equipment ID: The range of equipment ID’s to include in the report. Select a single unit or a range.

Group Area: The range of group area codes to include on the report. It will default to all.

ZIP Code: The range of ZIP Codes to include on the report. This allows you to choose a specific area within the entire database.

Location(s): This option allows you to select a range of locations. For example, equipment is located at the warehouse; check the “warehouse” box and the report will only print out the equipment at that location. Choose any one or all of the boxes shown.

Equipment Type: The range of equipment types to include in the report.
**Identify Sold Equipment:** Check this box to identify equipment owned by customers.

**NOTE:** If you want to include in the report anything other than “Installed” equipment, you will not be able to do it by ZIP Code range.

**Equipment Sold**

This report provides a list of units sold. It is useful for property tax assessments, sales tax reporting, and asset tracking issues.

![Equipment Sold Report](image)

**Fields:**

**Primary and Secondary Sort:** The primary and secondary fields to sort by. You can choose from the following categories:

- **Serial Number**
- **Customer**
- **Date**

**Equip. Serial Number:** The range of serial numbers to include in the report. All pieces of equipment are included if no range is specified.

**Date Sold:** The range of dates to include in the report. This is compared with the date sold in the equipment master file.

**Account Number:** The range of accounts to include in the report.
Customer Equipment List

This report prints a list of all equipment that is customer-owned.

**Fields:**

- **Primary and Secondary Sort:** The primary and secondary fields to sort by. Choose to sort by:
  - *Equipment ID*
  - *Equipment Type*
  - *Account Number*

- **Equipment ID:** The range of serial numbers to include in the report.

- **Equipment Type:** Select the types of equipment to include in this report. It will default to all types.

- **Account Number:** The range of customer accounts to include in the report.

- **Include Equipment Not Installed:** Indicate whether to include equipment that has not been installed.
Customers without Equipment

This report will print a listing of all customers who do not have equipment installed on their account. You may print it by a range of start dates so you could select only recent starts, for example.

Fields:

Primary and Secondary Sort: The primary and secondary fields to sort by. Choose from the following categories:

- Date
- Account Number
- Account Name

Account Number: The range of accounts to include in the report.

Start Date: The range of customer start dates to include in the report.

Sales Rep: Filter information by Sales Rep ID if necessary.

Only Non-Terminated Customers: Selecting this option will produce a report to only include customers who do not have an end date on their customer record.
Statements

The statements function allows you to print month-end statements according to specific parameters. There are many options that you can select. For more information, refer to the Statement Codes set up earlier in this manual.

Fields:

Primary Sort: Select one of the following sort options:
- ZIP Code
- Account Number
- Account Name

Account Number: The range of account numbers to include in the report, up to six characters each.

ZIP Code: The range of ZIP Codes to include in the report.

Statement Type: The type of statement to include in the report. Select the ID from the drop-down list and the corresponding description will automatically appear to the right of it. (Statement codes were originally set up under the Lists menu under Statement Codes). For example, if your statement type is bulk statement, then the statements are printed to a file and only a summary sheet is printed on your printer.

Date Range: Select the range of dates for statement printing.

Dates: The statement closing date is the date of the last transaction included on the statement. The due date is printed on your statement indicating when the payment is due at your office.
Include: Choose the columns to include on your report. However, you can narrow the list by selecting: Current, 30, 60, 90, or 120 or more days overdue.

NOTE: Not all of the following options are available with every statement type. They will only be accessible if they correspond to the Statement Type selected.

Include Payment Voucher: Select this option to print a payment voucher at the bottom of a normal 8½” x 11” statement.
Top/Bottom: Select the desired placement of the Payment Voucher on the statement.
Include Invoices: Select this option to have invoices included with the statements.

NOTE: By selecting Include Invoices, you will not have the ability to export your statements.

Rental Invoices Only: Select this box to only print the rental invoices with the statement.
Pre-Printed Form: Select here to print only the data, and not the heading on a pre-printed form.
Open Item Statement: Selecting this option will only print statements that still have balances.
Suppress Aging: Selecting this option will prevent the customer’s aging from printing on the statement.
Include Stop Information: Select this option if you wish to have the customers stop information printed on the statement.
Include Bottle Counts: Check this option to include the customer’s bottle counts on the statement.
Exclude Postal Bar Code: Selecting this option will remove the bar code from the statement.
Detail side first: Use this option to print the detail side of a postcard before the address side. This is used for two-sided postcards.
8 ½ X 11 Invoice Format: Select this option if you wish the invoices to be printed in 8 ½ X 11 format.
Include No Charge Items: Select this option if you wish to have No Charge items included in the statements.
Don’t Include Invoice Details: Select this option if you do not wish to have the invoice details printed on the statements.
Dunning Notices

There are always a few customers who either forget about, or neglect, their payments. This feature will print out a reminder notice for these customers.

Fields:

Primary Sort: Select one of the following sort options:
- ZIP Code
- Account Number
- Account Name

Account Number: Range of account numbers to be included on the report.

Due Date: The due date for payment of the Dunning Notice.

Available Credit Classes: Credit Classes that you have available in your system. You may select to print Dunning Letters for a single Credit Class or you may select as many as you need.

Selected Credit Classes: Credit Classes that you have selected to print Dunning Letters for.
Click this button to move the selected Credit Class from Available Fields to Selected Fields.

Click this button to move all Credit Classes from Available Fields to Selected Fields.

Click this button to move the selected Credit Class from Selected Fields to Available Fields.

Click this button to move all available Credit Class options from ‘Selected Fields’ to ‘Available Fields’.

**NOTE:** When the dunning letters are printed, the system will automatically generate a contact message. If *Preview* is selected you must close the preview screen before printing. If the letter is printed while in preview mode, the contact information will not be updated.

**Export Data:** Selecting this option will create a comma delimitated file with customer’s financial information.

**NOTE:** The file is labeled dnaccounts.csv, and it will be located in the *Letters* folder under X:\Dunning\ where X is the full path to your RM2000 folder.
List Reports

List reports are generally simple lists that correspond to the screens shown on the lists tab. Below is a listing of the reports in this submenu.

<table>
<thead>
<tr>
<th>Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer List</td>
</tr>
<tr>
<td>Customer Setup Codes List</td>
</tr>
<tr>
<td>Product Codes</td>
</tr>
<tr>
<td>Sales Tax Rates Report</td>
</tr>
<tr>
<td>General Ledger Account Usage</td>
</tr>
<tr>
<td>Group Area Codes Report</td>
</tr>
<tr>
<td>Truck Report</td>
</tr>
<tr>
<td>Employee Report</td>
</tr>
<tr>
<td>Security Level Codes List</td>
</tr>
<tr>
<td>Commission Class Report</td>
</tr>
<tr>
<td>Company Report</td>
</tr>
</tbody>
</table>

These reports relate directly to the List tab. Some can also be printed from within their respective programs by clicking on the image of the printer on the toolbar.
Customer List

At times, it may be helpful to view the information for a single customer or a range of customers. Use a Customer Report to see such information. You may sort or group the customers by the parameters shown.

Fields:

Primary and Secondary Sort: The primary and secondary fields to sort by. Sort by the following categories:

- Date (customer started service)
- Account Number
- Account Name
- Customer Type
- By Sales Rep

Account Number: Range of account numbers included on the report.

Start Date: The range of start service dates to include in the report.

Customer Type: The range of customer types to include on this report.

Sales Rep: The range of sales Rep ID’s you need to include on this report.

Only Non-Terminated Customers: This option will only include customers who do not have an end date on their record.

Short Listing: Check this box to obtain the consolidated, one-customer-per-line format. It will leave out some of the detail, but is handy if you simply want a customer list.
Customer Setup Codes List

This section contains many Customer Setup Codes reports that relate to customer information. The picture below shows the items in this section.

<table>
<thead>
<tr>
<th>Credit Class List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Finance Charge Codes List</td>
</tr>
<tr>
<td>Administrative Charge Codes List</td>
</tr>
<tr>
<td>Statement Codes List</td>
</tr>
<tr>
<td>Start/Stop Reasons List</td>
</tr>
<tr>
<td>Suspend Service Codes</td>
</tr>
<tr>
<td>Contact Reasons</td>
</tr>
<tr>
<td>Customer Type Codes</td>
</tr>
<tr>
<td>ZIP Codes List</td>
</tr>
<tr>
<td>Telephone Reasons List</td>
</tr>
</tbody>
</table>

Credit Class List

A report of all credit class codes can be printed using this report option. Choose your output destination to print the list.

Finance Charge Codes List

A list of all finance charge codes can be printed using this report option. Choose your output destination to print the list.
Administrative Charge Codes List

This report will print the administrative charges listing.

**Fields:**

*Primary & Secondary Sort:* Sort the report by ID or Description.

*Administrative Charge ID:* Select the range of administrative codes to include on this report.

Statement Codes List

A list of all statement codes can be printed using this report option. Choose your output destination to print the list.

Start/Stop Reasons List

A listing of all Start/Stop Reasons in the system can be printed using this option.
Suspend Service Codes List

With this program, you can list all of the Suspend Service Reasons.

![Suspend Service Codes List](image)

### Fields:

**Primary Sort and Secondary Sort:** The primary and secondary fields to sort by. You can choose from the following categories:

- **ID**
- **Description**

**Suspend Services Codes:** Select the range of suspend service codes to include on this report.
Contact Reasons List

This report will generate a list of all customer contact reasons.

Fields:

*Primary Sort and Secondary Sort:* The primary and secondary fields to sort by. You can choose from the following categories:

- **ID**
- **Description**

*Reasons:* Select the range of contact reasons to include on this report.
Customer Type Codes List

The *Customer Type Codes List* report displays the defaults selected for the range of customer types selected.

**Fields:**

*Primary Sort:* This option is defaulted for you. This report can only be printed by Customer Type.

*Customer Type Codes:* Select the range of customer type codes to include on this report.
ZIP Codes List

A list of all ZIP Codes in your system can be printed using this report option.

**Fields:**

*Primary and Secondary Sort:* The primary and secondary fields to sort by. You can choose from the following categories:

- **ZIP Code**
- **City**
- **Date (Last Updated)**

*Last Updated:* The range of dates used for updating the ZIP Codes list file.

*ZIP Code:* The range of ZIP Codes to include in the report.

*Short Listing:* Checking this box will print the ZIP Codes in a three-column format.
Telephone Reasons List

The Telephone Reasons List report will generate a list of the selected range of telephone reasons.

Fields:

Primary and Secondary Sort: The primary and secondary fields to sort by. You can choose from the following categories:

- **ID**
- **Description**

Reasons: Select the range of telephone reasons to include on this report.
Product Codes

This section contains many Product Codes reports that relate to information that you have entered into the system. The image below shows the items in this section.

<table>
<thead>
<tr>
<th>Product Charge Codes List</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Class List</td>
</tr>
<tr>
<td>Product Price List</td>
</tr>
<tr>
<td>Gratis Reasons List</td>
</tr>
</tbody>
</table>

These topics are described in the pages that follow.

Product Charge Codes List

The Product Charge Codes report gives you a listing of the product codes that you have entered into the system. You may limit the report to a charge code range, or a general ledger account number range.

Fields:

Primary Sort: The primary field to sort by. You can choose from the following categories:

- Charge Code
- Date(G/L Posting Date)
- Description

Charge Code: The range of charge codes to include in the report.

G/L number: The range of G/L number codes, for products sold, to include in the report. Specify from first to last (lowest to highest).

List All Price Levels: Check this box to include all price levels in the report. This will take more space to print.
Product Class List
The Product Class report will allow you to print a listing of all the product classes that you have entered into the system.

Product Price List
This report prints out a list of product price lists that have been entered into the system.

**Fields:**

*Primary Sort:* This option is defaulted for you. This report can only be printed by price list.

*Price List:* Select the range of price lists to include on the report. You may print one or all price lists.
Gratis Reasons List

This report will print out a list of all Gratis Reasons in the system.

Fields:

Primary Sort and Secondary Sort Description: The primary and secondary fields to sort by. You can choose from the following categories:

- ID
- Description

Gratis Reasons: Select the range of Gratis Reasons to include on this report.
Sales Tax Rates Report

This report will print a list of all the sales tax rates that you have entered into the system.

General Ledger Account Usage

This report allows you to print a listing of all general ledger numbers entered in the RM2000™ system.

**Fields:**

*Primary Sort:* This option is defaulted for you. This report can only be printed by general ledger number order.

*General Ledger Number:* The range of G/L numbers to include in the report.

Group Area Codes List

The *Group Area Codes* report allows you to print out a list of all the group area codes that have been entered into the system.
Truck List
A list of all entered trucks can be printed using this report option. Choose your output destination to print the list.

Employee Report
For reference, you may want a list of all employees that are on file in the computer. You have several options as you decide which employee names to print.

Fields:
Primary and Secondary Sort: The primary and secondary fields to sort by. You can sort from the following categories:

- Employee ID
- Hire Date
- Social Security Number

Date Hired: The range of hire dates to include in the report. You may choose only new employees.

ID Number: The range of employee ID numbers to include.

SSN: The range of Social Security numbers to include in the report.

Type: A range of employee types to include on the report.
Security Levels List

This option prints a report of the security levels within the system.

NOTE: Only the employee marked as “Master User” in the employee list can access and modify this report.

Fields:

Primary Sort: This option is defaulted for you. This report can only be printed by security level.

Security Level: The security level range to include on the report(s).

Commission Class List

The Commission Class report prints a list of all the commission class codes that you have entered into the system.
Company Report

To obtain a printout of your company’s set-up information, select this item. It will prompt you for the destination of the report.

Graphs

Use this utility to view graphs of four different data items:

- Aging Analysis
- Sales History (YTD)
- Revenue - Routes By Date
- Revenue – Dates By Route

Simply choose the graph and style that you would like and click OK.

**Fields:**

**Graph Data:** Select the data that is to be viewed as graph.

**Graph Type:** Select the type of graph to generate. Choose from these options:

- Line
- Vertical Bar
- 3D Vertical Bar
- Horizontal Bar
- 3D Horizontal Bar
- Pie
- 3D Pie
Custom Reports Menu

RM2000 supports a variety of custom reporting tools (e.g., Crystal Reports) to allow more flexibility for reporting purposes. Once these reports are created, the Custom Reports option gives you the ability to integrate these types of reports into the RM2000 Reports menu. This may be helpful for users that would benefit from having certain external reports accessible from within the RM2000 program (links to programs can be added as well).

Adding a Custom Report:

2. Choose Add.
3. Create a Menu Title.
4. Select a Shortcut Character.
5. Enter or Browse for the folder that contains your custom report(s), program(s), etc.
6. Add the Security Level Code(s) required for viewing the Custom Report(s).
7. Click Save.

Repeat these steps for each Custom Report Group that you will need. Continue to the next section to learn how to control the items that are displayed within each group.
Establishing Links:

You will need to create shortcuts to the reports, programs, etc., that you wish to add to the menu. You can achieve this by placing .lnk (shortcut) files within each Report Group Folder(s).

The Report Group below will be used for links to the “Crystal Reports” group.

1. All shortcut (.lnk) files placed in the Report Folder Location will be displayed under Reports > Custom Reports > Crystal Reports on the menu.

2. Here is a list of shortcut (.lnk) files placed within the “D:\RM2000\DOC_Data” directory:

   - Crystal Reports 10.lnk
   - Sales Report.lnk
   - Billing Report.lnk

3. We have included a link to the Crystal Reports program (Crystal Reports 10.lnk), and two custom reports (Sales Report.lnk and Billing Report.lnk).

4. Within the program, the links will be displayed under Reports > Custom Reports > Crystal Reports:

5. Repeat these steps for all of the folders and shortcuts needed.
Chapter 9 – Route Options

Overview

The Route pad is primarily used for items related to handheld processing.

<table>
<thead>
<tr>
<th>Morning Cards</th>
</tr>
</thead>
<tbody>
<tr>
<td>Afternoon</td>
</tr>
<tr>
<td>Load Data Card</td>
</tr>
<tr>
<td>Pre-Route Reports</td>
</tr>
<tr>
<td>Print Route Tickets</td>
</tr>
<tr>
<td>Print Load Sheet</td>
</tr>
<tr>
<td>Route Pre-Sale</td>
</tr>
<tr>
<td>Post Route Invoice Input</td>
</tr>
<tr>
<td>Card Override</td>
</tr>
<tr>
<td>Prepare Data Card</td>
</tr>
<tr>
<td><strong>Utilities</strong></td>
</tr>
<tr>
<td>Route Dispatch Manager (RDM)</td>
</tr>
</tbody>
</table>
Daily Handheld Processing

This section covers a majority of the options available when transferring route data to and from the handhelds each day.

Morning Cards

This option allows you to transfer route data to a storage card.

Fields:

Route: Lists all of the routes available for download.
Initials: Displays the initials of the driver assigned to each route.
Employee Name: Displays the driver’s name assigned to each route.
Status: Designates the status of the route, whether it has been downloaded (out) or uploaded (in).
Process Route For: Enter the date of the route to be downloaded.
All Routes: Select this option to create copies of each route on the network. These ‘loaded’ routes can be downloaded using the Load Data Card process discussed later.
Don’t Copy Route to Card: Select this option to create a copy of the current route on the network. This ‘loaded’ route can be downloaded using the Load Data Card process discussed later.
Afternoon

This option allows you to retrieve route data from a storage card and upload it to RM2000.

Simply follow the instructions on the screen to upload the data. Once the data has been uploaded successfully, a confirmation message will be displayed.
Load Data Card

Routes displayed in this screen have been previously ‘loaded’ by using the *All Routes* or *Don’t Copy Route to Card* options within the *Morning Card* screen. Simply insert a card, highlight a route, and click ‘OK’ to send the data to the storage card.

<table>
<thead>
<tr>
<th>Route</th>
<th>Initials</th>
<th>Employee Name</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>CD</td>
<td>Coffee Driver</td>
<td>08/1 5/2006</td>
</tr>
<tr>
<td>W</td>
<td>WD</td>
<td>Water Driver</td>
<td>08/1 5/2006</td>
</tr>
<tr>
<td>W2</td>
<td>MB</td>
<td>Mark Roland</td>
<td>08/1 5/2006</td>
</tr>
</tbody>
</table>

**Fields:**

*Route:* Lists all of the routes available for download.

*Initials:* Displays the initials of the driver assigned to each route.

*Employee Name:* Displays the driver’s name assigned to each route.

*Date:* Displays the date of the prepared route.
Pre-Route Reports

The *Pre-Route Report* includes all route data that will be displayed on the handheld for each route and date entered. This report can be used to identify past due accounts, or used by the driver if the handheld breaks or is lost, and much more.

**Fields:**

**Primary Sort:** Choose one of the following sort options:
- *Sequence*
- *Account Number*
- *Account Name*

**Date:** Enter the date range that you would like to include in the report. Each route will be printed separately.

**All Day Labels:** Choose this option if you would like to see all of the customers assigned to the specified route, regardless of delivery date.

**Route:** Enter the range of routes to include in the report. A separate report will be printed for each route.

**Blank Lines:** Enter the number of blank lines to include between each stop on the report (for writing notes).

**Include Messages:** Select each type of route message to include in the report.
- *Alert*
- *One Time*
- *Driver Instructions*
- *Site Instructions*

**Display Bottle(s) on Hand:** Select this option to include the number of container deposit on hand for each customer in the report.
**Wrap Address to Second Line:** Select this option to wrap each customer’s address to the second address line if it is too long to fit on the first line.

**Short Listing:** Select this option to suppress a majority of the detail on the report and only use one line per stop.

**Include Route Sheet:** Check this box to include Route Sheets with each report. Route Sheets can be used when running a route without a handheld.

**Include Load Sheet:** Checking this box will include a Load Sheet with each report that can be used when loading the delivery vehicle.

**# of Copies:** Specify the number of Load Sheet copies to include (if applicable).

**Include Phone Number:** Check this box if you would like to include customer phone numbers in the report.

**Include Equipment Serial No. and Type:** Check this box if you want to include installed equipment serial numbers and types per customer in the report.

**Show All Products:** Check this box to include all product information per customer (i.e., Default Products, Pending Orders).

**Show Product Descriptions Instead of Codes:** Check this box to replace any product ID’s displayed on the report with descriptions.
Print Route Tickets

This program allows you to print route tickets on standard paper. This is helpful when you are not using handhelds.

Fields:

Process Tickets For: Enter the date of the route you would like to print tickets for.

Route / To: Enter the range of routes to print. Tickets for each route will be printed separately.

Copies: Select the number of copies of each ticket to print.

Customer: To print only one route ticket for a specific customer, enter the account number here.

Include Quantity on Tickets: Select this option to include quantities next to items included on each ticket. Alternatively, a blank space is included next to each item when this option is not selected.

Only Print Required Tickets: Select this option to only print tickets for customers that have a value greater than ‘0’ entered within Invoice Copies found under Lists > Customer Information > Route > Handheld Options — a Pending Order on the account will override this setting.
**Blanks:**

Select an option that will control the number of blank route tickets that will print with each route. The driver can fill in customer account info manually.

**None:** Select this option to prevent printing any blank route tickets along with your route tickets.

**Default:** Select this option to include blank route tickets based on the Invoice Quantity field for this route, found under Lists > Handheld > Driver Setup. The number of blanks printed will depend on how many stops are scheduled on route.

**Custom:** Select this option to manually input the number of blank route tickets to print for each route.

**Blanks Only:** Select this option to print blank route tickets only. The number of blanks printed is determined by the Invoice Quantity field for this route, found under Lists > Handheld > Driver Setup.

**Invoices Per page:** Enter the number of route tickets that you would like to print on a single page (up to 4).
Print Load Sheet

Individual Load Sheets can be printed and distributed that contain the minimum or suggested product requirements for each route.

**NOTE:** Load Sheet quantities are based on Default Product and Pending Order totals entered per customer.

### Fields:

- **Route**: Enter the range of routes to include when printing Load Sheets. Each route will be printed separately.
- **Date**: Enter the date of the Load Sheet(s) to print.
- **Number of copies**: Enter the number of Load Sheet copies to print per route.
Route Pre-Sale

This option allows you to pre-call your customers prior to their delivery day. You have the ability to modify pending orders, cancel deliveries, and enter notes all from the same screen.

**Route and Date Parameters:**

The route and date parameters screen appears first. It allows you to enter the route and date information that you would like to load on the pre-call screen.

**Fields:**

- **Route:** The route and customer list you would like to use for your pre-sale calls.
- **Date:** The date of each scheduled route to pre-call.
- **Customer Type:** Select the range of Customer Types to include in the pre-call list.
- **Do you wish to clear product quantities:** Select this option to ignore any standing order quantities and revert each quantity to zero on the pre-call screen.
**Pre-Sale Screen:**

After you click the ‘OK’ button, the Pre-Sale screen will appear. On the left side of this screen is a list of all the customers that are on the selected route for the date chosen.

Simply click on each account to begin pre-calling and edit the information on the right of the screen. Each option is defined below.

**Fields (Left Side):**

- **Sequence Number:** Displays the customer’s assigned route sequence number.
- **Customer Name:** Displays the customer’s name.
- **Asterisk:** An asterisk symbol will appear next to the name after the account has been edited (or pre-called).

**Fields (Right Side):**

- **Customer Name:** Displays the name of the customer currently selected.
- **Account Number:** Displays the account number of the customer currently selected.
- **Delivery Date:** Displays the delivery date of the customer currently selected.
- **Billing Phone Number:** Displays the billing phone number of the customer currently selected.
- **Contact:** Displays the primary contact on the account.
- **Account Bal.:** Displays the customer’s current balance.
- **Past Due Amt.:** Displays the customer’s past due balance.
**Delivery. Phone Number:** Displays the customer’s delivery phone number.

**Delivery Address:** Displays the customer’s delivery address.

**Skip Delivery:** Select this box to skip the customer’s delivery.

**Alert Message:** Displays the alert message assigned to the account, if applicable. You may edit the existing message or add a new one.

**One Time Message:** Enter a one-time handheld message and *Start/End* date to control the duration of the message.

**Current Default Products:**

**Code:** The code of the selected product.

**Description:** The default product’s description.

**Price:** The price of the selected product.

**Qty.:** The quantity of the selected product.

**NOTE:** Use these buttons to make changes to any customer’s standing order.

**Find:** Allows you to view the customer’s last five delivery totals.

**Add:** Select this option to add a product to the list.

**Modify:** Select this option to edit any item on the list.

**Delete:** Select this option to remove any item from the list.

**OK:** Select this option to accept any changes and select another customer.

**Cancel:** Select this option to cancel any changes and select another customer.

**Exit:** Select this option to exit the *Route Pre-Sale* screen.
**Post Route Invoice Input**

The *Post Route Invoice Input* screen allows you to quickly input transactions into the system by loading customers based on their assigned route and delivery date. This is especially helpful for inputting route tickets.

**Fields:**

*Route:* Select the route from the drop-down list.

*Date:* Select the date of the route you want to input.
Input Screen:

Click the ‘OK’ button and the route listing will be displayed. Simply click on each stop to enter transaction information.

<table>
<thead>
<tr>
<th>Seq#</th>
<th>Name</th>
<th>Invoiced</th>
</tr>
</thead>
<tbody>
<tr>
<td>****</td>
<td>Java Center</td>
<td></td>
</tr>
<tr>
<td>0020</td>
<td>Dutra Gym</td>
<td></td>
</tr>
<tr>
<td>0030</td>
<td>Don Murray</td>
<td></td>
</tr>
<tr>
<td>0030</td>
<td>Internet Cafe</td>
<td></td>
</tr>
<tr>
<td>0050</td>
<td>Albert Nevarez</td>
<td></td>
</tr>
<tr>
<td>0060</td>
<td>Starbucks</td>
<td></td>
</tr>
<tr>
<td>0060</td>
<td>Modesto Chamber of Commerce</td>
<td></td>
</tr>
<tr>
<td>0070</td>
<td>Doubletree Hotel</td>
<td></td>
</tr>
<tr>
<td>0080</td>
<td>Eli Tenenbaum</td>
<td></td>
</tr>
<tr>
<td>0080</td>
<td>Albert Nevarez</td>
<td></td>
</tr>
</tbody>
</table>

Sequence Number: Displays the sequence number of the stop.

Name: Displays the name of the customer.

Invoiced: This field will be updated with a ‘T’ after you have invoiced each customer.
Card Override

The Card Override feature allows you to override existing data on the card to prepare it for new Morning Card data. For example, after your route drivers have created transactions on a card, RM2000 will automatically prevent you from being able to override the data unless you have performed an Afternoon Card or Card Override function. This will prevent you from accidently erasing transactions prior to upload.

![Card Override Interface](image)

Furthermore, the Card Override function is designed to allow you to override data that you know you do not wish to upload.

**NOTE:** Generally you will use a combination of the Morning/Afternoon functions to process your route cards. Card Override should not be a part of your standard daily routine.

Prepare Data Card

The Prepare Data Card function is used to place the RM2000 handheld program on a new or existing storage card. Typically, this function should be performed once per card.

![Prepare Data Card Interface](image)

Select the device type you are using from the list and choose ‘OK’. Follow the on screen prompts to complete the process.
Utilities

The *Utilities* menu provides you with a variety of tools to correct route data.

<table>
<thead>
<tr>
<th>Utilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Route Date</td>
</tr>
<tr>
<td>Delete Route</td>
</tr>
<tr>
<td>Route Resequence</td>
</tr>
<tr>
<td>Modify Route</td>
</tr>
<tr>
<td>Global Route Changes</td>
</tr>
<tr>
<td>Load Sheet Entry</td>
</tr>
<tr>
<td>Modify Telephone Order</td>
</tr>
<tr>
<td>Sequence</td>
</tr>
</tbody>
</table>

Each of these topics is described in greater detail within this section.
Change Route Date

The *Change Route Date* function can be used to globally adjust the date assigned to each transaction on uploaded routes. This is helpful if a route was run using the wrong date on the handheld.

**NOTE:** Posted transaction dates will not be displayed and cannot be modified.

**Fields:**
- **Route**: Displays the route assigned to the transactions.
- **Route Date**: Displays the date that was assigned to the route during the *Morning Card* process.
- **Transaction Date**: Displays the date assigned to all of the transactions.
- **New Transaction Date**: Enter the new date that you would like to globally assign to each transaction.
Delete Route

The Delete Route utility allows you to delete any unposted routes from the desktop. This can be helpful if there was a problem uploading a card, or you did not receive all of the reports during upload.

**Fields:**

*Route/Date:* Displays the unposted *Route/Date.*

**WARNING!** It is imperative that you choose the correct route to be deleted. Once the information has been deleted, it cannot be retrieved.
Route Resequence

The Route Resequence utility allows you to sequence all customers for the route and date entered.

![Route Resequence Utility](image)

**Fields:**

**Account Number:** This option allows you to manually add a customer to the route and date by entering their account number.

**Detail Lines:**

- **Move:** Click on the box to the left of each account and drag the stop to the desired location on route. Each sequence number will be updated automatically.

- **Acct #:** This field displays each customer’s account number.

- **Customer Name:** This field displays each customer’s name.

- **Seq.:** This field displays each customer’s sequence number.

- **Stop:** This field displays the stop number of each account.
Route Date: Enter the date of the route that you would like to resequence.

Route: Enter the route that you would like to resequence.

Load Data: Select this option to load the route data after you have entered the desired route and date.

Save: Select this option to save all changes made to the current route and date.

Cancel: Select this option to cancel all unsaved changes and exit the screen.

Modify Route

The Modify Route option allows you to change groups of customers from one route to another, update delivery dates, add customers to a route, and more.

NOTE: While Modify Route makes it easy to make global route changes in RM2000, it is recommended that you create a backup of your data prior to using this option.
**Fields:**

*Account Number:* This option allows you to manually add a customer to the current route and date by entering their account number.

**Detail Lines:**

*Account Number:* Displays the customer’s account number.

*Name:* Displays the customer’s name.

*Sequence Number:* Displays the customer’s sequence number.

*Stop:* This field displays the customer’s stop number.

*New Day:* Displays the new Day Label assigned to the account based on modifications made within the current screen.

*Old Day:* Displays the old Day Label assigned to the account when the data was loaded on the current screen.

**Other:**

*Don’t Change Day:* Check this box to prevent the system from updating the customer’s delivery date — based on criteria entered on the current screen.

*Don’t Resequence:* Check this box to ignore any new sequence numbers assigned on the current screen.

*Don’t Change Route:* Check this box to ignore any route changes assigned on the current screen.

*Route Date:* Enter the route date you would like to modify.

*Route:* Enter the route that you would like to modify.

*Day:* Enter the day label that you would like to modify, or choose ‘All’.

*Load Data:* Select this option to load the route data after you have entered the desired route and date.

*Save:* Select this option to save all changes made to the current route and date.

*Cancel:* Select this option to cancel all unsaved changes and exit the screen.

**NOTE:** Double-clicking on any account listed will remove them from the screen and exclude them from any changes made.
Global Route Changes

This option allows you to easily change the route and delivery day for a complete or partial route.

![Global Route Changes](image)

**Fields:**

- **Old Route:** Select the old route that you would like to update.
- **New Route:** Select the new route that you would like to assign the customers to.
- **Entire Route:** Select this option if you would like to move all customers from the old route to the new route.
- **Partial Route:** Select this option if you would like to move customers based on *Day Label* or *Sequence Numbers*.

**NOTE:** The following options only available if you have selected *Partial Route*.

- **Old Day:** Select the old *Day Label Code* that you would like to update.
- **New Day:** Select the new Day Label Code that you would like to assign the customers to.

**Sequence Number:**

- **From/To:** Enter the first sequence number range to include in the route update.
- **All:** Select this option to include all sequence numbers in the route update.
Load Sheet Entry

This option allows you to edit previously uploaded Load Sheet entries that are attached to un-posted handheld transactions. Choose the route and day to edit and select ‘OK’.

The Load Sheet Entry screen will be displayed for editing.

Fields:

Route: Displays the route being edited.

Date: Displays the route date being edited.

Driver Name: Displays the driver’s name assigned to the route.

Employee: Displays the driver’s initials.
**Detail Lines:**

*Charge Code:* Displays the charge code of the product that was loaded onto the truck.

*Description:* Displays the description of the product.

*Quantity Out:* Displays the quantity loaded onto the truck.

*Quantity In:* Displays the quantity returned to the truck.

*Difference:* Displays the difference between Quantity Out and Quantity In.

*Sold:* Displays the quantities sold on the route. The data is gathered from un-posted transactions.

**Other:**

- **Add:** Select this option to add a product to the load sheet.
- **Delete:** Select this option to delete an item from the load sheet.
- **Modify:** Select this option to edit an existing item on the load sheet.
- **Print:** Select this option to preview or print an updated Load Sheet for the current route.
- **Save:** Select this option to save all of the Load Sheet changes.
- **Cancel:** Select this option to cancel any unsaved changes made and exit the screen.
Modify Telephone Order Sequence

The Modify Telephone Order Sequence feature allows route supervisors to access and modify all open Telephone Orders. Each order can be re-routed using this screen.

NOTE: Telephone Orders that are not assigned to a route will not be available within this screen.

Fields:

Route: Select the route that the Telephone Orders are assigned to.

Date: Enter the date assigned to the Telephone Orders.

Group Area: Select the assigned Group Area Codes that you would like to include in the list.

Include Customers with No Group Area: Choose this option to load customers without a Group Area Code assigned.

Process Criteria: Select this option to generate the list of Telephone Orders found.

Pending Orders: Select this option after clicking on an order in the list to modify any associated Pending Orders.

New Route: Select this option after clicking on an order to assign it to a new route.

New Seq: Select this option after clicking on an order to assign it a new sequence number.

Change Promised Date: Select this option after clicking on an order to change the promised delivery date.

SAVE: Select this button to save your changes.

Cancel: Select this button to cancel any unsaved changes.

EXIT: Select this button to exit the screen.
Route Dispatch Manager (RDM)

The Route Dispatch Manager is a unique routing tool that simplifies your daily route management routines. Contact ARS for further information.
Intentionally left blank.
Chapter 10 – Tools

Overview

The Tools menu contains helpful Global Changes and administrative functions that can be used in RM2000, as well as optional module settings.

<table>
<thead>
<tr>
<th>Update Software via Web Site</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>EC2000 Web Update</td>
<td></td>
</tr>
<tr>
<td>EF2000</td>
<td></td>
</tr>
<tr>
<td>Automated Attendant</td>
<td></td>
</tr>
<tr>
<td>Check for New Messages</td>
<td></td>
</tr>
<tr>
<td>Global Changes</td>
<td></td>
</tr>
<tr>
<td>Administration</td>
<td></td>
</tr>
<tr>
<td>Undo</td>
<td>CTRL+Z</td>
</tr>
<tr>
<td>Cut</td>
<td>CTRL+X</td>
</tr>
<tr>
<td>Copy</td>
<td>CTRL+C</td>
</tr>
<tr>
<td>Paste</td>
<td>CTRL+V</td>
</tr>
<tr>
<td>Find</td>
<td>CTRL+F</td>
</tr>
<tr>
<td>Find Again</td>
<td>F3</td>
</tr>
<tr>
<td>Calculator</td>
<td></td>
</tr>
<tr>
<td>Calendar</td>
<td></td>
</tr>
</tbody>
</table>

These topics are described in further detail below.
### Update Software via Web Site

Choose this option to connect to the [www.ARS247.com](http://www.ARS247.com) Web site to search for the latest version of RM2000.

**NOTE:** Login credentials are required, contact ARS if you have not been provided with a username and password.

### Electronic Commerce 2000 Web Update (Optional Module)

The *EC2000 Module* allows your customers to view their important account information on your website, as well as place orders and other options. Contact Advantage Route Systems for further information.

### Electronic Filing 2000 (Optional Module)

The *EF2000 Module* allows you to scan printed documents and store them in virtual files. Contact Advantage Route Systems for further information.

### Automated Attendant

If you have purchased the *RV2000 Pre-calling Module*, your customers can call the office and leave messages that can be replayed here. Additionally, these messages can be permanently stored on each customer’s *Contacts* tab within *Customer Information*.

**NOTE:** Refer to the *RV2000 User Guide* for further information on this option.

### Check for New Messages

This option will display any open *Contact Messages* created in various screens within RM2000.

**NOTE:** These messages are also displayed when you login to RM2000.
Global Changes

The *Global Changes* option allows you to globally apply changes to several sections of the RM2000 program.

**NOTE:** These options should only be performed by a system administrator.

<table>
<thead>
<tr>
<th>Change Customer Acct. #'s</th>
<th>Change Customer Names</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Equipment ID's</td>
<td>Modify Rent Prices</td>
</tr>
<tr>
<td>Add/Remove Default Products</td>
<td>Modify Prices on Default Products</td>
</tr>
<tr>
<td>Change Default Products</td>
<td>Add/Remove Recurring Charges</td>
</tr>
<tr>
<td>Close Open Telephone Requests</td>
<td>MangoGeo Address Correction</td>
</tr>
</tbody>
</table>

Each item is discussed in further detail below.
Change Customer Account Numbers

This option allows you to change a customer’s account number.

**WARNING:** This option will update all references to the current account number within invoice history, payments, equipment, etc.

**Fields:**

*Old Account Number:* The customer’s old account number.

*New Account Number:* The customer’s new account number.

**NOTE:** You may only change one customer account number at a time with this program.
Change Customer Names

This option allows you to easily edit a customer’s billing and delivery name.

**Fields:**

- **Billing Name:** Displays the customer’s billing name.
  - **Left / Right Arrow:** Click this option to reverse the customer’s name. This option requires a semi-colon between the first and last name to work properly.

- **Delivery Name:** Displays the customer’s delivery name.
  - **Up / Down Arrow:** Click the arrows to copy data from one name field to the other.

- **Back:** Select this option to access the previous customer record.
- **Next:** Select this option to advance to the next record (or hit enter on your keyboard).
- **Go to Account#:** Enter an account number here and hit enter to jump the account.
- **EXIT:** Select this option to exit the screen.
Change Equipment ID’s

This option allows you to change the equipment ID (serial number) assigned to a piece of equipment.

**Fields:**

**Old Equipment No.:** Enter the current equipment number.

**New Equipment No.:** Enter the new equipment number.
Modify Rent Prices

The *Modify Rent* Prices option allows you to globally update rent prices based on several criteria options.

**Serial No. Range:**
*From and To:* Select the range of serial numbers to include.

**Equipment Type Range:**
*From and To:* Select the types of equipment to include.

**Charge Code Range:**
*From and To:* Select the range of rental charge codes to include (*Class 4* items).

**Rental Frequency Range:**
*From and To:* Select the rental frequency codes to include.

**Acct No. Range:**
*From and To:* Select the range of customer accounts to include.

**Customer Type Range:**
*From and To:* Select the range of customer types to include.

**Other:**
*Type:* Select the desired price modifier to use:

- $: This option will increase or reduce the rental price by the dollar amount entered in the *Modifier* field.
- %: This option will increase or reduce the rental price based on the percentage entered in the *Modifier* field (i.e., 25% is entered as 25.00).
**Modifier:** Enter the dollar amount or percentage to use as the price modifier.

**Modify for original prices between:**
- **From and To:** Select the minimum and maximum rental price to include when modifying rent prices.
- **Don’t Exceed:** The highest value that the rent price will be.
- **Round:** Rounds the new price to the value indicated.

**Add/Remove Default Products**
This option allows you to globally add or remove default products within the Products tab of Customer Information. Simply choose the ‘Add’ key and refer to the field definitions below to use this feature.

![Add/Remove Default Products](image)

**Detail Lines:**
- **Charge Code:** Displays the product code that is being added/removed.
- **Description:** Displays the description of the product that is being added/removed.
- **Quantity:** Displays the default quantity of the product that is being added/removed.

**NOTE:** The quantity must match in order for the product to be removed.
Fields:

Acct. Range: Enter the range of accounts to include in the global change.

Type: Select the appropriate action:
- Add: To add a new default product.
- Remove: To remove a default product.

Update Price List Also: Check this box to add/remove items from Product Price Lists as well.

Modify Prices on Default Products

This option allows you to easily update prices on Default Products assigned to the Products tab of Customer Information. Simply choose the ‘Add’ key and refer to the field definitions below to use this feature.

Detail Lines:

Charge Code: Displays the product code that is being modified.

Description: Displays the product code description that is being modified.

Modifier: Displays the modifier amount that will be used.

Type: Select the modifier method that will be used:
- $: This option will increase or reduce the price based on a dollar amount.
- %: This option will increase or reduce the price based on a percentage (i.e., 25% is entered as 25.00).

Modify Prices Between From To: Displays the minimum and maximum rent prices to include in the global change.

Don’t Exceed: Displays the maximum price that the default price can reach.

Round: Displays the rounding amount that will be used when determining the new price.
**Fields:**

*Acct. Range:* Enter the range of accounts to include in the global change.

*Customer Start Date:* Enter the range of customer Start Dates to include in the global change.

*Customer Type Range:* Enter the range of Customer Type Codes to include in the global change.

**Change Default Products**

This option allows you to globally replace an existing Default Product with a new Default Product on the Products tab of Customer Information. Simply choose the ‘Add’ key and refer to the field definitions below to use this feature.

**Detail Lines:**

*Old Charge Code:* Displays the product code that is being replaced.

*New Charge Code:* Displays the new product code.

*Quantity:* Displays one of the following options:

- *Keep Quantity:* Leaves the quantity the same as the previous charge code.
- *Change Quantity to Zero:* Will set the new quantity to zero.

*Prices:* Displays one of the following options:

- *Keep Price:* Leaves the price the same as it was on the previous charge code.
- *Change Price to Default:* Changes the price to the default product price.

**Fields:**

*Account Range:* Select the range of accounts to include in the global change.
Add/Remove Recurring Charges

This option allows you to add/remove Recurring Billing charges on a given customer range. Simply choose the ‘Add’ key and refer to the field definitions below to use this feature.

**Detail Lines:**

*Charge Code:* Displays the recurring product code that is being added/removed.

*Description:* Displays the recurring product code description that is being added/removed.

*Amount:* Displays the recurring charge amount that is being added/removed.

**NOTE:** The recurring charge amount must match the amount entered above in order to be removed.

**Fields:**

*Account Range:* Select the range of accounts to include in the global change.

*Type:* Select the appropriate action:

  - *Add:* To add a new default product.
  - *Remove:* To remove a default product.
Close Open Telephone Requests

This option allows you to globally close open Telephone Orders.

Fields:

Employee Name: Select the employee name that will be closing the Telephone Orders.

Completion Date: Enter the date that will be assigned to all closed Telephone Orders.

Completion Message: Enter a completion message that will be assigned to all closed Telephone Orders.

Criteria:

Telephone Request Entered Date: Enter the date range to include when closing open Telephone Orders (Entered Date).

Entered By: Select the range of employees to include when closing open Telephone Orders (employee that entered the order originally).

NOTE: Pending Orders will need to be removed from the customer’s account manually.
MangoGeo Address Correction

*MangoGeo* is a web-based address correction tool that can correct your delivery and mailing addresses, retrieve ZIP+4 information, and update tax codes. Contact Advantage Route Systems for further information.
Administration

The Administration tools have been designed to help you efficiently manage your program.

These options are described in detail within the following pages.

Users Currently Logged In

This option allows you to view all of the users currently logged into RM2000. If necessary, you can easily 'boot' a user from the program by selecting their name and choosing the Wastebasket button.

Fields:

User Name: Displays the user name of the employee logged on.

Login Date: Displays the original login date of the user.

Time On: Displays the length of time the user has been logged in during their current session.

Computer Name: Displays the computer name that the employee is using on the network.

Network ID: Displays the network that the employee is using.

Wastebasket: Select a user and click the wastebasket to remove the user from the program.

NOTE: This may be necessary if a user is "stuck" in the system.

Clear Locks: Select this option if users are having problems accessing certain areas of the program.

Refresh list: Updates the list of users logged into the system.
Data Integrity Check

This option allows you to check your RM2000 data for errors and problems. It is recommended that this function be performed at least once per month to ensure that your data is optimized.

Fields:

**Omit Inactive Accounts:** Select this option to ignore inactive customers when checking for problems.

**Select All:** This option is selected by default. It will check all areas of the program for problems.

**De-Select All:** Choose this option to de-select all areas of the program. This will allow you to manually double-click on the desired area of the program to check from within the list.

**Print:** Choose this option to receive a summary of errors in each category selected. This can be helpful for running a quick-check for problems in each section.

**Next:** Select this option to preview or print the Data Integrity Check Error Report. It is recommended that you try to resolve any problems found.
Consolidate History Data

This function will export historical RM2000 history data that can be used with external reporting utilities such as Crystal Reports.

**Fields:**

- **From/To:** Enter the date range to include when exporting data.
- **File Name:** Enter a name that will be assigned to the export file.

**NOTE:** Each file will be placed under the ‘DATA’ folder within your RM2000 directory.

Clean Open Invoice System

Use this option to automatically apply all of the ‘credits’ found within each customer account to their oldest open items.

**NOTE:** This option cannot be undone. It is recommended that a backup of your RM2000 data is created prior to using this feature.
Helpful Windows Functions

As you enter data in RM2000, you can use standard Windows functions to help you enter data quickly. Here are the system’s features that function like standard Windows routines:

- Undo
- Redo
- Cut
- Copy
- Paste
- Find
- Find Again

Calculator

This full-function calculator can be used within RM2000 to help with most calculations.

Calendar

This calendar program can be used in RM2000 to look up dates.
Module Bar

The Module Bar contains quick access to important areas of the program.

Module Date

The Module Date is typically the current date on your PC and will be used on all transactions and entries made in RM2000. However, this date can easily be changed by clicking directly on top of the date listed; for example, this can be helpful when you are entering adjustments for previous dates.

Telephone Request

The Telephone Request screen handles special requests from customers, and is used to schedule special deliveries as needed. You may create and save orders as well as track their progress to be sure important tasks have been completed.

Fields:

Account Number: The account number of the customer who made this telephone request.

Name: The name of the customer making this request.

Delivery Address: This customer’s delivery address.

Route/Day/Stop: This customer’s regularly scheduled route, day, and sequence number.

Driver: The name of the route driver that delivers to this customer.
**Date/Time:** The date and time the customer made this request.
**Phones (Info/Route):** The phone number of the customer.
**Contact:** The customer to contact regarding this request.
**Ticket No.:** The unique reference number to identify the request.
**Balance:** The customer’s account balance.
**Last Payment:** The date and the amount of this customer’s last payment.
**Next Delivery:** The customer’s next scheduled delivery day.
**Request:** The request made by this customer.

**NOTE:** To set up standard order request reasons, go to the *Lists > Telephone Reasons*. You can then enter up to 24 reasons that will meet the needs of your customers.

**Message:** Any additional requests or comments can be entered into this field.
**Promise Date:** The date being promised to the customer to fulfill the order.
**Completed:** When this customer’s request is completed, check this box (automatic when completed on the handheld).
**Completion Date:** The date this customer’s request was completed.
**Completion Message:** Comments pertaining to the request’s completion.
**Follow up Date:** The date for a future follow-up call.
**Processed By:** The employee who received and input the information regarding the request.
**Completed By:** The employee who fulfilled the request.
**Add to Contacts:** If you select this box, the order will be added to the *Contacts* tab of the customer’s account (recommended).
**Handheld Message:** Information about the request to be transferred to the handheld for the route driver to use.
**Copies:** The number of copies of this report to print on *Save*. Indicate whether you want the wide version ‘W’ or standard ‘S’, and the number of copies to print (1-4). The default value can be established within *File > Local Settings* for each user.

**Buttons:**
- **Report:** Pressing the *Report* button takes you directly to the *Telephone Messages Report* screen.
- **Browse:** Pressing the *Delivery Summary* button takes you directly to the *Last 5 Deliveries* screen for the current customer.
Customer Fast Find

The Customer Fast Find screen is used as a tool to look up customer information by inputting search criteria. You can browse for a customer by entering account numbers, billing or delivery names, and more.

Print Customer Label

Use this function to print customer mailing labels. The options are defined below.

Settings:

Copies: The number of labels to print for each customer.

Missing Labels: If you are printing labels on a sheet that is missing labels, enter the number of labels to skip before printing.
**Label Type:** Select the label type that you are using from the drop-down list:

- *Avery 5162*
- *Avery 5163*
- *Avery 6231*
- *European A4*

**NOTE:** Select the ‘Laser’ option next to the *Label Printer* within *File > Local Settings* to enable access to the options above.

**Address:** Select the desired address information to print on each label.

**Print Phone Number:** Check this box to include the customer’s phone number on the label.

**Print Contact Name:** Check this box to include the customer’s contact name on the label.

**Eject After Printing:** For dot matrix printers, select this option to automatically form feed the sheet after printing.

**Block Account #:** Check this box to suppress the account number on the label.

**Fields:**

**Account Number:** Enter all of the account numbers that you will print a mailing label for.

**Last Entered:** Displays the account numbers recently entered during the current batch.

**Notification Message**

This button will periodically become active when a message is transmitted from Advantage Route Systems. Click on the button to view the message.

**Current Period**

This button displays the month or period that RM2000 is currently working in.
Chapter 11 – Help

Overview

The Help menu includes support content as well as information about RM2000.

<table>
<thead>
<tr>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day-to-Day Operations</td>
</tr>
<tr>
<td>Technical Support</td>
</tr>
<tr>
<td>Tech Support Remote Connection</td>
</tr>
<tr>
<td><a href="http://www.ARS247.com">www.ARS247.com</a></td>
</tr>
<tr>
<td>About RM2000</td>
</tr>
</tbody>
</table>
Contents

The Contents option gives you access to the RM2000 User Guide directly from within the program.


NOTE: You may also access this screen by pressing the F1 key from any screen in RM2000.
Day-to-day Operations

The day-to-day operations section of the Help file contains information about several daily processes.
Technical Support

Select the Technical Support option to access the Autotask portal where you can view and submit inquiries to ARS.

**NOTE:** If you have not received login information for the Autotask portal, please contact us at Support@ARS247.com with the following information: first and last name, company name, phone number, and E-mail address.

Each inquiry reviewed or submitted will be assigned a unique ticket number that allows you to easily view and track the item(s).

**Tech Support Remote Connection**

ARS utilizes the Go-To-Meeting program to allow our technical support staff to access your PC.

**Fields:**

*Meeting ID:* This will be supplied to you by a support staff member during when remote support is required.
WWW.ARS247.COM

Choosing this option will link you to the www.ARS247.com Web site.

If you have not received login information for ARS247.com, please contact us at Support@ARS247.com with the following information: first and last name, company name, phone number, and E-mail address.
About RM2000

Select this option to view program version information and support information.

Modules:

Select the ‘Question Mark’ icon (next to the Serial# field) to view your available optional modules. Any modules purchased by your company will be marked with an [X].
Tables:

Click this button to view diagnostic information about the system data tables and your active directories. You can scroll through this information or exit by clicking ‘OK’.

Contact Us

Whenever you need assistance, we are just a phone call away. Listed below are our main contact numbers:

- Toll free tech support: 888.294.7688 (in the US only)
- Fax: 1.775.263.8426
- E-mail: support@ARS247.com

Chapter 12 – Training and Support

Overview

Advantage Route Systems provides a variety of materials to help you train the people you work with and to assist you in becoming familiar with RM2000. This chapter gives you an overview of the training materials that we recommend.

Training Materials

We have developed a variety of training materials that can help you as you embark on your training process. Some of these are included with your RM2000 installation package while others can be downloaded from our support Web site www.ARS247.com.

Materials that we have created include:

- Videos
- Manuals
- Web-Based Training
- Special "white papers"

Furthermore, we have several one-on-one services such as the following:

- Telephone training
- On-site visit for consulting and training
- Classroom training at our offices
- Telephone assistance to help you design just the right programs for your group.

With all of these materials available, you can design the right training mix to help your office staff work accurately and proficiently.
How long does it take?

Training time varies from one organization to another. Typical training times can be a few hours for a small group to several weeks for a larger organization.

In a larger company, it will take several weeks of planning and a high degree of coordination to make it happen. The important thing is that a qualified local team leader be placed in charge of the project so it can be completed on time and within budget.

Technical Support

If you just have a question and need quick resolution, then we can help you quickly via direct services. We provide 24-hour-a-day, 7-day-a-week telephone support to all our users.

How to contact us:

- Toll free, 24-7 Telephone Support – 888-294-7688 ext. 444
  (Outside the United States at 1-209-632-1122)
- Visit the support Web site at http://www.ARS247.com
- Email – support@ARS247.com
- Fax – 1-209-632-6868
Glossary of Terms

Overview

This glossary has been designed to help you become familiar with terms that are used in this manual and in the software.

Edit Screens

General Controls

Chapter 4 contains a description of the general control keys that can be used to find and save information. In addition to this standard control key is the following abbreviated key group:

These keys allow you to perform the following functions:

- **Modify**: Allows you to change the information on the screen.
- **Print**: Prints information associated with the data on the screen.
- **Save**: Keeps all changes made during the editing session.
- **Cancel**: Erases all changes just made.
- **Exit**: Leaves the screen and returns you to the *Main Menu*. 
Printing Controls

As you enter a report window, you will see a set of controls related to printing.

The icons in the window represent the following functions:

- **Print:** Sends the selected report to the default printer.
- **Cancel:** Leaves the screen without printing anything.
- **Preview:** Shows the report on the screen before printing it.
- **Change Printer:** Allows you to select a different printer to use for this report.
- **E-Mail:** This option will send the report as a .PDF file attachment via E-mail.

**NOTE:** Requires additional setup, refer to the Supplemental Guide for additional information.

**Excel Export:** Exports the report data to a Microsoft Excel spreadsheet.

Other Controls

When you preview a report, you will see a control bar such as the one below. These controls allow you to move up a page, back a page, or to the top or bottom of a document. You can also exit the screen using these icons.

**NOTE:** When exiting the preview screen, it is always a good idea to click on the exit door.
Appendix A: End-of-Month Procedures

Overview

We have provided a checklist you can follow for general procedures on the Month-End process. Using a checklist will help you stay on task and avoid problems once you have established your routine.

NOTE: Refer to the Supplemental Guide for further information on the Month End process.
**Checklist**

Below is a checklist of steps to follow during the *Month-End* process. Depending on your company, some of the steps may be omitted.

<table>
<thead>
<tr>
<th>Date:</th>
<th>Time:</th>
<th>Who:</th>
<th>Month End Processing Checklist</th>
<th>Refer:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>1. Post last batch of regular transactions</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2. Back-up Data Files</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>3. Generate Rent Charges/Rents Not Billed / Post Rentals</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>4. Generate Recurring Billing Charges/ Post Charges</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>5. Generate Over-Usage Charges (Package Plan Only) / Post Charges</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>6. Calculate Administrative Charges / Post Charges</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>7. Calculate Finance Charges / Post Charges</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>8. Calculate Credit Card Payments / Post Payments</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>9. Print Monthly Reports:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Business Pulse Report</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Aging Analysis</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Sales Detail Report</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Month End Summary</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>• Any other relevant reports</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>10. General Ledger Posting Report</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>11. Customer Statements</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>12. Close Period</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>13. Start next month’s processing</td>
<td></td>
</tr>
</tbody>
</table>
Appendix B: Customer Notes

Overview

The RM2000 package provides two general ways to record interactions with customers. These are:

- *Office Messages*
- *Handheld Messages*

Each of these message types is explained in more detail below.

Office Messages

*Note:*

![Note information box]

This information box is used to record permanent notes about the personality of the customer, such as: “Never pays on time,” “Promises a check and always sends it late,” or “Always speak with Linda to confirm any special orders.” These messages are only displayed on the screen, and the customer will never see them. The *Note* option can be found under *Lists > Customer information*, on the *Info* tab.
Statement Message:

On the customer’s statement, you can print a customized message such as, “Give this statement to Linda in accounts payable,” or “The products delivered under this invoice qualify under the National Fair Atmospheric plan,” or any other message specific to this customer. The Statement Message can be found under Lists > Customer Information, on the Info tab.

NOTE: If you want a message to appear on every customer’s statement, you can use the Statement Notes option under Lists > Customer Setup Codes > Statement Codes.

Contact Messages:

This area provides an ongoing history of events that have transpired between you and the customer. These messages are logged within Lists > Customer Information, on the Contacts tab.
Many different types of messages can be entered, including:

**Automatic Messages:** These are messages that are automatically added to the Contacts tab each time a certain event occurs. This can include: credit card processing approval, equipment transfers, telephone messages, route driver messages, returned checks, and other events.

**Manual Messages:** Any system user can select this tab and enter a short message describing contact with the customer. This can include phone conversations, promises by the customer to pay an invoice, requests to change an address, and more. You can also enter a follow-up date and the system will remind you to take further action on the account.

**Handheld Messages:**

**Alert Message**

This message appears on the handheld as the driver first selects the stop to make a delivery. Like all handheld messages, there is no maximum length restriction. If more text is entered than can fit on the screen, scroll bars provide easy viewing.

**One Time Message**

The one-time message is just like the alert message, except it will only appear on the handheld for the period of time entered within the Begin/End Date fields. This is useful to remind a route driver when a customer may be on vacation and will not require a delivery.

**Driver Directions**

To help the route driver locate a customer, instructions can be entered in this message area. Typically, this would include street names or landmarks such as “Last house before the creek,” or “Go one light east on Meridian before turning right on Maple Street.”
Site Instructions
This message provides on-site instructions for delivery. For example, “Bottles are located in garage next to tool shop,” or “Place a full bottle on the cooler each time.” While site instructions could include, “Beware of the big dog,” it may be better to enter such a message in the Alert Messages that appear when the driver comes to the stop.

Invoice Messages
Use this space to put a special message on the handheld delivery receipt. This might include a Purchase Order number, special instructions such as, “Accounts Payable will require one copy as well as the signing party,” or “This invoice must be paid under agreement 45-8384 which requires payment in five days.” No special formatting is required for this message.
Index

A
Account Number
  Format 31
Accounting
  Information 33
  Reports 246
Accounting Setup 143
Accounts Receivable 1, 33
  Aged 260
Add Day Label 50
Adding New Records 20
Administration 377
Advanced TSClient 30
Afternoon
  Data Transfer 339
Aging Analysis 260
Alert Message 401
Alignment 21
Altering Invoice Data 208
Annual Rate 117, 119
ARS247.com 2, 4, 394
Assembling Materials 7
Average Price Per Product 283

B
Background Memory 56
Backup Data Files 75
Balances 83
Bank Account Billing Info 91
Bank Information 35
Bank Transfer 216
Bank Transfer Processing Directory
  61
Banking 35
Baud Rate 59
Billing
  Account Name 189, 190
  Frequency Code 110
  Bookkeeping Programs 34
  Bottle Deposits 110, 195
Bottles in Field Report 266
Branch Code 48
Browse 20
Browse Order 58
Business License 80, 193
Business Pulse Report 270
Button Descriptions 19

C
C.V.V. 90
Calculate Finance Charge 231
Calculating Charges 229
Calculator 380
Calendar 380
  Equipment Service 149
  Information 49
  Setup Information 49
Calendars By Day Report 300
Cancel 21
Card Override 351
Card Reader 58
Cash 33
Cash Receipts Journal 225
Cash Received by Sales Rep 256
Change Customer Account Numbers 367
Change Customer Names 368
Change Equipment ID 369
Change Route Date 353
Charge Codes 33, 109, 149, 196,
  203, 373, 374
Check Type 34
Clear All 51
Clear All Unbilled Cycles 46
Clear Day Label 51
Clerical Employees 181
Close Period 233
Close Preview 22
Closing the Month 229
Collections
  Class 113
  Collections Agency Accounts Report
    261
COM Ports 59, 60
Comments 204
Commission
  Class 136, 182
  Class Codes 182, 184
  Rates 182
Commission Class List 333
Communication Reports 277
Communications Options 59
Company
Information 2, 29
Name 30
Company Report 334
Component Rates 143
Consolidate History Data 379
Contact
Information 81
Messages 400
Notes 40
Contact History 279
Contact Messages 47
Contact Reasons 126
Contact Reasons List 324
Contents 386
Corrupted Data Files 73
Create Standard Months Billed
Ahead 46
Create Standard Months Billed in
Arrears 46
Credit
Terms 87, 89, 91
Credit Card 89
Processing 216
Processing Directory 61
Credit Class 113
Credit Class List 321
Credit Classes
ID 113
Currency 35
Current Invoice Number 31
Currently Unposted Transactions
146
Customer
Contact Information 80
Delivery Calendar 299
Fast Find 383
Notes 37, 399
Type Codes and Descriptions 127
Customer Equipment List 313
Customer Information 80
Contact History 93
Contacts 93
Credit 87
Finance 83
History 86
Products 108
Route 95
Customer List 320
Customer Pre-Order 109
Customer Purchases Report 295
Customer Refund List 264
Customer Route Listing Report 289
Customer Setup Codes 321
Customer Starts and Stops 269
Customer Type Codes List 325

Customer Without Deliveries Report 296
Customers Without Equipment Report 314
Cycle Code 46
Cycle Description 46

D
Daily Processing and Transactions 2, 207
Daily Sales Report 253
Data Integrity Checks 378
Day Label 52
Day Label Calendar 50
Day-to-day Operations 4, 387
Default
Accounts 33
Information 40
Number of Bays 163
Default Products 108
Adding and Removing 371
Changing 373
Delete
Records 20
Route 354
Unposted Finance Charges 231, 232, 233
Delivery
Calendar 198
Dates 97
Summary 109
Delivery Schedule Preview 101
Demo Version 12
Deposit Code 139
Deposit Slip Report 225
Desktop
Information 37
Diagnostics 8
DL Directory 48
Docking 48
Driver
Directions 98
Directions Message 401
Identification Tag 8
Setup 173
Driver Summary Report 272
Dunning Letter Type 114
Dunning Notices 317

E
EF2000 Document Directory 61
Electronic Commerce 2000 365
Electronic Filing 2000 365
Email 2, 30, 81, 89, 96, 394
E-mail
   Statement 121
Employee 180
   Clerical 181
   Hire Date 181
   ID 180
   Information 180
   Termination Dates 181
   Type 181
Employee List 332
Employee Setup 180
End-of-Month Procedures 397
Equipment
   Master List 147
   Equipment 44, 147
      Defaults 44
      History 40
      ID 110
      Information 108
      Locations 45
      Marking 8
      Rental 110
      Repair Rate 45
   Equipment
      Information 148
      Equipment
         Service Calendar 149
      Equipment
         Customer History 152
      Equipment
         Location 153
      Equipment
         Service History 154
      Equipment
         Type 155
   Equipment
      Equipment
         Style 156
   Equipment
      Service Codes 157
      Equipment
         ID 196
      Equipment
         Movement 237
      Equipment
         Service 238
      Equipment
         Service Calls 240
      Equipment 306
      Equipment by Location Report 311
      Equipment Master List 307
      Equipment Movement Reason 131
      Equipment Service Report 310
      Equipment Setup 201
Equipment Sold Report 312
Equipment Style List 308
Equipment Transfer 236
Equipment Type List 308
Exception Reports 135
Exit 21
Exiting the Program 77
Expired Purchase Orders 301
Export 72
   Databases 72
      Routing 73
   Export Report To Excel 21
Fax Report 21
Fax Server Directory 62, 64
Federal Tax ID 36
Field Data Collection 1
Finance Charge(s) 33, 86, 192, 227
   Deleting Unposted 231, 232, 233
   ID 117, 119
Finance Charge(s) Codes 117
Finance Charge(s) Codes List 321
Financed Equipment 148
Find Button 19, 348
First Page 22
Fiscal Year End 34
Floppy Drive 58
Follow-up Date and Times 240
Foreground Memory 55, 56
FTP Password 30
FTP User 30
General Controls 395
General Ledger 136
   Account Type 145
   Account Usage 331
   Number 144
   Postings 228
   Setup 145
Generate Rent Charges 233
Geographic Area 175
Getting Started 17
GL Output Directory 61
Global Changes 366
Graphs 334
Gratis Reasons 142
Gratis Reasons List 330
Group Area Codes 103, 128, 178, 198
Group Area Codes List 331
H
Handheld
   Messages 401
   Notes 40
   Options 2, 197, 337
   Technology 1
   Types 174
Handheld Options 103, 158
   General 160
   Handheld 162
   Hardware 158
   Labels 166
   Messages 167
   Receipt 169
   Upload Reports 171
Handheld Printer Type 174
Handheld Product 135
   Handheld Upload Method 59
   Handheld 162
   Hardware 7
      Minimum Requirements 3
      Minimum Requirements 3
   Help 2, 385
   Host Accounting System 66

I
Ignore 53
Import 67
   Customers 67
   Equipment 68
   Routing 71
   Inactive Accounts 263
Inputting Customer Data 80
Install
   Equipment 110
   Installation
      Installing RM2000 10
   Options 12
   International 38
   Internet Connection 3
Inventory 164, 172, 225
   MTD and YTD 137
   Sold Summary 225
Inventory Reports 303
Inventory Status Report 304
Invoice
   Copies 103
   Drilldown 37
   Messages 402
   Open 250
   Paid 251
   Pool 175
   Rollover 31, 175

K
Keyboard 3

L
Languages 104
Last Page 22
Latitude 97
License Number of Route Trucks 185
List Reports 319
Load Card Data 340
Load Order 208
Load Sheet Entry 359
Local Settings 57
Locating Customers 20
Lock Box 217
Logged In Users 377
Logging 47
Login
   Multi User 16
   Screens 25
   Logout 77
   Longitude 97

M
Mailable Postcard 299
Mailing Permit 41
Main Menu Screen 18
Maintaining Data Files 73
Maintenance
   Personnel 241
   Management Guide 2, 3
   Management Reports 268
   Manager’s Role 4
MangoGeo 32, 95, 97, 190, 191
MangoGeo Batch Processing 376
Manual
   Handheld 1
   User 1
Manufacturing Control Report 273
Map page 97
Master Bill Account Number 81, 190
Master Billed Accounts 274
Master User 181

Route Manager 2000 User Guide

Index ● 406
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mechanical Problems</td>
<td>241</td>
</tr>
<tr>
<td>Memory Cards</td>
<td>8</td>
</tr>
<tr>
<td>Merchant ID</td>
<td>35</td>
</tr>
<tr>
<td>Messages</td>
<td>98, 198</td>
</tr>
<tr>
<td>Alert, Contact</td>
<td>98, 401</td>
</tr>
<tr>
<td>Driver Directions</td>
<td>401</td>
</tr>
<tr>
<td>Handheld</td>
<td>40, 401</td>
</tr>
<tr>
<td>ID 115, 116</td>
<td></td>
</tr>
<tr>
<td>Invoice 402</td>
<td></td>
</tr>
<tr>
<td>Monthly Statement</td>
<td>115</td>
</tr>
<tr>
<td>Office 399</td>
<td></td>
</tr>
<tr>
<td>One Time 98, 401</td>
<td></td>
</tr>
<tr>
<td>Site Instruction</td>
<td>402</td>
</tr>
<tr>
<td>Statement 82, 193, 400</td>
<td></td>
</tr>
<tr>
<td>Microphone</td>
<td>3</td>
</tr>
<tr>
<td>Mileage on Route Trucks 185</td>
<td></td>
</tr>
<tr>
<td>Minimum Purchase Offenders</td>
<td></td>
</tr>
<tr>
<td>Report 297</td>
<td></td>
</tr>
<tr>
<td>Misc Account Deposits 265</td>
<td></td>
</tr>
<tr>
<td>Modify Prices on Default Products</td>
<td>372</td>
</tr>
<tr>
<td>Modify Route 356</td>
<td></td>
</tr>
<tr>
<td>Modifying Records</td>
<td>20</td>
</tr>
<tr>
<td>Module Bar 38, 381</td>
<td></td>
</tr>
<tr>
<td>Monitor 3</td>
<td></td>
</tr>
<tr>
<td>Month Close Date 31</td>
<td></td>
</tr>
<tr>
<td>Month End Summary 267</td>
<td></td>
</tr>
<tr>
<td>More 20</td>
<td></td>
</tr>
<tr>
<td>Morning Cards 338</td>
<td></td>
</tr>
<tr>
<td>N</td>
<td></td>
</tr>
<tr>
<td>Navigational Tools</td>
<td>19</td>
</tr>
<tr>
<td>New Customer Setup</td>
<td>189</td>
</tr>
<tr>
<td>Next Page 22</td>
<td></td>
</tr>
<tr>
<td>Notes 82</td>
<td></td>
</tr>
<tr>
<td>O</td>
<td></td>
</tr>
<tr>
<td>Obtaining Priority Service 4</td>
<td>4</td>
</tr>
<tr>
<td>Office Messages</td>
<td>399</td>
</tr>
<tr>
<td>One Time Message 401</td>
<td></td>
</tr>
<tr>
<td>Open Invoice 88, 128, 192, 250</td>
<td></td>
</tr>
<tr>
<td>Optimizations 56</td>
<td></td>
</tr>
<tr>
<td>Ordering Supplies 4</td>
<td></td>
</tr>
<tr>
<td>Output to Host 66</td>
<td></td>
</tr>
<tr>
<td>Overdue Balances</td>
<td>83</td>
</tr>
<tr>
<td>P</td>
<td></td>
</tr>
<tr>
<td>Pack (Data Files)</td>
<td>74</td>
</tr>
<tr>
<td>Packing Slip</td>
<td>7</td>
</tr>
<tr>
<td>Paid Invoices</td>
<td>251</td>
</tr>
<tr>
<td>Paper</td>
<td></td>
</tr>
<tr>
<td>Ordering 8</td>
<td></td>
</tr>
<tr>
<td>Passwords 16</td>
<td></td>
</tr>
<tr>
<td>Past Due Authorization Codes 285</td>
<td></td>
</tr>
<tr>
<td>Past Due Average By Route 282</td>
<td></td>
</tr>
<tr>
<td>Past Due By Route Day 284</td>
<td></td>
</tr>
<tr>
<td>Payment</td>
<td></td>
</tr>
<tr>
<td>Entering 210</td>
<td></td>
</tr>
<tr>
<td>Lookup 223</td>
<td></td>
</tr>
<tr>
<td>Methods 211</td>
<td></td>
</tr>
<tr>
<td>Summary 171</td>
<td></td>
</tr>
<tr>
<td>Transactions 227</td>
<td></td>
</tr>
<tr>
<td>Type 226</td>
<td></td>
</tr>
<tr>
<td>Voucher 121</td>
<td></td>
</tr>
<tr>
<td>Payment Lookup 249</td>
<td></td>
</tr>
<tr>
<td>Payment Summary 292</td>
<td></td>
</tr>
<tr>
<td>Payments 210</td>
<td></td>
</tr>
<tr>
<td>PC Card</td>
<td></td>
</tr>
<tr>
<td>Marking 8</td>
<td></td>
</tr>
<tr>
<td>Pending Transactions 37</td>
<td></td>
</tr>
<tr>
<td>Perform Data Integrity Check 74</td>
<td></td>
</tr>
<tr>
<td>Period Code 150, 202</td>
<td></td>
</tr>
<tr>
<td>Period Rate 117, 151, 203</td>
<td></td>
</tr>
<tr>
<td>Permit Number 42</td>
<td></td>
</tr>
<tr>
<td>Phone Message Copies 57</td>
<td></td>
</tr>
<tr>
<td>Plant Production Planning 294</td>
<td></td>
</tr>
<tr>
<td>Post Route Input 349</td>
<td></td>
</tr>
<tr>
<td>Postal Indicia 41</td>
<td></td>
</tr>
<tr>
<td>Postcard</td>
<td></td>
</tr>
<tr>
<td>Mailable 299</td>
<td></td>
</tr>
<tr>
<td>Standard 299</td>
<td></td>
</tr>
<tr>
<td>Posting</td>
<td></td>
</tr>
<tr>
<td>Transactions 224, 227</td>
<td></td>
</tr>
<tr>
<td>PreCall Options 128</td>
<td></td>
</tr>
<tr>
<td>Preparing Equipment 7</td>
<td></td>
</tr>
<tr>
<td>Pre-Route Reports 341</td>
<td></td>
</tr>
<tr>
<td>Previous Page 22</td>
<td></td>
</tr>
<tr>
<td>Price Levels 88, 128</td>
<td></td>
</tr>
<tr>
<td>Price List by Customer 290</td>
<td></td>
</tr>
<tr>
<td>Price Overrides 164</td>
<td></td>
</tr>
<tr>
<td>Pricing Products 134</td>
<td></td>
</tr>
<tr>
<td>Print 21</td>
<td></td>
</tr>
<tr>
<td>Print Service Tickets 309</td>
<td></td>
</tr>
<tr>
<td>Printer</td>
<td></td>
</tr>
<tr>
<td>Afternoon Report 63</td>
<td></td>
</tr>
<tr>
<td>Dot Matrix (Impact) 63</td>
<td></td>
</tr>
<tr>
<td>Fax 63</td>
<td></td>
</tr>
<tr>
<td>Impact 63</td>
<td></td>
</tr>
<tr>
<td>Information 62</td>
<td></td>
</tr>
<tr>
<td>Label 63</td>
<td></td>
</tr>
<tr>
<td>Laser 7, 62</td>
<td></td>
</tr>
<tr>
<td>Message 63</td>
<td></td>
</tr>
<tr>
<td>Requirements 7</td>
<td></td>
</tr>
<tr>
<td>Setup 21, 76</td>
<td></td>
</tr>
<tr>
<td>Printing</td>
<td></td>
</tr>
</tbody>
</table>
Controls 396
Customer Label 383
Load Sheet 345
Refund Checks 234
Route Tickets 343
Product Charge Code 34, 35, 36, 132
Product Charge Code List 328
Product Charge Codes
  Accounting 136
  Description 132
  Handheld 135
  History 138
  Pricing 134
Product Class 136
Product Class Code 139
Product Class List 329
Product Codes 328
Product Information 108
Product on Hand 167
Product Price List 329
Product Price Lists 141
Profit 86, 136
Property Tax Assessments 312
Prorate Rent 44
Public Key 35
Purchase and Sales Information 148
Purchase Order 104
  Number 104
Purchase Orders 243

R
Rebuild History Files 74
Rebuilding Data Files 73
Receipt Fonts 168
Receive Inventory 242
Receive Inventory Posting Reprint 303
Refunds 33
Registration Screen 15
Release Code 92
Remittance Stub 103
Rent Billing Calendar 46
Rent Billing Cycle 54
Rent Schedule 1 and 2 54
Rented Equipment 110
Rents - Prorate 44
Reordering Products Level 137
Report Output Directory 61
Reports 2, 245
  Previewing 21
Reprinting
  G/L Reports 259
Reprinting Deposit Slip 259
Restoring Data Files 75
Returned Check Balance 35
Returned Check Fee 35
Returned Checks 87
  Processing 221
Returned Checks Report 262
RM2000
Software 7
RM2000d 66
Route
  Calendar Options 99
  Changing Date 353
  Code 97, 99
  Delete 354
  Driver 181
  Modify 356
  Pre-Sale 346
  Resequence 355
  Schedule 50
  Sequence 97
Route Commission Report 271
Route Reports 281
Route Stop Mapping Report 288
Route Times 291
Route Truck Balancing 294
RV2000 Options 104, 128

S
Sales
  Representatives 81, 193
Sales and Profit 136
Sales Detail Report 252
Sales History Report 255
Sales Tax 97
  Authorities 144
  Codes 143
  Rates 143
  Reporting 312
Sales Tax Collected 258
Sales Tax Rates List 331
Sales Tax Report 257
Saving Data 20
Security 25
  Level 181
  Security Level Codes 183
  Security Level Codes List 333
  Sequence Number 208
Serial Number of Equipment 209
Serialization Code 15
Server IP 30
Service
  Agreements 4
  Codes 239
Equipment 4
Follow Up 241
Support 2, 388
Tickets 309
Service Codes List 308
Setting Up
  List Information 79
  List Information 2
  Route Data 5
  System 2, 4, 7
Setup 30
Setup Wizards 189
Signature Required 103
Site Instructions 98, 402
Slide 53
Social Security Number 80, 181
Sold Price and Date of Unit 148
Spare Units 5
Special 99
  Standard Postcard 299
Start and Stop Reasons 124
Start and Stop Reasons List 322
Starting Date 52
Starting the Program 15
State Tax ID 36
Statement 30
  Codes 120
  Creating a File 21
  Custom 121
  Descriptions 133
  E-mail 121
  ID 120
  Information 41
  Self Mailedr 121
  Standard Postcard 121
  Types 121
Statement Codes
  Messages 120, 123
  Statement Codes List 322
  Statement Options 41
  Statements 315
  Stops by ZIP Code Report 287
  Stylus 9
  Support 2
    Telephone 394
  Suppress Balance 102, 103
  Suspend Service Codes 125
  Suspend Service Codes List 323
  Suspended Accounts Report 286
  System Start Date 31

T
Tax

Authors 144
  Codes 134, 143, 208
  Label 36
Tax Authority 144
Tax breakdown 39
Taxes 36
Telephone
  Request 381
  Support 394
Telephone Messages 47, 277
Telephone Reasons 131
Telephone Reasons List 327
Thin Client Connection Type 60
TomTom 174
  Tools 2, 364
  Touch Safe 9
Tracking
  Funds 210
Training
  Personnel 4
  Support 2, 393
Transaction
  Detail 224
  Invoice 227
  Payment 227
  Posting 224
  Reports 224
Transmitter ID 35
Truck
  ID 185
  Sequence Code 135
  Truck Information 185
  Truck List 332
  Truck Load Verification 162
  Trucks 185

U
UL Directory 48
Unauthorized Access 16
Undelete 20
Unit Style 201
Unit Type 201
Unposted Transactions 225
Updating Your Software 12
USB Ports 8
Using Your Desktop Software 2, 17

V
Vehicle Condition Inspection 186
W
Warranty
   Expiration Dates 148
   Status 240
Web Update 365
Windows NT 7

Z
ZIP Code List 326
ZIP Codes 81, 130
Zoom 22